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Introduction 

Scheme of work for iPad Accessibility Training  

 

Scope 

These documents are for use by Qualified Teachers of the Vision 

Impaired (QTVIs), Teaching Assistants (TAs), teaching professionals 

and where appropriate families. 

 

Introduction  

This set of resources have been complied by QTVIs from Gateshead, 

Portsmouth, Barnet and Manchester, and the involvement of staff from 

Thomas Pocklington Trust.  

 

The inspiration for collating these resources came from the VI forum, 

which is an email-based group consisting of professionals who work with 

vision impaired children and young people (CYP). 

 

The forum frequently receives requests to share teaching tips, advice 

and guidance on a range of topics, including teaching accessibility for 

the iPad to CYP.  

 

Aims 

The aim of this scheme of work is to provide one central resource for 

teachers, professionals, and parents to teach CYP with a vision 

impairment the core skills of using an iPad.  
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The materials are broken down into sections which look at the learners’ 

knowledge and ability to perform set tasks, and how they want to use the 

equipment and what their outcomes are.  

 

The scheme of work covers the following areas: 

 

Unit 1: Getting Started 

Unit 2: iPad Functional Skills 

Unit 3: Access via screen magnification 

Unit 4: Accessing text 

Unit 5: Alternative ways of recording 

  References 

  Appendices 

 

 

How to Use the Scheme 

The scheme of work is designed to be as pupil-centred as possible in 

order to meet their very individual needs. The lessons which have been 

written can be delivered to a pupil of any age based on which skills and 

knowledge they need in order to successfully access the curriculum. All 

of the lessons provided have been the work of previous lesson plans 

which have been delivered to various age groups in a range of settings. 

All of the pupils had varying degrees of vision impairment.  

 

Delivery of the scheme to each pupil can be tailored by initially using a 

baseline assessment in each area of the scheme. This will indicate 

which skills need to be developed in each area. It is recommended that 

an iPad accessibility lesson will contain outcomes from each unit (please  
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see Appendices A for lesson examples) with the exception of Unit 1 

which contains a standalone lesson in order to set the iPad up although 

this lesson could be expanded over a period of time if necessary i.e. as 

part of a Functional Vision Assessment. Lessons provided are in order of 

delivery although some lessons are more suited for pupils with functional 

vision and some lessons are more suited for pupils who have little or no 

functional vision. An example of this is the lessons on magnification 

(more suited to pupils with functional vision) and the lessons on 

VoiceOver (more suited to pupils with little or no functional vision).  

 

In order to further tailor these to each pupil, each lesson has the 

following: 

 

Tailor It!     - These are ideas to reflect on prior to the lesson to tailor the  

            lesson to meet individual needs. 

 

Let’s Apply! – These are ideas to provide opportunities for the pupil to 

      apply and consolidate their knowledge and skills in a  

              variety of ways. This could be between lessons, part of 

      another lesson or within the home environment. 

 

Think SMART! – These are ways to make the suggested outcome at the  

   beginning of every lesson as SMART as possible. They  

   can also be used to break the lesson down into smaller 

   lessons as required over time i.e. you may expect the  

   pupil to only produce 2/5 correct gestures in the first  

   lesson but this may progress to 4/5 over time. 
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Differentiation is based on Koenig and Holbrook’s (2000) instruction on 

special methods for teaching pupils with a vision impairment using 

scaffolding. In order to make lessons achievable for each pupil, it is 

suggested that graduated guidance is provided after skills are modelled 

in the most suitable way for the pupil. For instance, in order to perform a 

VoiceOver gesture, a pupil with a severe vision impairment may benefit 

from the gesture being modelled using hand-under-hand guidance. They 

then achieve the lesson outcome of turning a page using a VoiceOver 

gesture with a high level of physical guidance (hand-under-hand). In the 

next lesson, they may only need physical prompting with verbal guidance 

etc. 

 

Instructions are provided after every appropriate lesson to support the 

delivery of the lesson. There are also ‘How To’ guides provided at the 

end of some units of work. These are to share with settings and families 

as a quick start guide so that they can also support the pupil to use 

taught skills.  

 

Outcome of the Scheme 

By completing the following scheme of work, it is expected that the pupil 

will be able to meet this suggested long-term intervention outcome: 

 

The pupil is able to identify, explain and use appropriate accessibility 
features of the iPad in order to engage in apps within the classroom 
environment.   

 

E-Safety 

As appropriate, lessons relating to e-safety are highlighted in appropriate 

places throughout the scheme of work in order for the pupil to apply their 
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new skills and knowledge as safely as possible. Please note that it is 

always very beneficial to inform staff and families when pupils have been 

taught new skills which could put them at risk without following e-safety 

rules and guidelines i.e. once a pupil has been taught how to locate 

information in Safari using Siri, families may like to ensure that 

appropriate settings have been applied within Safari.  
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Scheme Skills Overview 

 

Unit 1 - Getting Started  

Customising Appearance 

Unit 2 - iPad Functional Skills 

Gestures  

Lock Options 

Volume and Sound 

How to Use and Explore Apps 

Files and Filing 

Reminders 

Calendar 

Notifications 

Use and manage Control Centre 

Unit 3: Magnification 

Zoom 

Zoom Controller 

Part-Screen Zoom Options 

Using the Magnifier 

Unit 4: Accessing Text 

Spoken Content 

EasyReader 

OCR 

iBooks 

VoiceOver  

Unit 5: Alternative Ways of Working  

Using Camera for Videos 

Using Camera for Photos 

Notes  

Inputting Text 

Word 

Excel 
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Aim 

The pupil’s iPad is set up to suit their own visual needs.  

 

Purpose 

The iPad has a number of settings which can be utilised in order to tailor 

the iPad’s presentation so that it is easier for the pupil to access 

information displayed on it.  

 

Let’s tailor it! - Baseline 

• What can they already do/explain? (Using the Skills Progression 

Checklist for Unit 1, baseline your pupil (B/L) to identify what skills 

they already have in order to progress through this unit.)  

• What do they want to be able to do? 

• What would their parent/carer like/need them to be able to do? 

• What would their teacher like/need them to be able to do? 

 

 

 

 

 

 

 

Unit 1 – Getting Started 
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iPad Accessibility Skills 
Unit 1 - Getting Started 

Customising the appearance 1 Progression 

Basic Skills Introduce Developing Achieved 

Access visual display options 
   

Bold text 
 

  

Larger text    

Button shapes    

On/off labels    

Increase contrast    

Differentiate without colour    

Invert colours     

Colour filters     

Reduce White Point    

Auto-Brightness    

    

Intermediate Skills    

Use Dark Mode          

Turn True Tone on/off    

Use Night Shift    
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Lesson 1: Getting Started  

 

 

Outcome 

The pupil can identify which settings they prefer to be used in order to 

customise the appearance of the iPad to suit their needs. 

 

Preparation 

Ensure that you are familiar with the instructions following this lesson.  

 

E-Safety  

Ensure that the iPad’s settings are age-appropriate.  

 

Key Vocabulary 

Display and text size, Bold text, Larger text, Button shapes, On/Off labels, 
Increase Contrast, Differentiate without colour, Invert colours, Colour filters, 
Reduce White Point, Auto-brightness, Dark mode, True Tone, Night Shift 
 
 

Activity 

Introduce the pupil to the iPad, discussing why it has been identified as a 

tool (or auxiliary aid) to support their access to learning. Open the Settings 

menu and explain how the iPad’s appearance can be changed so that it is 

easier to see. Beginning with Display and Brightness, explore each option 

with the pupil and encourage them to identify their preference. Can they 

explain their preference? 
 

 

 

Tailor It! 

• Change the Display & Brightness settings. 

• Change the text size. 

• Change the text to Bold Text. 

• Change the Display & Text Size options in the Accessibility setting. 
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• Change the Wallpaper (this could also include taking a photo i.e. of a 

plain background to apply) 

 

 

Let’s Apply! 

• Ensure that if a pupil has an iPad at home, the same settings are 

applied. 

• Challenge the pupil to set their own iPad up. 

• Encourage the pupil to explore display settings further to identify any 

further changes.  

 

Think SMART! 

S – Which settings do you expect to be identified during the lesson?  

M – How many choices do you expect the pupil to be able to make?  

A - What level of scaffolding will the pupil need be able to achieve the 

outcome on this occasion? 

R – How much functional vision does the pupil have? 

T – Does the pupil have enough time during one lesson in order to explore 

and identify all of their preferred settings or do they need to complete this 

lesson over a longer period of time? 
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Instructions for Lesson 1: Getting Started 

 

Finding your way around 

 

What is Where?  
 

Place your iPad screen up in front of you with the small rectangular 
Lightening Connector port at the bottom edge.  

Using the two diagrams below, identify all the buttons and ports.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

See https://www.callscotland.org.uk/downloads/posters-and-leaflets/a-

complete-beginners-guide-to-the-ipad/ for further information. 

https://www.callscotland.org.uk/downloads/posters-and-leaflets/a-complete-beginners-guide-to-the-ipad/
https://www.callscotland.org.uk/downloads/posters-and-leaflets/a-complete-beginners-guide-to-the-ipad/
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You should be able to identify: 

• the multi-touch display screen showing Home Screen with apps 

• the Dock (a quick way to get to your most commonly-used apps) 

• the Status Bar (front, top of screen) 

• Home Button (front, underneath the screen) N.B. there is no Home 
Button on the latest iPad versions 

• connector port 

• volume rocker keys 

• cameras, front and back 

• the Sleep/Wake button 

• headset and microphone jacks 

 

Customising Appearance  

 

This section concerns initial adjustments made to appearance which would 
typically be the go-to display settings.  
 

Visual display options in Accessibility > Display & Text Size 
Most of the visual display options can be found in one place. It may be 
worth going through each one with your pupil initially and playing around 
with the iPad to see what difference they each make.  
 

• Go to the Settings menu by tapping on the Settings key. 

• Go to the Accessibility menu by tapping on Accessibility in the drop-
down menu on the left.  

• Click on ‘Display and text size’.  
 
Generally, options are presented as toggle keys, where the bump to the 
right (black and green) represents ON and the bump to the left represents 
OFF (black and white). 

 

Bold text 
Toggling this ON makes the text heavier and stand out more. You can 
instantly see the effect on your page.  

 

Larger text 
This enables you to change the size of the text in all apps that support 
Dynamic Type, which includes the Home screen and all integrated apps. 
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• Tap the toggle (to the right-hand side of ‘Larger text, currently set at 
‘off’). 

• Tap the toggle for ‘Larger Accessibility Sizes’ to ON.  

• Use the slide to make the text bigger or smaller. Your pupil will be 
able to see the effects straight away on the page.  

 

Button shapes 
Toggling this ON puts a shape around on-screen buttons to make them 
easier to see.  

 

On/Off labels  
These make it easier to identify whether buttons are toggled ON or OFF by 
adding a visual marker in addition to colour and toggle position: O for OFF 
and I for ON. 
 

Increase contrast 
Toggle this to increase contrast between foreground and background 
colours. 
 

Differentiate without colour 
For pupils who have difficulties differentiating between different colours, 
this provides alternative ways to convey that information. 
 

Invert colours 
If toggled ON, this will reverse the colours of the display. ‘Smart’ and 
‘Classic’ options are available. They are identical except that ‘Smart Invert’ 
doesn’t reverse the colours of images, media and some apps with dark 
colour styles.  
 

Colour filters 
The colour filters options allow pupils to opt not to use colours they have 
trouble telling apart. They can also choose to view the iPad in ‘Greyscale’.  

• If applicable, select a filter. 

• Choose whether you want to increase or decrease the intensity of the 
colours selected. The sample images at the top of the screen show 
the different effects. 

• The ‘Colour Tint’ menu at the bottom of the screen allows you to 
customise the screen using ‘Intensity’ and ‘Hue’. 

Reduce White Point 
Reduces the intensity of bright colours. By toggling this option to ON, you 
can use the sliding scale to select the reduction you require.  
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Auto-brightness 
In this option, the iPad will adjust the screen brightness according to 
current light conditions using the in-built light sensor.  
 

Dark mode 
Dark mode gives the iPad a dark colour scheme that’s great for low-light 
environments, or for pupils who find high-contrast visually tiring.  

Turning Dark mode on and off 
 

• Open Settings 

• Go to Display & Brightness 

• Select Dark to turn Dark mode on, or Light to turn it off. 
You can also do this from Control Centre. We will look at this later.  
 

How to set Dark mode to turn on and off automatically  
 

• Open Settings  

• Go to Display & Brightness. 

• Turn on Automatic, then tap Options. 

• Select either Sunset to Sunrise or Custom Schedule. 

• If you choose Custom Schedule, tap the options to schedule the 
times you want Dark Mode to turn on and off. 

 
If you select Sunset to Sunrise, iPad uses the data from your clock and 
geolocation to determine when it’s night-time for you. 
 

True Tone  
Turn on True Tone to automatically adapt the colour and intensity of the 
display to match the light in your environment. To turn ON or OFF: 

• Open Settings 

• Go to Display & Brightness 

• Turn on True Tone.   
 

Night Shift 
Night Shift describes a swift to warmer colours in the iPad display at night. 
This makes the screen easier and less tiring to view. To schedule Night 
Shift to turn on and off automatically: 

• Tap on Settings 
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• Tap on Display & Brightness 

• Tap on Night Shift 

• Turn on Scheduled. 
 
To adjust Night Shift’s colour balance, find the slider below Colour 
Temperature to move towards cooler or warmer colours.  
 
Set a time for Night Shift to come on and go on.  
 
You could choose a Custom Schedule, where you select the times yourself. 
 
Instead, you might choose Sunset to Sunrise. Here, the iPad will use data 
from your clock and location to determine what these are where you are, so 
that the Night Shift will vary according to location and time of year. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 
 

 

 

How to Modify Your Screen  

 

This quick start guide is designed to help you get started using the Apple accessibility features 

on your iPad to modify your screen, making accessing text easier. 

 

Step 1: Select ‘Settings’                  on the main display. Then make sure 

that 'General’ is selected on the left-hand column called ‘Settings’ (it will 

be highlighted in blue). 

 

 

Step 2: Select ‘Accessibility’ from the right-hand column within ‘General’. 

You will now see a list of accessibility features under the heading of 

‘Vision’ at the top right-hand side of your screen.  

 

 

 

Step 3: By choosing ‘Display Accommodations’ from the right-hand 

column under ‘Vision’ options, you can ‘Invert Colours’ so that the screen 

display reverses the colours (quite like a photo negative). There are now 

two options. You could choose ‘Classic Invert’ or ‘Smart Invert’. The only 

difference is that ‘Smart Invert’ will not reverse the colours of images, 

media and some apps which use dark colour styles. Just reselect to turn 

these off. 

 

Step 4: Within ‘Display Accommodations’, you may also have the option 

of using ‘Colour Filters’. Select ‘Greyscale’ from the Colour Filters menu 

to change the colour on the screen to shades of grey. Again, just reselect 

to turn this off. There are also filters for people with colour vision 

difficulties including Red/Green, Green/Red, Blue/Yellow. Once selected, 

there is an option to increase or decrease the intensity of these. There 

are three sample images at the top of the screen to swipe between which 

show the effects of the different colour filters. Finally, at the bottom of 

the ‘Colour Filters’ menu there is also a ‘Colour Tint’ so you can 

customise your screen using ‘Intensity’ and ‘Hue’. 



 
 

 
 

Step 5: Staying in the ‘Display Accommodations’ menu, you can select 

‘Auto-Brightness’. The iPad will use its light sensor to choose the right 

screen brightness based on your environment. You can also select 

‘Reduce White Point’, this will make any white parts of the screen a lot 

less glary. 

 

 

Step 6: In order to have larger text on the screen in apps that support the 

‘Larger Dynamic Type’ feature such as Mail, Messages, Notes and some 

third-party apps (not owned by Apple), select ‘Larger Text’ from the 

‘Accessibility’ menu on the right-hand side. A slider will appear below. 

Slide your finger from left to right and right to left to adjust the text size 

for your needs. 

 

 

Please note that you can also enlarge the text by choosing ‘Display & 

Brightness’ from the left-hand column called ‘Settings’ and then select 

‘Text Size’. By dragging your finger on the slider, you can adjust the text. 

However, this won’t enlarge the text to the same size as the ‘Larger Text’ 

option in the Accessibility menu described above. 

 

 

Step 7: Back in the Accessibility menu, by selecting ‘Bold Text’ on the 

right-hand side the contrast is increased making text easier to see. Please 

note, you can also select ‘Bold Text’ in the ‘Display and Brightness’ option 

in the left-hand column of the ‘Settings’ menu.  

 

 

 

Step 8: Within the ‘Vision’ options of the ‘Accessibility’ menu in the right-

hand column there is feature called ‘Increase Contrast’. Once selected, 

there are two options to increase the contrast of the screen, including 

‘Reduce Transparency’ and ‘Darken Colours’.  

Reduce Transparency – will make features such as popups, keyboards 
and the Control Centre a lot less transparent.   
Darken Colours – will make menus and tabs darker so that they are 
clearer. 



 
 

 
 

Step 9: Select ‘Display & Brightness’ from the left-hand side column 

called ‘Settings’. You can manually adjust the brightness of the screen by 

sliding your finger on the button at the right-hand top of the screen from 

left to right and right to left or select ‘Auto-Brightness’ as shown in Step 

5.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you have any difficulties in modifying your screen, please use the following link to find Apple 

User Guides which contain full details of Accessibility Features: 

http://support.apple.com/manuals/ 

 

Please note that accessibility features on electronic devices are updated regularly and therefore 

can change. This guide is designed to be as universal as possible for Apple devices, but you may 

find slight differences depending on the operating system (or iOS) your device is using.

Other useful hints include: 

In the Accessibility menu within Settings, select ‘Button Shapes’ – This will put a shape around on-screen 

buttons. 

In the Accessibility menu within Settings, select ‘Reduce Motion’- This will change the screen effect of 

zooming when changing from the Home screen to another app to a fade effect instead. This is beneficial 

for people who are sensitive to the ‘motion’ of the screen when moving between apps and the Home 

screen.  

In the Accessibility menu within Settings, select ‘On/Off Labels’ – This will add  ‘I’ or ‘O’ to each button 

next to its option so that it is easier to see if the option is on or off. 

Please note that within the Shortcut Zoom menu, there is a feature called ‘Choose Filter’ which includes 

some shortcut options to modify the screen including inverting the colours on screen, Greyscale, 

Greyscale Inverted and an option called Low Light which will dim the screen to the minimum amount of 

brightness. By selecting Low Light within the Zoom Accessibility feature, you can dim the screen even 

further by opening the Control Centre and dragging the brightness control  up or down (see  

https://support.apple.com/en-us/HT202769 for more information).  

 

http://support.apple.com/manuals/
https://support.apple.com/en-us/HT202769
https://support.apple.com/en-us/HT202769
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Aim 

The pupil can use a number of gestures in order to engage with the iPad, 

applying these to control and manage apps and key functions to meet their 

own individual needs.  

 

Purpose 

Pupils with vision impairments will have ownership of their iPad and the 

ability to confidently navigate it to utilise and optimise the iPad’s 

functionality.  

 

Let’s tailor it! - Baseline 

• What can they already do/explain? (Using the Skills Progression 

Checklist for Unit 2, baseline (B/L) your pupil to identify what skills 

they already have in order to progress through this unit.)  

• What do they want to be able to do? 

• What would their parent/carer like/need them to be able to do? 

• What would their teacher like/need them to be able to do? 

 

 

 

 

 

 

 

Unit 2 – iPad Functional Skills 
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Medium-Term Plan 

 

Lesson Outcome Key Skills Key Knowledge Links to 
Other Units 

Lesson 1: 
Basic 
Gestures 

Create an effect 

using a single, 

double and triple 

finger tap, tap 

and hold as well 

as drag gestures 

on request.  

• Produce 
basic 
gestures 

 

• Understand 
correct 
terminology for 
gestures 

•Understand 
how to care for 
an iPad 

 

Lesson 2: 
Basic 
Controls 

Successfully 

differentiate        

between the 

Home button and 

the Sleep/Wake 

button as well as 

adjust the volume 

on request.  

• Turn the 
iPad off and 
on 

• Un/lock the 
iPad 

• Adjust the 
volume 

•Know the 
difference 
between  
locking and 
turning the iPad 
off 

•Explain where 
the volume 
button is 

 

Lesson 3: 
App 
Control 

Explain and/or 
model how to 
switch between 
apps, close apps 
and search for an 
app.  

•App switch 

• Close apps 

• Use Quick 
Search 

•Understand the 
purpose of app-
switching 

•Relate closing 
an app to 
saving the 
battery  
•How using 
Quick Search 
can be more 
efficient to find 
apps  

 

Lesson 4: 
Getting 
Organised 

Outcome 
The pupil can 
utilise their iPad 
to efficiently 
locate apps on 
their iPad within 
folders, schedule 

•Create and 
use folders 

•Schedule 
alarms 
•Schedule 
reminders 

•Understand  
that using folders 
is an efficient 
way of 
organising apps 

•How to use 
native apps to 

Unit 5b 
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alarms and 
reminders and 
adapt the Control 
Centre to suit 
their individual 
needs. 

•Locate the 
Control 
Centre 
•Adapt the 
Control 
Centre 

organise their 
day-to-day 
activities 

•What the 
Control Centre 
does 
•How to 
customise the 
Control Centre 
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills 

Gestures Progression 

Basic Skills Introduce Developing Achieved 

Tap 
 

  

Touch and hold    

Swipe    

Scroll    

Zoom and pinch    

Double tap    

    

Intermediate Skills    

Go Home    

Quickly access controls    

Open the app switcher    

Switch between open apps    

Open the Dock within an app    

    

Advanced Skills    

Ask Siri    

Use Accessibility Shortcut    

Take a screenshot    

Turn off    

Force restart    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills 

Lock options Progression 

Basic Skills Introduce Developing Achieved 

Locate the Home button 
   

Turn iPad on/off (with/without a Home button) 

   

Turn iPad on/off (with/without a Home button) 

   

Send to sleep (with/without a Home button) 

   

Wake up (with/without a Home button) 
 

  

    

Intermediate Skills    

Understand the status bar    

Charge iPad by connecting to the mains    

Change a passcode    

Turn off the passcode    

    

Advanced Skills    

Identify all buttons and ports     

Set up Face ID and Touch ID    

Change the lock settings    

Lock or unlock the screen orientation    

Charge iPad by connecting to a PC    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills 

Volume and Sound Progression 

Basic Skills Introduce Developing Achieved 

Adjust volume 
 

  

Mute the sound    

    

Intermediate Skills    

Use Do Not Disturb to silence calls/alerts/notifications    

Turn off sounds     

Change sounds    

    

Advanced Skills    

Set sound level for ringer and alerts    

Lock the ringer and alert volumes    

Limit the headphone volume    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills 

How to use and explore apps Progression 

Basic Skills Introduce Developing Achieved 

Open apps on the Home screen (single-finger single-tap gesture) 
 

  

Locate app using search menu    

Use the App Switcher    

    

Intermediate Skills    

Open/use the Dock    

Quit and reopen an app    

Manage multiple open apps    

Move and organise apps    

    

Advanced Skills    

Create folders to organise apps    

Delete apps from iPad Home screen    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills  

Files and Filing Progression 

Basic Skills Introduce Developing Achieved 

Open files and folders 
 

  

Change how files are sorted in folders    

Change how to view the files (as an icon/list/column)    

Find a specific file or folder    

    

Intermediate Skills    

Rearrange the Browse sidebar    

Create a folder    

Rename/compress/make other changes to a file or a folder    

Mark a folder as a favourite    

Send files to others    

    

Advanced Skills    

Set up iCloud Drive on iPad    

Turn on iCloud    

Choose which apps use iCloud Drive    

Browse iCloud Drive    
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iPad Skills 
Unit 2 - iPad Functional Skills  

Reminders Progression 

Basic Skills Introduce Developing Achieved 

Add a reminder 
 

  

Add more details to a reminder    

Mark a reminder as complete    

    

Intermediate Skills    

Edit multiple reminders all at once    

Organise reminders in lists - use smart lists    

Organise reminders in lists - create reminder lists and groups    

Move reminders into a list    

Make a sub-task    

Delete reminders     

    

Advanced Skills    

Change your Reminders settings    

Share reminders and collaborate on iPad    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills  

Using the Calendar Progression 

Basic Skills Introduce Developing Achieved 

Set up a Calendar account 
 

  

Add an event to your calendar    

Delete an event     

    

Intermediate Skills    

Edit an event - access the edit menu    

Edit - Change event time    

Edit - Set an alert    

Edit - Add/remove an attachment to an event    

Find events in other apps    

Change how you view events    

Send/receive/respond to diary invitations    

    

Advanced Skills    

Schedule a meeting without blocking your schedule    

Suggest a different meeting time    

Customise and track events    

Use multiple calendars    

Share iCloud calendars    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills  

Notifications Progression 

Basic Skills Introduce Developing Achieved 

Read notifications 
 

  

Respond to notifications    

Dismiss/clear/manage notifications    

    

Intermediate Skills    

Change notification settings    

Allow notification previews    

Choose which notifications to allow    

Show recent notifications on the Lock Screen    

    

Advanced Skills    

Set Do Not Disturb    

Allow calls when Do Not Disturb is on    

Allow calls from emergency contacts when Do Not Disturb is on    

Schedule quiet hours    
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iPad Accessibility Skills 
Unit 2 - iPad Functional Skills  

Using and managing the Control Centre Progression 

Basic Skills Introduce Developing Achieved 

Open Control Centre 
 

  

Access more controls in Control Centre    

    

Advanced Skills    

Temporarily disconnect from a Wi-Fi network    

Temporarily disconnect from Bluetooth devices    

Add and organise controls    

 

 

 

 

 



 
 

23 
 

 

Lesson 1: Basic Gestures 

 

 

Outcome 

Create an effect using a single, double and triple finger tap, tap and hold as well 

as drag gestures on request.  

 

Preparation 

You will need to download apps such as Mini Pet Café app, Art of Glow app, I 

Love Fireworks app, Rainbow Draw app, Toca Band app, R-Tap Drums app, 

Popping Bubbles app, Robot Lab app, Toca Monsters app, Reactickles Magic 

app, Finger Paint app, Magic Piano app, Robot Lab app. 

 

E-Safety  

What equipment are you currently responsible for? Can you demonstrate safe 

handling of an iPad? How do you demonstrate respect for this equipment? 

Discuss how these behaviours can be transferred to the iPad and how it can be 

looked after in school i.e. where would it be placed during school hours and who 

is responsible for identifying when it needs charging etc. 

 

Key Vocabulary 

Single – finger single tap, single-finger double tap, single-finger triple tap, 

single-finger tap and hold, single-finger tap and drag  

 

Activity 

Model completing a single-finger tap in order to create an effect in a motivating 

app. Provide guidance in order to encourage the pupil to produce an effect 

using this gesture on request. Extend to single-finger double and then triple-tap 

before moving onto single-finger tap and drag and tap and hold gestures. 

Finally focus on double-finger and triple-finger gestures. Challenge the pupil to 

increase accuracy and speed in using these gestures. Encourage 
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understanding of when they have successfully completed a focussed gesture 

and ensure that the correct terminology is used for each gesture.  

 
 

Tailor It! 

• Explore success in using fingers to complete gestures with a stylus or 

iPad crayon.  

• Use Siri to open apps using voice-driven command. 

• Ensure that instructions reflect the pupil’s current understanding of 

prepositions and directional vocabulary.  

• Identify appropriate and motivating apps based on pupil’s preference.  

• Ensure that the apps identified are accessible for the pupil based on their 

visual needs.  

• The pupil may benefit from using Guided Access (another accessibility 

feature) to assist them to stay in an app.  

 

Let’s Apply! 

• Ensure that the pupil has a lot of opportunity to transfer each gesture to a 

range of other cause and effect apps which reward the pupil for 

completing the gestures such as a rewarding sound or image. 

 

Think SMART! 

S – Which gestures do you expect the pupil to perform by the end of the 

lesson? Will you expect them to apply these gestures to multiple apps or just 

one? 

M – How many gestures do you expect the pupil to confidently name and 

perform? How many occasions do you expect the pupil to correct perform the 

gesture? Within how many attempts do you expect the pupil to correctly perform 

the gesture? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Will they be able to retain all of the gestures in one lesson? Do they have 

sufficient fine motor skills to perform these gestures? 

T – Will the pupil be able to learn all of these gestures in one lesson or will the 

pupil need to focus on one gesture each lesson with opportunities to practise 

and consolidate learned gestures too i.e. as a Warm Up? 



 
 

25 
 

Instructions for Lesson  1: Gestures 
 

 

 

Tap  
Touch one finger lightly on screen  

Try: opening an app by tapping on the icon on the Home Screen. Use the 

Home button to return. 

  

Touch and hold  

As a tap but hold the finger down for a second. This opens a quick actions 
menu for the item you are holding.  

Try: on the Home Screen, touch and hold an app icon to open a quick actions 
menu, or touch and holding within an app e.g. KeyNote. 

 

Swipe   

Move one finger across the screen quickly before lifting. 

Try: swiping through the list of apps on the Home screen 

  

Scroll  

Move one finger across the screen without lifting  

Try: going into Safari > Wikipedia.org and scrolling through an article. 

  

Zoom & Pinch 

Place two fingers on the screen near each other. Spread them apart to enlarge 
the image and zoom in to a part of it or bring them back together in a pinch to 
zoom back out again.  
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Try: taking a photo using the Photos app, going into the photo (underneath the 
round white shutter button) and use the Zoom/Pinch option to look at fine details 
and then come out again.  

  

Double tap  

You can also double-tap a photo or webpage to zoom in. To zoom out again, 
either double-tap again or use the Pinch gesture.  drag down to zoom out.  

 

More advanced gestures (to be used in conjunction with other areas of 
learning in this scheme) 

Go Home 

Swipe up from the bottom edge of the screen to return to the Home Screen at 
any time. 

Quickly access controls 

Swipe down from the top-right corner to open Control Center; touch and hold 
a control to reveal more options. To add or remove controls, go to Settings  > 
Control Center. 

Open the App Switcher 

Swipe up from the bottom edge, pause in the centre of the screen, then lift 
your finger. To browse the open apps, swipe right, then tap the app you want 
to use. 

Switch between open apps 
Swipe left or right along the bottom edge of the screen to quickly switch 
between open apps.  
 
On an iPad with a Home button, swipe with a slight arc.  

Open the Dock within an app 
Swipe up from the bottom edge of the screen and pause to reveal the Dock. 
To quickly open another app, tap it in the Dock.  
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Ask Siri 
Just say, “Hey Siri.” Or press and hold the Sleep/Wake key and make your 
request.  
 
On an iPad with a Home button, press and hold the Home button and make 
your request. Siri listens until you release the button.  

Use Accessibility Shortcut  
Triple-click the Sleep/Wake key.  
 
On an iPad with a Home button, triple-click the Home button.  

Take a screenshot  
Simultaneously press and quickly release the Sleep/Wake key and volume up 
button.  
 
If you have an iPad with a Home button, simultaneously press and quickly 
release the Sleep/Wake key and the Home button. 

Turn off 
Simultaneously press and hold the Sleep/Wake key and either volume button 
until the sliders appear, then drag the top slider to power off.  
 
If you have an iPad with a Home button, press and hold the Sleep/Wake key 
until the sliders appear.  
 

Alternatively, you can go to Settings  > General > Shut Down. 

Force restart 

Press and release the volume up button, press and release the volume down 
button, then press and hold the top button until the Apple logo appears. 
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Lesson 2: Basic Controls 

 

 

 

Outcome 

Successfully differentiate between the Home button and the Sleep/Wake button 

as well as adjust the volume on request.  

 

E-Safety 

Ensure that the pupil is able to input their password at the beginning of the 
lesson, is able to explain why having a password is important and who they 
should share this with.  
 
 
Key Vocabulary 
 
Home button, Sleep/Wake button, volume 
 
 
Activity 

Demonstrate turning the iPad on and off, using functional vision and auditory 
clues to identify when the iPad is turning on and off. Encourage the pupil to 
count how long they need to press the Sleep/Wake button for and discuss 
strategies the pupil feels could be successful in remembering how long to press 
this button in order to turn the iPad on and off. Once the pupil is confident in 
locating the sleep/wake button, develop their understanding of the Home button 
and locking/unlocking the iPad. Distinguish between the functions of lock and 
unlock and power on and off. Role-play problem-solving scenarios in which the 
pupil has to work out if the iPad is locked or the power is off.  Then develop 
competency in being able to locate the volume button and provide graduated 
guidance in order for the pupil to adjust the volume on request, exploring multi-
sensory strategies in order to locate the volume button and adjust it. Can they 
explain how to increase and decrease the volume when it is too loud or quiet? 
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Tailor It! 
 

• Initially ensure the iPad is in the position it is used the most with the pupil 
i.e. portrait or landscape when locating buttons.  

• The pupil may initially benefit from bump-ons or bright stickers to identify 
where the key buttons are on the iPad. 
 

 

Let’s Apply! 
 

• Encourage the pupil to begin to take responsibility for turning the iPad on 
and off as well as adjusting the volume in class and at home. 

• Look for opportunities for the pupil to problem-solve when the iPad is too 
quiet or loud i.e. by changing the setting without the pupil’s knowledge.  

• Challenge the pupil to provide instructions on turning the iPad on and off 
and un/locking the screen so that a friend could follow these and know the 
main differences between them if appropriate. 

 

Think SMART! 

S – Which buttons will the pupil focus on during the lesson? How will you know 

that they can differentiate between the power being off and the screen being 

locked? 

M – How many buttons will they be able to successfully identify and activate?  

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Is the pupil able to differentiate yet or will the focus be on identifying when 

the iPad is locked or off?  

T – Will the pupil require more lessons in order to develop their confidence in 

un/locking an iPad and turning the iPad on and off first? 
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Instructions for Lesson 2: Lock Options 
 

 

 

 

Turning the iPad on/off and sleep/wake (for iPads with home button) 
 

To turn on 
 

• Hold down Sleep/Wake button until the Apple logo appears. 

• If you have set a password, you will need to enter this before you can start 
using the iPad. 

 

To turn off 
 

• Hold down Sleep/Wake button until the slider appears onscreen. 

• Drag slider to right to power off 

Turning off saves power! 

 

To send to sleep 
Press the Sleep/Wake button once. The iPad will instantly go dark 

 

To wake up 
Press the Home button. If you have set a password, you will be prompted to 
enter this now.  

 

Turning the iPad on/off and sleeping (for iPads without a Home 
button) 
 

To turn on   

 

• Hold the iPad in portrait position. 

• Simultaneously press and hold the Sleep/Wake button at the top right and 
the volume up button.  
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Powering off    

 

• Hold the iPad in portrait position. 

• Press and hold the power button and one of the volume buttons (up or 
down) until the power-off slider appears. 

• Swipe across to turn off the device.   

  

To send to sleep 
Press the Sleep/Wake button once. The iPad will instantly go dark 

 

To wake up 
Press the Sleep/Wake button once or press somewhere on the screen. If you 
have set a password, you will be prompted to enter this now.  

  

Understanding the Status Bar 
The Status Bar can be found at the top of the iPad screen and gives important 
information about the iPad: 

• Left side: time and date 

• Right side: Wi-Fi and the battery charge level in percentage and 
graphically as a shaded battery. If you are using Bluetooth, have engaged 
the Orientation lock, or are in the middle of a download, these icons can 
also be found here.  

 

Charging 
 

To connect to the mains 
Connect USB connector on the charging cable to adaptor, and then insert the 
smaller end into the connector port at the bottom of the iPad (just below the 
Home button). When charging, the iPad will chime and a picture of a battery 
with an electricity flash will appear on screen.  

 

To connect to a PC (for a slower charge) 
 

• Connect USB connector on the charging cable to a USB port in the laptop. 

• Connect the smaller end into the connector port on the iPad. 



 
 

32 
 

• Ensure the laptop is connected to a power source otherwise the iPad will 
just drain its power.  

 

Use of Home button 
Pressing the Home button once will take you back to the Home screen if you 
are elsewhere e.g. exploring settings or using an app. 

 

Pressing the Home button twice will show you the apps that are already 
opened.  Tap on the icon to take you back to the app. Alternatively, swipe up to 
close the app.  

 

Holding down the Home button for a few seconds will open Siri.   

 

Find Control Centre 
Use Control Centre for quick access to camera, brightness, volume, timer etc.  

 

Swipe down from top of the screen with 2 fingers to bring up the Control Centre. 
Tap on the icon you want to use. 

 

To remove it again, swipe it back up or press the Home Button to return to the 
Home screen.  

 

Passwords 

 

Passwords are an important way to keep a device, and personal documents 

protected. When a password is set, the iPad will ask for this password each 

time the iPad is turned on, or woken up after sleeping.  

Not all services and settings allow pupils to password-protect devices, although 

others will require it. It is important to teach pupils how to devise and remember 

secure passwords, and to keep them safe and private. However, it may be a 

prudent precaution for them to share their password with a member of the VI 

service in case of emergencies. 
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How to set a passcode  
 

• Go to Settings  

• Tap on Touch ID & Passcode 

• Tap on Turn Passcode On. 

• Enter a 6-digit numeric password. 

• Re-enter at the Confirm prompt 

The password is now set.  

 

Alternatively press Passcode options to give you alternative passcode 
formats:  

• Custom Alphanumeric Code (for a mixture of letters and numbers) 

• Custom Numeric Code (for more than 6 numbers) 

• 4-digit Numeric code (less secure but possibly more appropriate for some 
pupils) 

To change the passcode 
 

• Go to Settings 

• Tap on Touch ID & Passcode 

• Tap on Change Passcode.  

• Enter your old passcode when prompted. You will then be able to enter a 
new one.   

 

To turn off the passcode 

 

• Go to Settings 

• Tap on Touch ID & Passcode 

• Tap on Turn Passcode Off. 

 

You will be prompted to enter your passcode to confirm identity.  

Setting up Face ID and Touch ID 
 

On some models, it is possible to set up the iPad to unlock using face or 
fingerprint recognition.  

 



 
 

34 
 

• Go to Settings 

• Tap on Touch ID & Password 

• Turn ON Fingerprint recognition and follow the instructions to add a 
Fingerprint. 

 

Additional fingerprints can be added using the ‘Add a Fingerprint’ option below.  

 

Use of Face or Touch ID does not mean that your pupil will not also need to use 
and remember their numeric password, as this will be required when you turn 
on or restart your iPad, after 2 days of not using your iPad, when you haven’t 

used both password and Face/Touch ID for a certain amount of time, and if you 
have had 5 unsuccessful attempts to open your iPad using Face or Touch ID.  

 

Changing the lock settings 
 

You might wish to extend the amount of time the iPad remains awake before 
locking or, conversely, have it lock down more quickly.  

 

• Go to Settings 

• Tap on Display & Brightness in the menu on the left.  

• The current setting will be displayed to the right of Auto-Lock (2 minutes is 
the default). To change, tap the arrow to the left of ‘2 minutes’ to bring up 
other time settings. Tap on the one you want to tick it. 

• Press Back to return to the Display & Brightness menu, or the Home key 
to return you to the Home Screen.  

 

Lock or unlock the screen orientation  
  

You can lock the screen orientation so that it doesn’t switch between landscape 

and portrait when you rotate iPad.  

• Open Control Centre by dragging down from the top right-hand corner of 

the screen with 2 fingers. 

• Find the Lock icon. It looks like this:   

• Tap it to lock the screen orientation. The padlock will shut and the icon will 

turn red against a pink background.  
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Instructions for Lesson 2: Volume and Sound 
 
 
 

Adjust the volume  
Use the Volume up and down buttons on the side of iPad to adjust the volume 
of media, alerts, and sound effects.  
Alternatively, use Siri. Hold down the Home button and say, for example, “Turn 
up the volume” or “Turn down the volume.”    
  

Mute the sound  
Press and hold the Volume Down button.  
  

Using Do Not Disturb to temporarily silence calls, alerts, and notifications  
 

• Open Control Centre. 

• Tap on the crescent moon signal to open ‘Do Not Disturb’. 

• Otherwise touch and hold the sign to bring up the menu for options on 
how long to silence calls, alerts etc.  

 
The ‘Do Not Disturb’ menu can also be found under Settings.   
 

Turn off sounds 
 

• Open Settings 

• Go into the Do Not Disturb menu 

• Under ‘Silence’, you can opt to have silence ‘always’ or ‘while iPad is 
Locked’. Ticking ‘always’ will silence all incoming calls and notifications at 
all times.   

  

Change sounds  
 

• Open Settings  
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• Go into the Sounds menu. The menu shows sounds associated with the 
various actions and alerts. Tap on the existing sound setting to see and 
hear the other options.  

You can also opt to have keyboard clicks when using the on-screen keyboard, or 
to lock existing sounds through the toggle key. 

Set sound level for ringer and alerts  
 

• Open Settings  

• Go into the Sounds menu 

• Use the Ringer and Alert slide to change volume. 

• Set options for alert tones and ringtones, and ringer and alert volumes.   
  

Lock the ringer and alert volumes  
This locks the volume of ringers and alerts and means they cannot be affected by 
the volume buttons. 

• Tap on Settings 

• Tap on Sounds to go into the Sounds menu 

• Toggle to turn OFF ‘Change with Buttons’ (at the top).   
 

   

Limit the headphone volume  
You can limit the maximum headphone volume for music and videos to protect 
your hearing.  

• Open Settings 

• Tap on Sounds 

• Turn on Reduce Loud Sounds, then drag the slider to choose the maximum 
decibel level for headphone audio.  

  
Note: If you have ‘Screen Time’ turned on in Settings, you can prevent changes to 
the maximum headphone volume. Go to Settings > Screen Time > Content & 
Privacy Restrictions > Reduce Loud Sounds, then select Don’t Allow.  
  

 Alternatively, you can 

• Open Settings 

• Tap on Music 

• Tap on ‘Volume Limit Off’ to turn it on. Use the slider to set maximum 
volume. 
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Lesson 3: App Control 

 

 

Outcome 

Explain and/or model how to switch between apps, close apps and search for 

an app.  

 

Links to Previous Learning 

Ensure that the pupil is confident in applying named gestures taught in Lesson 

1, Unit 2.  

 

Preparation 

The pupil will require access to a few familiar apps i.e. Notes, Pages, Safari, 

PowerPoint.  

 

Key Vocabulary 

 

App Switcher, close, Search 

 
Activity 

 

Demonstrate how to locate apps quickly using the search menu, distinguishing 
between this and manually searching. Identify the pros and cons of using this 
feature. Encourage the pupil to use the quick search feature in order to locate 
named apps. Extend this to closing apps when they have finished with these, 
discussing the relation between this action and the battery life of the 
iPad. Model how to switch between apps in order to combine their functionality 
and produce work in a more accessible format. Challenge the pupil to complete 
short tasks using two apps simultaneously.  Extend to three if applicable. 
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Tailor it!  

• Increase or decrease the amount of apps available on the iPad for the 

pupil to search between and close. 

• Provide apps for the pupil to switch between which will be the most useful 

for the pupil and reflect their current school curriculum IT skills i.e. the 

pupil may have been introduced to Safari and Pages. 

• Use VoiceOver gestures to complete the actions (ensuring that the pupil 

has completed Unit 5b).  

• Use Item Chooser with VoiceOver to locate an app. 

 

Let’s Apply! 

• Look for opportunities to use the quick search feature to locate required 

apps within the classroom and home environment.  

• Provide opportunities for the pupil to produce work in an electronic format 

and extract information from other apps i.e. Safari in class and within the 

home environment.  

 

Think SMART! 

S – Which skills will the pupil be able to demonstrate by the end of the lesson? 

Will they be able to model it and/or explain how to complete an action and/or 

how this can be utilised to complete tasks? To whom are they going to model or 

explain? 

M – How many skills will they be able to model/explain by the end of the 

lesson? How many steps are accurate? How many attempts are accurate? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Reflect on the pupil’s language skills and development in order to determine 

how the pupil will demonstrate they can switch between apps, close apps and 

search for an app. They may feel more comfortable doing this in an alternative 

way i.e. videoing it to show at a later date or showing a familiar peer which is 

observed.  

T – Will the pupil be confident in explaining and/or modelling these skills in one 

lesson or do they need each skill to be introduced separately over a longer 

period of time? 
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Instructions for Lesson 3: How to use and explore 

apps 

 

 

Open apps on the Home screen  

• At the Home screen, wipe up from the bottom edge of the screen. 

• Swipe left or right to browse apps on other Home screen pages.  

• To open an apps, tap its icon. 

• To return to the first Home screen page, either swipe up from the bottom 
edge of the screen or simply press the Home key.  

 

Managing multiple open apps 
You will often have more than one app open at a time, and it’s important to 
know how to switch from one app to another easily.  
 
The simplest way to move from one app to another is either to swipe across the 
screen with four or five fingers to go to the next app, and then the next and the 
next. Alternatively, swipe left or right along the bottom edge of the screen. You 
may need to swipe with an arc on later models.    
 
For iPads with a Home button, click twice on the Home button 
 
You can also do this using devices called the Dock; and the App Switcher.  
 

Using the Dock 
The iPad Dock is a handy area at the bottom of the screen that can store 
frequently used apps or those you accessed recently. The left side of the Dock 
contains your favourite apps. Suggested apps appear on the right-hand side.  
 
How to open the Dock 
From the Home screen, the Dock is always visible. Simply tap on the app you 
want to go to. 
When in an app, simply swipe up from the bottom edge of the screen, pause to 
reveal the Dock, then tap the app you want to use. To hide it again swipe down 
on the Dock. 

Using the App Switcher 
To open the App Switcher, swipe up from the bottom edge of the iPad and 
pause in the centre of the screen to see all open apps pop up on screen. 
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If your iPad has a Home button, you can also reach the App Switcher by 
double-clicking on this.  
 
To browse the open apps: swipe right, then tap the app or Split View 
workspace you want to use.  
To return to the Home screen: press the Home button, swipe up from the 
bottom of the screen, or else quickly pinch four or five fingers together.   
  
  

Move and organise apps  
 

1. Move apps around the Home Screen, into the Dock, or to other pages  
Touch and hold any app on the Home Screen, then tap Edit Home Screen. The 
apps begin to jiggle.  
You can drag the app to one of the following locations:  

• Another location on the same page  

• The Dock at the bottom of the screen. The dots above the Dock tell you 
how many pages there are and which one you are viewing at the 
moment.  

• Another Home Screen page. Drag the app to the right edge of the screen. 
The new page will appear shortly. 

Tap Done when you are finished. You can find this at the top of the screen on 
the right.   

  

2. Create folders and organise your apps  
You can group your apps in folders to help you find them more easily on the 
Home Screen.  

• Touch and hold any app on the Home Screen, then tap Edit Home 
Screen. The apps begin to jiggle.  

• To create a folder, drag an app onto another app.  

• Drag other apps into the folder. You can have multiple pages of apps in 
the folder.  

• To rename the folder, tap the name field, then enter the new name.  

• When you’re finished, tap Done (top right).  
 
To delete a folder, drag all the apps out of the folder. The folder will 
automatically delete.  
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3. Quit and reopen an app on iPad  
If an app isn’t working properly, you can quit it and then try to reopen it. Quitting 
and reopening the app may resolve the problem. (Typically, there’s no reason to 
quit an app; quitting it doesn’t save battery power, for example.)  
To quit an app, open the app switcher, then swipe up on the app.  
To reopen the app, go to the Home Screen, then tap the app.  
If quitting and reopening the app doesn’t solve your problem, try restarting the 
iPad  
  

4. Delete apps from iPad Home screen 
You can easily delete apps from your iPad. If you change your mind, you can 
download the apps again later.  

• Touch and hold an app you want to delete to open a quick actions menu, 
then tap Delete App. If the apps begin to jiggle, tap on the X symbol by 
the app you want to delete.   

• Tap Delete. If the apps are still jiggling, tap Done at the top right.  
  
  

  
  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

42 
 

Lesson 4: Getting Organised 

 

 

Outcome 

The pupil can utilise their iPad to efficiently locate apps on their iPad within 

folders, schedule alarms and reminders and adapt the Control Centre to suit 

their individual needs.  

 

Links to Previous Learning  

For pupils who require VoiceOver to successfully access this lesson, they will 

need to complete Unit 5b before this lesson.  

 

Key Vocabulary 

Folders, alarms, reminders, Control Centre 

 

Activity 

Model how to create folders, discussing the purpose of these in order to locate 
apps easily. Encourage the pupil to set up their own iPad, utilising folders to 
store relevant apps. Then explore the Reminders app, modelling how to set up 
reminders and schedule alarms from this. Discuss when this would be useful 
within the pupil’s everyday context i.e. to set reminders for homework. Introduce 
Siri as an alternative tool to complete these actions and encourage the pupil to 
practise both ways until they identify their preference. Explore the Control 
Centre, ensuring the pupil is able to successfully open and close this using the 
appropriate gesture. Which apps do they need to use the most? Focus 
particularly on functions which will increase access i.e. Accessibility Shortcuts, 
Magnifier, Text Size, Brightness etc. Encourage the pupil to adapt their Control 
Centre to suit their own needs.  
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Tailor It! 
 

• If appropriate, model and provide guidance for the pupil to access and 
close the Control Centre using VoiceOver.  

• If appropriate, model and provide guidance for the pupil to edit and create 
folders using VoiceOver.  

• Present the pupil with less or more apps to put into folders.  

• Adapt how many functions to focus on from the Control Centre.  
 
 
 

Let’s Apply! 

• Expand the pupil’s use of Siri as an organisation tool to check the date 

and time.  

• Extend personal organisation of the iPad by adapting the Notification 

Centre. If the pupil is a VoiceOver user, ensure they are able to access 

and close this using the appropriate gestures.  

• Encourage the pupil to independently locate apps within the classroom 

and home environment. 

• Encourage the pupil to utilise their reminders and alarms rather than 

relying on others to organise their workload. 

• Provide opportunities for the pupil to access the Control Centre to quickly 

access a function within everyday opportunities.  

 

Think SMART! 

S – Which adaptations will the pupil be able to apply to their own iPad by the 

end of the lesson? How will ‘efficient’ be determined? 

M – How many folders will they make? Can they provide accurate instructions 

on how to make folders, adapt the Control Centre and schedule alarms and 

reminders? On how many occasions do you expect them to be successful?  

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Are all/some of the skills not relevant to the pupil at this time?  

T – Will the pupil be able to learn all of these skills and why they can be useful 

for the pupil within one lesson or will they need more time to gain a good 

understanding of the Control Centre, alarms and reminders and using app 

folders 
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Instructions for Lesson 4 – Files and Filing 
 

 

Open files and folders 
Tap on Files from the Home Screen. It may be on the Dock at the bottom of the 
screen. 
To see recently opened files, tap Recents at the bottom of the screen. 
Otherwise tap on Browse. You will see a list of folders you have recently used 
which can be explored by tapping on them. 
Tapping on Browse again will open the Browse sidebar which gives additional 
locations and options. 

Change how files are sorted within folders 
With an open file, tap Name, Date, Size, Kind, or Tags to sort as you wish.  
 

Change how to view the files 
From an open location or folder, drag down from the centre of the screen, then 
do one of the following: 

View as icons: Tap . 

View as a list: Tap . 

View as columns: Tap . 
To look deeper into a folder hierarchy from the column view, tap an item in the 
rightmost column, then swipe left. To see a preview of a file along with its 
metadata (such as its kind and size), tap the file. (If the preview doesn’t appear 
in the rightmost column, swipe left.) To view the file and perform various actions 
on it without leaving Files, tap Open under the file preview. 

Find a specific file or folder 
Within Files, use the Search box to enter a filename or folder name.  
Focus the scope of your search by tapping Recents, Date, Size Kind or Tags. 
 

To hide the keyboard and see more results on the screen: Tap . 
 
To start a new search, tap your search terms into the search field.  
Tap to open a result.  
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Rearrange the Browse sidebar 

Tap  at the top of the sidebar, tap Edit, then do any of the following: 
 
Hide a location: Turn the location off. 

Delete a tag and remove it from all items: Tap the Remove symbol  next 
to the tag.  
Remove an item from the Favorites list: Tap the Remove symbol next to the 
item.  
Change the order of an item: Touch and hold the three-line symbol to the 
right of the items, then drag it to a new position. 
 

Create a folder 
 

• From the Files app, open a location or an existing folder. 

• Drag down from the centre of the screen, then tap . 

Note: If you don’t see , you can’t create a folder in that location. 

Rename, compress, and make other changes to a file or a folder 
 
Touch and hold the file or folder, then choose an option: Copy, Duplicate, Move, 
Delete, Rename, or Compress. 
 
To modify multiple files or folders at the same time, tap Select, tap your 
selections, then tap an option at the bottom of the screen. 
 
Note: Some options may not be available, depending on the item you select; for 
example, you can’t delete or move an app library (a folder labelled with the app 
name). 
 

Mark a folder as a favourite 
Touch and hold the folder, then tap Favorite. 
Favorites appear in the Browse sidebar. 
 

Send files to others 
You can send a copy of any file in the Files app to others. If you have a 
document you want to send that isn’t digitized, you can scan it with Files first. 

• Touch and hold the file, then tap Share. 
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• If the file is too big for sharing, tap Compress before you tap Share. Then 
touch and hold the compressed version of the file (identified as a zip file), 
and tap Share. 

• Choose an option for sending (for example, Messages or Mail), then tap 
Send. 

 
Tip: If the files or folders are stored in iCloud Drive, you can invite others to 
view or edit their contents rather than send them copies. 
 

Set up iCloud Drive on iPad 
 
In Files, you can store files and folders in the iCloud drive. This is built into later 
iPad devices (iPad OS 13 onwards).  
 

Turn on iCloud Drive 
 

• Tap on Settings 

• Tap on your name at the top of the left-hand menu 

• Tap on iCloud and turn on the iCloud Drive.  
 

Choose which apps use iCloud Drive 
 

• Tap on Settings 

• Tap on your name 

• Tap on iCloud. 
Apps are listed under Apps Using iCloud. Toggle the button ON to 
selected those to use the iCloud Drive.  
 

Browse iCloud Drive 
 

• Tap on Files 

• Tap Browse at the bottom of the screen twice to bring up the Sidebar.  

• Under Locations, tap iCloud Drive to browse folders and files.  

• To open a folder, tap it. 
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Instructions for Lesson 4: Using Reminders 
 
 

 

The Reminders app enables you to create and organise to-do lists, as well as 
choose when and where to receive reminders.    

Add a reminder 
Open the Reminders app. 
When in a list, tap New Reminder, then enter text. Or if you have Apple Pencil, 
write in the text field. 
Use the quick toolbar above the keyboard to do any of the following: 

• Schedule a date and time: Tap the clock symbol to select today, tomorrow 
or this weekend, or else a custom date. 

• Add a location with the arrow key. This will tell you where you want to be 
reminded. Default option is ‘Getting in the car’ but you can add any 
location in custom settings. N.B. To receive location-based reminders, you 
must allow Reminders to use your precise location. Go to Settings > 
Privacy > Location Services, turn on Location Services, tap Reminders, 
choose While Using the App, then turn on Precise Location. 

• Tap on the flag symbol to mark an important reminder. 

• Tap on the camera icon to assign a photo to the event. You can choose to 
use an existing photo, scan a document, or take a snap on the spot. 

To add more details to a reminder 
 
Tap the little information sign next to the event, then do any of the following: 

• Add notes: In the Notes field, enter more info about the reminder. 

• Add a web link: In the URL field, enter a web address. Reminders 
displays the link as a thumbnail that you can tap to go to the website. 

• Get a reminder when chatting with someone in Messages: Turn on 
“When messaging,” then choose someone from your contacts list. The 
reminder appears the next time you chat with that person in Messages. 

• Set a priority: Tap Priority, then choose an option. 
To finish, tap Done. 
 

Mark a reminder as complete 
Tap the empty circle next to a reminder to mark it as complete. This will erase it 
from the Reminders lists.  
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To unhide completed reminders click the settings button with 3 dots in the top 
right corner, then tap Show Completed. 

 

Edit multiple reminders all at once 
 

• Tap the 3 dots Settings button and then Select Reminders. 

• Select the reminders you want to edit, by tapping the circles next to them 
or dragging 2 fingers over the reminders to be edited. 

• Use the buttons at the bottom of the screen to select the action: Delete, or 
move to another list.  
 

Organising reminders in lists 
 

The Reminders app enables you to organise your reminders in lists and groups.  

Use smart lists 
You can automatically track and organize upcoming reminders with smart lists. 
Tap any of the following: 
Today: See reminders scheduled for today and overdue reminders. 
Scheduled: See reminders scheduled by date or time. 
Flagged: See reminders flagged as important. 
Assigned to Me: See reminders assigned to you. [only available on some 
models] 
Siri Suggestions: See suggested reminders detected in Mail and Messages. 
[only available on some models] 
All: See all your reminders across every list. 
To show, hide, or rearrange the smart lists, tap Edit. 

 

Create reminder lists and groups 
You can organize your reminders into lists and groups of lists such as work, 
school, or shopping. Do any of the following: 
Create & customise a new list: Tap Add List, enter a name, then choose a 
colour and symbol for the list. 
Create a group of lists: Tap Edit, tap Add Group, enter a name, then tap 
Create. Or drag a list onto another list. 
Move and reorder lists: Touch and hold a list, then drag it to a new location. 
Change colour or symbol of a list or group: Swipe left on the name, then tap 
the information button to change the colour or symbol.  
Delete a list or group: swipe left on the list or group, then tap the delete icon. 
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Move reminders into a list 
Touch and hold the reminder. Drag it across into your chosen list.  
 

Make a subtask 

• Tap on the information symbol to the right of your message.  

• Go to ‘subtasks’ towards the bottom of the menu, and tap the arrow to the 
right of it.  

• Tap Add Reminder and type in your sub-task.  

• Tap on Add Reminder again before tapping on the back arrow to return 
you to the menu.  

• Don’t forget to tap on Done before going back to the main app screen.  
 

If you delete or move a parent task, the subtasks are also deleted or moved. If 
you complete a parent task, the subtasks are also completed. 
 
 
Delete a reminder 
Swipe left on the reminder, then tap Delete. 
 

Change your Reminders settings 
Tap on Settings 
Tap on Reminders to go to the reminders menu. 
Options include:  
Today Notification: Set a time to show notifications for all-day reminders that 
have been assigned a date without a time. 
Show as Overdue: The scheduled date turns red for overdue all-day 
reminders. 
Mute Notifications: Turn off notifications for assigned reminders. 
 
See also: 

Share reminders and collaborate on iPad - Apple Support 
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Instructions for Lesson 4: Using the Calendar 
 
 

 

Set up a calendar account 
Tap on Settings 
Tap on Calendar 

Go to Accounts, then Add Account. 
Tap Other, then do any of the following: 
Add a calendar account: Tap Add Account, then enter your server and 
account information  
Subscribe to iCal (.ics) calendars: Tap Add Subscribed Calendar, then enter 
the URL of the .ics file to subscribe to; or import an .ics file from Mail. 

Add an event to your calendar 

• Go into the Calendar app 

• Tap on the plus button (top right). 

• Fill in the event details. 

• Enter the name and location of the event, the start and end times, how 
often it repeats, and so on. 

• Tap Add. 
 
Alternatively, you could use Siri: 
 
To use Siri say “Hey Siri” and make your request e.g. “Hey Siri add Science 
lesson at 10am next Monday, to my calendar”.   
 
You can also use Siri by pressing and holding down the ‘power button’ until Siri 
appears and saying eg “open my calendar”.  

 

Delete an event 
Tap on the event in your calendar 
A pop-up menu will appear on the screen. 
Tap Delete Event at the bottom of the menu, and then confirm that you want to 

delete it when prompted. 
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Editing the event 
The Edit menu allows you to make changes to the start and end time of your 
event, put in whether it repeats, add details about travel times and invitees and 
others. To reach it, tap on the event in the Calendar and tap Edit (top right). 
 
 

Change event time 
From the Edit menu, tap on Starts or Ends and edit as necessary. 
 

 

Set an alert 
To set an alert to be reminded of an event beforehand, tap Alert in the Edit 
menu and choose when you’d like to be reminded – when it is time to leave, 
when the event is due to start, or minutes, hours or days beforehand.  
 
Note: If you add the address of the event’s location, Calendar uses Apple Maps 
to look up locations, traffic conditions, and transit options to tell you when it’s 
time to leave. 
 

Add an attachment to an event 
To add an attachment to a Calendar event to share with invitees, tap on Add 
attachment in the Edit menu.  
 
The Files app opens, displaying your recently opened files. If the file is here, 
you can just tap it to attach. Otherwise, you can enter the file name in the 
Search bar, or tap the Browse option at the bottom of the screen to look in other 
locations.  
 
When you have selected the file, you will return to the Edit Event menu. Tap 
Done to confirm changes and come out of it. 
 

Remove an attachment 
Tap on the event in the calendar. 
Tap Edit (top left). 
Go down to the attachment name and swipe right. The ‘Remove’ option will 
appear from the right. Tap on it.  
 

Find events in other apps 
Siri can suggest events found in Mail, Messages, and Safari—such as flight 
reservations and hotel bookings—so you can add them easily in Calendar. 

• Tap on Settings 
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• Tap on Calendar 

• Tap on Siri & Search to show and edit current Siri settings for Calendar. 
You can choose to allow Siri to make suggestions in Calendar and learn 
from how you use the app; or to show Siri Suggestions on Lock screen 
based on how you use the Calendar.  

 

Change how you view events 
In the Calendar app you can view one day, a week, a month, or a year at a 
time. 
Either tap on Day, Week, Month or Year at the top of the screen or alternatively 
pinch to zoom in or out when in Week or Day view. 

To view upcoming events, you can tap the ‘view list’ symbol    

 
Send and receive invitations 
In the Calendar app, you can send and receive meeting invitations. N.B. Not all 
calendar servers support every feature.  

Invite others to an event 
If you scheduled the event:   

• Tap the event, tap Edit, then tap Invitees. 

• Type in the names or addresses of the people you’d like to invite. If you 
tap the Plus sign, you can browse your Contacts. 

• Tap Done when you are finished. 
If it’s someone else’s event: 

• Tap the event, tap Invitees and then tap the envelope. 

• Type in the names or addresses of the people you’d like to invite. If you 
tap the Plus sign, you can browse your Contacts. 

• Tap Send when you are finished.  

 

Respond to a diary invitation 
To respond to an event notification, tap it. You could also check your Inbox 
(bottom right of the screen). 
Tap your response—Accept, Maybe, or Decline. 
 
To respond to an invitation you receive by email, tap the underlined text in the 
email, then tap Show in Calendar. 
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Schedule a meeting without blocking your schedule 
You can add an event to your calendar without having the timeframe appear as 
busy to others who send you invitations. 

• Tap the event, then tap Edit. 

• Tap Show As, then tap Free. 
 

Suggest a different meeting time 
You can suggest a different time for a meeting invitation you’ve received. 

• Tap the meeting, then tap Propose New Time. 

• Tap the time, then enter a new one. 

• Tap Done, then tap Send. 

 
 
 
  
See also: 
 
Search for/customise/track events  
https://support.apple.com/en-gb/guide/ipad/ipad6a79cb00/14.0/ipados/14.0   
  
https://support.apple.com/en-gb/guide/ipad/ipadfe71d772/14.0/ipados/14.0   
  
https://support.apple.com/en-gb/guide/ipad/ipad580b4126/14.0/ipados/14.0   
  
Use multiple calendars  
https://support.apple.com/en-gb/guide/ipad/ipad1b02bf5b/14.0/ipados/14.0   
  
  
Share iCloud calendars  
https://support.apple.com/en-gb/guide/ipad/ipadc2a14a22/14.0/ipados/14.0   
  

 
 
 
 
 
 
 
 

https://support.apple.com/en-gb/guide/ipad/ipad6a79cb00/14.0/ipados/14.0
https://support.apple.com/en-gb/guide/ipad/ipadfe71d772/14.0/ipados/14.0
https://support.apple.com/en-gb/guide/ipad/ipad580b4126/14.0/ipados/14.0
https://support.apple.com/en-gb/guide/ipad/ipad1b02bf5b/14.0/ipados/14.0
https://support.apple.com/en-gb/guide/ipad/ipadc2a14a22/14.0/ipados/14.0
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Instructions for Lesson 4: Using Notifications 
 
 

 
 
Notifications help you keep track of what’s new—if you have a missed call, if an 
event has been postponed, even top news stories – and they can be 
customised so that you only see what is important to you.  

Read your notifications 
Notifications will be displayed as they arrive, but if you choose not to read them 
immediately, they are saved in the Notification Centre.  
You can reach Notification by swiping down from the top centre of the iPad 
screen, and then scrolling down to see older Notifications. 
To close Notification Center, swipe up from the bottom, or press the Home 
button. 

Respond to notifications 
When you have multiple notifications in Notification Center or on the Lock 
Screen, they’re grouped by app, which makes them easier to view and manage. 
Notifications from some apps may also be grouped by organizing features 
within the app, such as by topic or thread. Grouped notifications appear as 
small stacks, with the most recent notification on top. 
 
Do any of the following: 

• To expand a group of notifications to see them individually, tap the group. 
To close the group again, tap Show Less. 

• Tap a notification to open the app that it’s from and respond. 

• Touch and hold a notification to view it and perform quick actions if the 
app offers them. Or swipe the notification left, then tap View. 

• To respond when iPad is locked, touch and hold the notification. 

Dismiss, clear, and manage notifications 
 
Do any of the following: 
Handle a notification you receive while using another app: Pull it down to 
view it, then swipe up to dismiss it. 
Clear notifications: Swipe left over the notification or group, then tap Clear or 
Clear All. 
Turn off notifications for an app or notification group: Swipe left on the 
notification or group of notifications, tap Manage, then tap Turn Off. 
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Change how an app displays notifications: Swipe left on a notification, tap 
Manage, tap Settings, then choose an option. You can choose whether to allow 
notifications from the app, where the notifications appear (in Notification Centre, 
for example), whether to play an alert sound, and so on. 

Clear all your notifications in Notification Centre: Tap , then tap Clear. 
When you haven’t used an app for a while, Siri suggests that you turn off 
notifications for that app. 

Change notification settings  
You can choose which apps can send notifications, change the alert sound, set 
up location-based alerts, allow government alerts, and more. Most notification 
settings can be customized for each app. You can turn app notifications on or 
off, have notifications play a sound, choose how and where you want app 
notifications to appear when your device is unlocked, and more. 
 

Allowing Notification Previews 
Notifications give you a quick summary or snapshot of a full Notification, and 
may include text from Messages or Mail, or invitation details from Calendar. 

• Tap on Settings 

• Tap on Notifications. 

• Tap on Show Previews and select an option—Always, When Unlocked, or 
Never. (You can override this setting for individual apps.) 

 

Choosing which Notifications to allow 
 

• Tap on Settings 

• Tap on Notifications. 

• Below Notification Style, tap on each app to toggle Allow Notifications On 
or Off.  

 
If you turn on notifications, choose how and where you want the notifications to 
appear for the app—for example, on the Lock Screen or in Notification Center. 
You can also set a notification banner style, sound, and badges for many apps. 
 
Tap Notification Grouping, then choose how you want the notifications grouped: 
By App: All the notifications from the app are grouped together. 
Automatic: The notifications from the app are grouped according to organizing 
criteria within the app, such as by topic or thread. 
Off: Turn off grouping. 
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Show recent notifications on the Lock Screen 
 

• Tap on Settings 

• Go to Touch ID & Passcode. You will be asked to enter your passcode to 
get in. 

• Toggle on Notification Centre (below Allow Access When Locked).  

Set Do Not Disturb 
To quickly silence iPad, whether you’re going into a lesson or going to bed, turn 
on Do Not Disturb. It silences notifications and calls and prevents them from 
lighting up the screen. 

• Tap on Settings 

• Tap on Do Not Disturb 

• Toggle on. 
 
Do Not Disturb can also be turned on via the Control Centre. 

Allow calls when Do Not Disturb is on 
 

• Tap on Settings 

• Tap on Do Not Disturb 
Do any of the following: 
Tap Allow Calls From: To allow incoming FaceTime and Wi-Fi calls from 
selected groups. 
Turn on Repeated Calls: To allow repeated calls from the same caller to come 

through for emergencies. 

Allow calls from emergency contacts when Do Not Disturb is on 
You can allow FaceTime and Wi-Fi calls and messages from emergency 
contacts when Do Not Disturb is on. 

• Open Contacts from the Home Screen. 

• Select a contact, then tap Edit. 

• Tap Ringtone or Text Tone, then turn on Emergency Bypass. 

Schedule quiet hours 

Go to Settings  > Do Not Disturb. 
Turn on Scheduled, then set the start time and end time for quiet hours. 
Tip: To dim your display during quiet hours, turn on Dim Lock Screen. 
Do Not Disturb turns off automatically at the end of the quiet hours you specify. 
To turn it off sooner, tap the Do Not Disturb notification on the Lock Screen, 
then tap Turn Off. When Do Not Disturb is off, notifications resume. 
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Instructions for Lesson 4: The Control Centre 
 

 
 
The Control Centre on an iPad gives you instant access to useful controls—
including airplane mode, Do Not Disturb, a flashlight, volume and screen 
appearance controls and instant access to apps.   
 

Open Control Centre 
Swipe down from the top right of the screen with 2 fingers. To close it again, 
swipe up from the bottom of the Panel, or just return to the Home screen using 
the Home key or swiping up from the bottom of the screen. 
 

Appearance options in Control Centre 
The Control Panel is automatically set to include a variety of appearance 
options. 
 

1. Adjust the screen brightness 
The brightness slider (with a sun on it) can be moved up or down to instantly 
increase or decrease brightness. 
 
This can also be achieved by going to Settings > Display & Brightness and 
using the slider to adjust brightness. 
 

2. Turn Dark Mode On or Off  
Touch and hold the brightness button. You will see a Dark Mode button which 
can be tapped ON or OFF. 
 

3. Turn Night Shift On or Off 
Touch and hold the brightness button. You will see a Night Shift button. Tap to 
turn ON or OFF.    
  
4. Turn True Tone on or off (only available on some models) 
Touch and hold the brightness button. You will see a True Tone button. Tap to 
turn ON or OFF.  
 

5. Change the text size 
In Control Panel, click on the Text button. It will open to give you a sliding scale 
of text size. Adjust as required.   
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6. Turn on magnifying glass 
In Control Panel, tap on the magnifying glass. The iPad will open to Magnifying 
Glass, Use the slider at the bottom to increase or decrease magnification.  
 

Customising the Control Centre  

 

You can make changes and additions to the Control Panel to make it more 

useful and easier to use. 
 

Add more appearance options 

• Go to Settings 

• Tap on Control Centre. 

• At the top of the screen under ‘Include’ are the apps that are already on 
the Control Centre. 

• Under ‘More Controls’ are those that are not. To add more controls, tap on 
the green + button.  

 

Reorganising controls in your Control Centre 

• Tap on Settings 

• Tap on Control Centre 

• In the ‘Include’ menu, which lists those controls that are already in your 
centre, touch the symbol next to the control you want to move. It looks like 

3 lines. Drag it to its new position.  
 

 

Temporarily disconnect from a Wi-Fi network 

In Control Centre, tap the Wi-Fi icon ; to reconnect, tap it again. 
 
To see the name of the connected Wi-Fi network, touch and hold the Wi-Fi icon. 
 
Because Wi-Fi isn’t turned off when you disconnect from a network, AirPlay and 
AirDrop still work, and iPad joins known networks when you change locations or 
restart iPad.  
 
You can also turn Wi-Fi on and off in Settings > Wi-Fi. 
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Temporarily disconnect from Bluetooth devices 

In Control Centre, tap the Bluetooth icon ; to allow connections, tap the 
button again. 
 
Because Bluetooth isn’t turned off when you disconnect from devices, location 
accuracy and other services are still enabled.  
 
You can also turn Bluetooth On and Off in Settings > Bluetooth.  
 
 

 
 

 
 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 
 

 

 

How to use Guided Access  

 

 

This quick start guide is designed to help you get started using the Apple accessibility feature called 

Guided Access. Guided Access is a feature which enables you to lock the iPad within an app and 

control which app features are available. This is very helpful to stop children and young people from 

accidentally exiting apps and tapping on adverts within apps. 

 

 

Step 1: To turn on Guided Access, go to settings                . Select General on the 

left-hand side menu and then locate Accessibility from either the right-hand 

side or it may be further down the screen on the left-hand side. 

 

 

 

Step 2: Guided Access is either under the ‘Learning’ or ‘General’ section in the 

Accessibility menu. To turn this on, tap the button on the right of ‘Guided 

Access’.  

 

 

 

 

 

Step 3: You will now be in the Guided Access menu. Select ‘Guided Access’ by 

touching the button to its right. More options will then appear. 

 

 

 

 



 
 

 
 

Step 4: It is very important that you select ‘Passcode Settings’ underneath the 

option to turn on ‘Guided Access’. This will take you to another screen.  Select 

‘Set Guided Access Passcode’. This passcode is only for ‘Guided Access’ so it 

doesn’t have to be too complex but not one your child or young person will 

easily guess. Once you have entered your password, press the ‘Guided Access’ 

button at the top of the screen to return to the ‘Guided Access’ menu. 

 

Step 5: Come out of the Guided Access menu by pressing the Home Button and 

open an app you wish to use Guided Access with. 

 

 

 

 

Step 6: Start Guided Access by pressing the Home Button three times. This will 

shrink       the app screen into the middle of the iPad screen and you will see 

the Guided Access menu appear on a black background on the top and bottom 

of this. 

 

 

 

Step 7: To block out any adverts or options you don’t want your child or young 

person to select, draw around these with one finger. You will see a black line 

appear. The area you have chosen will change to grey. You can adjust how 

large the area to block out is by dragging your fingers on the small, white 

circles on the edge of the grey area. This can be repeated until all of the 

adverts and options that you don’t want are blocked out. This means that even 

if the child or young person touches these, nothing will happen.  

 

 

Step 8: You can also stop anything happening when the child or young person 

touches the ‘Sleep/Wake Button’, ‘Volume Buttons’, ‘Motion’ option and 

‘Keyboards’. This is done by selecting the ‘Hardware Buttons’ option or 

‘Options’ at the bottom left-hand side of the screen.  

 

 



 
 

 
 

 

Step 9: At the bottom of the screen you can also select ‘Touch’, which means 

that any onscreen touches are then ignored, and ‘Time Limit’, which sets a limit 

on how long Guided Access will run for. Once you have made your selections, 

press ‘Start’ at the top right-hand side of the screen. When you have finished 

within the app, press the Home Button again three times. You will be asked to 

enter the Guided Access passcode you set in Step 4 twice. Finally, select ‘End’ 

at the top left-hand side of the screen. 

 

 

 

 

 

 

 

 

 

If you have any difficulties in using Guided Access, please use the following link to find Apple User 

Guides which contain full details of Accessibility Features: 

http://support.apple.com/manuals/ 

 

Please note that accessibility features on electronic devices are updated regularly and therefore can 

change. This guide is designed to be as universal as possible for Apple devices but you may find slight 

differences depending on the operating system (or iOS) your device is using. 

 

 

 

 

Other useful hints include: 

In the Guided Access menu within Settings, choose ‘Time Limits’ – This will set a time limit on how long 

Guided Access will run for. There are two alarm options available, the first to warn you when half the 

time has gone and the second when the Guided Access session has finished. You can choose from a 

choice of sounds or ‘Speak’. 

In the Guided Access menu within Settings, choose ‘Accessibility Shortcut’- This means that when you 

want to quickly turn Guided Access on and off, you just have to press the Home Button three times.   

 

 

about:blank
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Aim 

For pupils with vision impairments to confidently use in-built magnification 

accessibility features on an iPad in order to enable access to electronic text and 

images based on their individual needs. 

 

Purpose 

Pupils will learn how to use the Zoom accessibility features of an iPad, 

developing their own preferences in use of features and gestures. They will also 

develop an understanding of when to apply these skills in order to access 

information in an electronic format through magnification.  

 

Let’s tailor it! - Baseline 

• What can they already do/explain? (Using the Skills Progression Checklist 

for Unit 4, baseline your pupil (B/L) to identify what skills they already 

have in order to progress through this unit.)  

• What do they want to be able to do? 

• What would their parent/carer like/need them to be able to do? 

• What would their teacher like/need them to be able to do? 

 

 

 

 

 

 

Unit 3 – Magnification 
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Medium-Term Plan 

Outcome 

The pupil can use the zoom accessibility features to successfully open and 

close the zoom menu, vary the magnification, quickly adjust the magnification, 

adjust a magnification window and pan around the screen in order to access 

increasingly more complex images and text using their own identified 

preferences. 

 

Lesson  Lesson 

Outcome 

Key Skills Key Knowledge  Links to 

Other 

Units 

Lesson 1: 

Introduction 

to Zoom     

Select, open and 

adjust the 

magnification 

using the Zoom 

menu on request 

with at least the 

Home screen 

using the slide 

feature. 

• How to open 

the Zoom 

menu 

•How to use the 

Zoom slider 
 

•What 

magnification is 

•How 

magnification 

can help to see 

images and text 

easier 

 

Lesson 2: 

Introduction 

to Panning 

Around the 

Screen   

Pan around the 

screen of a 

simplified image 

of an object or 

character to 

locate key 

features on 

request after 

applying the 

Zoom slider.  

• How to pan 

around the 

screen 

•That magnified 

parts of an 

image are part 

of a whole 

 

Lesson 3: 
Pan Around 
Multiple 
Images  

 

Pan around the 

magnified screen 

to locate a named 

image from 

multiple images. 

•How to pan 

systematically 

•That applying a 

systematic 

approach is 

more efficient 

Unit 5, 

Lesson 

2 
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Lesson 4: 

Comparing 

Methods to 

Activating 

Zoom     

Compare panning 

around the screen 

using a three-

fingered gesture 

to toggling with 

the zoom 

controller, 

identifying which 

method was the 

easiest to locate 

named 

information. 

•How to toggle 

around the 

screen using 

the Zoom 

controller 

•Similarities and 

differences 

between 

panning and 

toggling 

•Which methods 

suits their needs 

 

Lesson 5: 

Using Zoom 

to Track 

Along and 

Down Images 

and Text  

 

Use the zoom 
accessibility 
feature to pan 
around a screen 
in order to locate 
and track text and 
images from the 
top to the bottom 
of the screen 
when it is 
magnified. 

•Apply a 

systematic 

approach to 

toggle or pan 

along and 

down text and 

images 

•How Zoom can 

help to access 

images and text 

presented in 

class 

 

Lesson 6: 

The Zoom 

Magnification 

Window 

Compare locating 
named image or 
text using the 
magnification 
window to whole-
screen 
magnification, 
identifying which 
method was the 
most preferable. 

•Use and adjust 

a magnification 

window 

•Pan around the 

screen using a 

magnification 

window 

•Similarities and 

differences 

between the 

magnification 

window and 

whole-screen 

magnification 

•Which method 

suits their needs 
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iPad Accessibility Skills 
Unit 3 - Magnification 

How to use Zoom Progression 

Basic Skills Introduce Developing Achieved 

Use the shortcut Zoom menu to start and stop Zoom 
 

  

Use the slider to adjust magnification    

Use a panning gesture to move around the screen    

Use the three-finger double-tap gesture to magnify the screen    

Change the filter from the Zoom Controller menu    

    

Intermediate Skills    

Pan around the screen using the Controller    

Make the Zoom Controller easier to see     

Operate a Zoom window    

Resize the window    

Access the Zoom menu in the Accessibility Menu     

    

Advanced Skills    

Access advanced Zoom settings    
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Set a maximum level of magnification    

Set Follow Focus 
   

Set Smart Typing    

Enable Keyboard Shortcuts    

Apply a Zoom Filter    

    

Using Zoom with a pointer device    

Zoom Pan    

Adjust Size with Zoom    
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iPad Accessibility Skills 
Unit 3 - Magnification 

Using the Magnifier  Progression 

Basic Skills Introduce Developing Achieved 

Set up Magnifier using accessibility shortcut 
 

  

Set up Magnifier using Control Centre    

Turn on Magnifier (via Accessibility Shortcuts/Control Centre/Siri)    

Exit Magnifier    

    

Intermediate Skills    

Adjust magnification level    

Apply colour filters    

Invert colours    

Adjust Brightness (on supported iPad models)    

Adjust Contrast (on supported iPad models)    

Turn Flashlight on/off (on supported iPad models)    

Lock Focus (on supported iPad models)    

    

Advanced Skills    

Freezing images    

Freeze one image    

Freeze multiple images    

Save frozen images    
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Lesson 1: Introduction to Zoom 

 

 

Outcome 

Select, open and adjust the magnification using the Zoom menu on request with 

at least the Home screen using the slide feature. 

 

Preparation 

You will need to ensure the Zoom controller is on and visible.  

 

Key Vocabulary 

Zoom menu, magnify 

 

Activity 

Introduce the zoom accessibility menu as a shortcut on the main display. 
Discuss the best position of Zoom controller for pupil’s use. Demonstrate 
opening the zoom menu and locating the zoom slide bar at the bottom of the 
menu. Model zooming in and out before encouraging the pupil to use the slider 
to adjust magnification and develop their own understanding of their needs in 
relation to the strength of magnification.  

 

Tailor It!  

• Model using a triple-finger gesture to quickly adjust magnification, tailoring 
the maximum level of magnification to suit your pupil’s visual needs. 
Compare this method to using the Zoom slider on the Zoom menu and 
encourage the pupil to identify their preference to activating Zoom.  

• Try using a stylus or iPad crayon etc instead of using fingers to see if the 
pupil is more successful.  
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• If using a newer iOS version, change the Zoom menu’s colour to suit the 
pupil. 

• Explore the visibility of the Zoom menu and identify the pupil’s visual 
preference i.e. 50%, 75%, 100% idle etc.  

 

Let’s Apply!  

• When could you use Zoom in the classroom or home environment? 

• What other screens could you use this with? 

• What is happening when you Zoom in? Why is this useful? 

• What other equipment do you use that also magnifies? 

 

Think SMART!  

• S – Which skills are you going to focus on today?  

• M – How many occasions do you think the pupil could successfully zoom 

in and out of the screen on request? 

• A – What level of scaffolding will the pupil need be able to achieve the 

outcome on this occasion?  

• R – Can they access the Zoom controller slider with their functional vision 

or would the triple-finger gesture be more appropriate?  

• T – Could the pupil achieve all of the above in one lesson successfully 

and accurately on most occasions? Do you need to split the lesson to 

cover a number of weeks to achieve? 

 

 

 

 

 

 

 

 



 
 

68 
 

Instructions for Lesson 1: Using Zoom 
 

 

In many apps, it is possible to zoom in and out of the screen using the finger 

pinch and spread gestures. However, this doesn’t work with all of them and in 

such cases the inbuilt Zoom facility comes to the rescue. Most people will 

choose to magnify the entire screen (Full Screen Zoom), but you can also 

magnify part of the screen with a resizable lens (Window Zoom), or magnify a 

portion of the screen that stays in one place (Pinned Zoom). And, you can use 

Zoom together with VoiceOver. 

 

Setting up Zoom 
 

If you are new to Zoom, it is strongly recommended that you have the Zoom 

Controller on (at least in the first instance) so that you can adjust the 

magnification quickly and easily. To do this, please follow the instructions 

below: 

 

Turning it on  

• Tap on Settings 

• Tap on Accessibility 

• Tap Zoom Controller  

• Tap Show Controller 

• Adjust the Idle Opacity and colour 

• Tap Zoom ON 

 

Putting onto Accessibility Shortcuts 

• Tap on Settings 

• Tap on Accessibility 

• Tap on Accessibility Shortcut and select Zoom 
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Using Zoom 

 

With Zoom turned on:  

 

• Tap the Zoom Controller and adjust the slider at the bottom of the menu to 

magnify the screen 

 

Alternatively: 

• Triple-tap the screen with 3 fingers.  

• Drag the slider to the right to zoom in, and to the left to zoom out again.   

• Drag 3 fingers to move round the screen 

• Tap ‘Zoom Out’, or triple-tap the screen with 3 fingers to exit.   

 

Or:  

• Double-tap the screen with 3 fingers to magnify the whole screen. Keep 

your fingers on the screen. 

• Without lifting your fingers, move them up or down to adjust the 

magnification. Once zoomed in, you can move around by dragging 3 

fingers around the screen (or just one finger on some iPad models).  

• Double-tap the screen with 3 fingers to zoom back out.  
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Lesson 2: Introduction to Panning Around the 

Screen   

 

Outcome 

Pan around the magnified screen of an image of an object or character to locate 

key features on request.  

 

Preparation 

You will need a simple and clear image on screen accessible either through the 
Photos app or in Safari. 

 

Links to previous learning 

Ensure the pupil is able to magnify the screen using either a triple-finger gesture 
and/or varying the amount of magnification using the slider in the Zoom 
controller menu.  

 

Key Vocabulary 

Pan, magnify 

 

Activity 

Present the pupil with a single clear and simple image. Ensure that the image is 
familiar to the pupil. Model panning around the image to locate a feature. 
Challenge the pupil to pan around the image in order to locate named features. 
Explore the difference in magnification to the size of the image. Continue to 
provide searching activities to locate features of a single image until the pupil is 
demonstrating more control in panning. Provide a range of increasingly detailed 
images and encourage the pupil to practise varying the magnification to identify 
the details.  
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Tailor It!  

• Images presented could be related to key vocabulary being taught it class. 

• Use knowledge of the pupil’s functional vision to present accessible 

images. 

• Explore the range of filters and their effect from the Zoom menu to identify 

the pupil’s preferences which they can then apply in order to distinguish 

features more easily.   

 

Let’s Apply! 

Discuss trouble-shooting if the pupil is presented with an inaccessible image in 
class by magnifying the screen and/or applying a filter.  

• Explore a range of images and filters. Does it depend on the type of 
image presented? 

• Can the pupil pan around a range of singular images? 

• Can the pupil magnify the image presented in a number of different apps 
i.e. camera roll and Safari? 

 

Think SMART! 

S – How many steps do you expect the pupil to do? How complex is the image?  

M – How many features do you expect they will successfully find? How many 
times do you think they will be able to smoothly pan? 

A – How much scaffolding do they need?  

R - How smooth do you expect the pupil will be when panning? Can they move 
onto more complex images or do they need to practise with a lot of simple and 
clear images first? 

T – Will they model smooth panning with a range of images quickly within a 
short number of lessons or will they need longer? 

 

 



 
 

72 
 

Lesson 3: Pan Around Multiple Images 

 

 

Outcome  

Pan around the magnified screen to locate a named image from multiple 
images. 

 

Preparation 

You will need an electronic image with smaller images in rows with increasing 
spacing between them. Ensure that the images are of good quality and will not 
blur when magnified. 

 

Links to Previous Learning 

Revise how to magnify the screen using the pupil’s preferential method and pan 
around the screen.  

 

Key Vocabulary 

Pan, magnify 

 

Activity 

Initially present the pupil with multiple smaller, simple images in a predictable 
sequence i.e. in a horizontal row without much spacing between the images. 
Model using a systematic approach to pan along all of the images and identify 
these. Practise panning along the images, identifying them with gradually 
increasing control. Once the pupil is able to smoothly pan along the images, 
gradually increase the spacing between the images before increasing the 
complexity of the images. Then challenge the pupil to pan along vertical images 
before moving onto images in less predictable sequences.  
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Tailor it! 

• Remember to encourage the pupil to use their preferred method of 

magnifying the screen and panning around with their preferred fingers.  

• Which filter do they need to use? 

• Ensure the images selected are visually accessible for each pupil. 

• Present the pupil with images which they would expect to access in class. 

 

Let’s Apply! 

• Encourage the pupil to apply their panning skills to locate apps on their 

Home screen. Does it make it easier to find them? 

• Look for opportunities in class or at home to apply their developing 

panning skills in order to identify images or access details on the images 

more easily i.e. on a worksheet they have been given.  

• In association with their developing camera skills, encourage the 

application of Zoom magnification to captured images. Compare this with 

using Magnifier (another accessibility tool) within the Camera app. 

 

Think SMART!  

S – How much spacing is there? How are the images presented? Are they 

familiar images or not? 

M – How many steps do you expect the pupil to be able to complete 

independently? How many lines do you expect them to pan along smoothly? 

How many images do you expect them to locate and/or identify?  

A – How much scaffolding will they need?  

R – How smooth do you expect the pupil will be when panning? Can they move 
onto rows of images with more spacing or do they need to practise with a lot of 
rows of images closer together? Do they need a lot of practise with more 
predictable rows first? 

T – Will they model smooth panning with a range of smaller images quickly 
within a short number of lessons or will they need longer? 
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Instructions for Lesson 3: Using the Magnifier 
 

 

Set up magnifier 
 

To add Magnifier to Accessibility shortcuts: 
Tap on Settings  
Tap on Accessibility 
Turn Magnifier ON  
 

To add Magnifier to Control Centre: 
Tap on Settings 
Tap on Control Centre 
Go to Customize Controls and tap on the ‘+’ next to ‘Magnifier’.   
 

Turn on the Magnifier 
 

via Accessibility Shortcuts: 
Go into Accessibility Shortcuts by triple-clicking either the Home button or the 
Sleep/Wake key (at the top), depending on your iPad model and iOS. 
Tap on ‘Magnifier’. 
 

via Control Centre: 
Swipe down from the top right-hand side of the iPad screen to bring up Control 
Centre.  
Tap on the Magnifier icon 
 

via Siri 
Press down the Home Key, or bring up Siri by saying “Hey Siri”. 
Say something like “turn on Magnifier”   
 
To exit magnifier: press the Home button or swipe up from the bottom of the 
screen.  
 
Adjust magnification level 
Within Magnifier, drag the Zoom level slider up or down, or left or right 
(depending on your iPad model).  
 



 
 

75 
 

Apply colour filters  

• Within Magnifier, tap on colour options icon:   

• The 2 slides allow you to adjust for brightness (sun icon) and contrast.  

• You can also change your magnified image’s colours to Red/Black, 
Yellow/Black, Greyscale, Yellow/Blue, and White/Blue. Horizontally scroll 
through the word menu above the sliders to select (the current option will 
be in yellow).   

• To apply changes and return to Magnifier, tap the colour options icon 
again.   

 
Invert colours  
Within Magnifier, tape on the colour options icon. 

Tap on the invert icon  .     
To apply changes and return to the Magnifier, tap the ??invert colours icon 
again.   
 
Add more light (some models only) 
Within Magnifier, tap the lightening flash or torch icon to turn the flashlight on. 
Tap it again to turn it off.  
 
Lock focus 

While in Magnifier, tap the padlock icon    to lock the focus 
Tape it once more to unlock focus.   
 

Freezing Images 
 

Magnifier is typically used to do active work. However at times you might want 
to do more extended work with a Magnified image, and you do this by ‘freezing’.  

 

Freeze one image 

• While in Magnifier, tap the white shutter button   

• The image will stay on the iPad screen and you can zoom into it and 
move around within it. 

• Tap the shutter button again to unfreeze image. Ensure you are zoomed 
out as far as you can be otherwise you won’t see the button.  

 

Freezing multiple images (only available on some models) 

• Freeze one image, as above.  
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• When you are ready to take another image, tape the multiple-frames icon 

Reposition the camera and take your shot using the plus icon . 
You can do this as many times as you want. 
To view your images: 

• Tap View, and then tap on the frames you want to see. 

• Tap End to return to the live magnifier. 
 

Saving frozen images 
Frozen images will not automatically be saved on your iPad or in the iCloud. 
You will need to direct the iPad to do this.  
 

• When in a frozen image, tap and hold your finger on the screen to bring 
up a sub-menu 

• Tap ‘Save Image’. 
 

Alternatively, tap on Share. This allows you to Save to Files and thus decide 
exactly where you want the image to be stored. Don’t forget to confirm your 
selection by tapping Save.  
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Lesson 4: Comparing Methods to Activating Zoom     

 

 

Outcome  

Compare panning around the screen using a gesture to toggling with the Zoom 
controller, identifying which method was the easiest to locate named images. 

 

Preparation 

You will need an image prepared in the Photos app or in Safari which initially 
replicates earlier successful magnification activities as well as images which 
matches the pupil’s current skill level of panning i.e. multiple smaller images in 
horizontal or vertical rows. You need to ensure the Zoom menu is visible to the 
pupil and in the pupil’s preferred part of the screen.   

 

Links to Previous Learning 

Revise how to pan around the screen using the appropriate gesture with rows of 
images.  

 

Key Vocabulary 

Panning, Zoom controller, toggling 

 

Activity 

Introduce toggling around the screen by sliding the finger under the Zoom 
menu when magnification is enabled. Encourage the pupil to toggle up and 
down and then left to right using the Zoom menu to locate and identify simplified 
images before moving onto multiple smaller images in different arrays. 
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Compare how the level of magnification effects how much toggling is 
required. Encourage the pupil to identify their preferred method of panning 
around the whole screen. Can they explain why they prefer it? 

 

Tailor it! 

• Present the pupil with images which match their skill in panning around 

the screen. 

• Remember to use the pupil’s preferred presentation of the Zoom menu i.e. 

colour and visibility.  

• If the pupil quickly identifies a preference for one way of panning rather 

than the other, tailor the rest of the lesson to practise  panning using that 

way.  

 

Let’s Apply! 

• Encourage the pupil to utilise their preferred panning method to access a 

range of images within the classroom and home environment (ensuring 

that key staff and family members are aware and confident in using this 

method too).  

• Provide increasingly more complex images and multiple images which 

continue to be of an appropriate level of accessibility for each pupil. 

• Ensure the pupil has opportunities to use their preferred method in a 

range of appropriate apps.  

 

Think SMART!  

S – What kind of images are you expecting the pupil to access in order to 

compare methods?  

M - How do you expect the pupil to identify their preferred method? 

A – How much scaffolding does the pupil need to achieve the outcome? 

R - Is the pupil able to compare methods or is the focus more on how 

confidently they are able to pan along images using both methods? 

T – Does the pupil require one lesson to compare methods or does the pupil 

need a few lessons to become familiar with toggling using the Zoom controller 

before making a decision? 
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Instructions for Lesson 4: Zoom Controller 

 

 

The Zoom Controller is an icon consisting of a small black and white circle and 

arrows which sits permanently and discretely on the iPad screen, and provides 

quick and easy access to the Zoom commands. 

How to turn it on: 
Method 1 (via the Accessibility menu): 

• Tap on Settings 

• Tap on Accessibility 

• Tap on Zoom 

• Go to Zoom controller and turn ON ‘Show Controller’ 

 

Method 2 (via Accessibility Shortcuts):     

• Triple-tap the Home button to bring up menu 

• Tap on Zoom 

• A message will tell you that Zoom is Enabled, and you will be able to see 
the Zoom Controller 

 

How to use it:  

• Double tap Zoom control button (at its centre) to Zoom in or out  

• Single tap Zoom control button to display controls  

• When you are zoomed in, use the Zoom Controller to move around the 

screen like a joystick. Lightly move your finger over the controller and drag 

to pan around the whole document.  

 

How to make Zoom Controller easier to see 

• Tap on Settings 

• Tap on Accessibility 

• Go to Zoom 

• Select Idle Opacity / Idle Visibility and use the slide to adjust how visible 
the Controller is when it’s not in use.  

You can also move the Zoom Controller to wherever you want it on the iPad 
screen by dragging it with one or two fingers. 
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Lesson 5: Using Zoom to Track Along and Down 
Images and Text 

 

Outcome 

Use the Zoom accessibility feature to pan around a screen in order to locate 
and track text and images from the top to the bottom of the screen when it is 
magnified. 

 

Preparation 

You will need multiple lines of images of an appropriate level of detail for the 
pupil and multiple lines of text.  

 

Links to Previous Learning 

Revise the pupil’s preferred panning method. How does the pupil think they 
move down to the next line? 

 

Key Vocabulary 

Pan 

 

Activity 

Begin by tracking along motivational images from far left to right whilst using the 

pupil’s preferred panning method. Model how to move down and locate the 

beginning of the next line of images before encouraging the pupil to practise this 

skill. Once the pupil is demonstrating competency in panning from top left to 

bottom right, introduce text. Develop panning skills in order to access text when 

the screen is magnified from being able to track along a single line of text to 

tracking from top left to bottom right. Provide guidance to encourage the pupil to 

identify when text is too small to access and it is appropriate to apply Zoom.  
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Tailor It! 

• Present text at the pupil’s reading level i.e. CVC words or more complex 

sentences, remembering to start simply to develop the pupil’s confidence 

initially e.g. begin with lines of single letters before moving onto CVC 

words.  

• Present text in a format which represents everyday tasks the pupil will 

need to access i.e. worksheets or textbooks but remember to apply 

strategies where appropriate from results of functional vision assessment 

to ensure the pupil can be successful. 

• Ensure the pupil is using the level of magnification that gives them the 

most access.  

• The pupil may require additional steps to successfully pan down to the 

next line i.e. guiding dots. Utilise techniques usually used when 

introducing hand-held magnifiers if required. 

 

Let’s Apply!  

• Provide opportunities for the pupil to access text which is too small for 
them. Encourage them to identify this in line with their preferred computer 
font size and apply Zoom. 

• In line with their developing camera skills, provide opportunities for the 
pupil to take photos of inaccessible text presented to them and apply 
Zoom as a problem-solving technique.  

• Encourage the pupil to apply their panning skills to access text in a 
number of apps using magnification. 

 

 

Think SMART! 

S – What type of images and text do you expect the pupil to access?  

M – How many lines do you think the pupil will pan along and down successfully 

with? On how many occasions will the pupil pan along smoothly?  

A - How much scaffolding does the pupil need? 

R – Would the pupil be able to apply their panning skills to pan down multiple 

lines of text or will they need to practise with images first?  
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T – Will the pupil be able to apply their panning skills to access multiple lines of 

images and text within one lesson or will they need to achieve this over multiple 

lessons? 
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Lesson 6: The Zoom Magnification Window 

 

Outcome 

Compare locating named image or text using the magnification window to 
whole-screen magnification, identifying which zoom region was the most 
preferable.  

 

Preparation 

You will need multiple lines of images of an appropriate level of detail for the 
pupil and multiple lines of text. 

 

Links to Previous Learning 

Revise panning along and down multiple rows of images and/or lines of text. 

 

Key Vocabulary 

Zoom Region, Full Screen Zoom, Window Zoom 

 

Activity 

 Introduce the Zoom window option, exploring the difference between this and 
magnifying the whole screen. Explore moving the window around the screen by 
toggling with the Zoom menu or using fingers, encouraging the pupil to identify 
their preferred method. Repeat the activity above but using the window 
feature. Develop the pupil’s knowledge of when it would be more appropriate to 
use full screen magnification or window magnification.  
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Tailor it! 

• Vary the size of the magnification window to identify the pupil’s 

preference. 

• Use the pupil’s preferred method of panning around the screen using the 

Zoom menu or fingers. 

• Utilise the filter option within the Zoom window to replicate the pupil’s filter 

preference.  

 

Let’s Apply 

• Encourage the pupil to utilise their preferred zoom region to access a 

range of images within the classroom and home environment (ensuring 

that key staff and family members are aware and confident in using this 

method too).  

• Provide increasingly more complex images and text which continue to be 

of an appropriate level of accessibility for each pupil. 

• Ensure the pupil has opportunities to use their preferred method in a 

range of appropriate apps. 

 

Think SMART! 

S – What kind of images and/or text are you expecting the pupil to access in 

order to compare methods?  

M - How do you expect the pupil to identify their preferred method? 

A – How much scaffolding does the pupil need to achieve the outcome? 

R - Is the pupil able to compare methods or is the focus more on how 

confidently they are able to pan using both methods? 

T – Does the pupil require one lesson to compare methods or does the pupil 

need a few lessons to become familiar with using the window magnification tool 

before making a decision? 
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Instructions for Lesson 6: Part-Screen Zoom 

Options 

 

Apart from using Zoom to magnify the entire iPad screen, you can also use it to 

magnify either just a window, which can be moved around the screen as 

necessary, or else to magnify just one particular, static part of the screen via 

Pinned Zoom.  

 

To choose which region to magnify:    

• Triple tap with three fingers (or single tap the Zoom Controller).   

• Click on Choose Region and tap on your preference.   

 

This can also be done via the Zoom menu in the Accessibility app. 

 

Window Zoom 
This option provides a rectangular window within which you can see the 

zoomed text. 

Resize window 

• you can resize by tapping on the Zoom Controller, or else triple-tapping on 

the screen with 3 fingers to make the Zoom menu appear.  

• Tap on ‘Resize Lens’, and then drag your fingers on the small circles 

surrounding the zoomed window to change the size.  

• Once you have finished resizing, just tap outside the window to come out. 

 

Move window 

• Drag the handle at the bottom of the Zoom lens. Let go when it is where 

you want it. 

Otherwise, you can drag 3 fingers left, right, up or down anywhere on the 

screen.  

Advanced Zoom settings 
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Advanced Zoom settings are available in the Zoom menu within Accessibility: 

• Tap Settings 

• Tap Accessibility 

• Go to Zoom. 

 

These allow you to: 

• Set a maximum level of magnification: Use the slider at the bottom of 

the screen to set the greatest magnification for Zoom. 

• Set Follow Focus: this has the Zoom focus on your selections, the text 

insertion point, and your typing.  

• Set Smart Typing: this makes the iPad switch to Window Zoom when a 

keyboard appears. 

• Enable Keyboard Shortcuts: this allows you to control Zoom using 

shortcuts on an external keyboard. 

• Apply a Zoom Filter: this changes the way that the zoomed screen is 

displayed. ‘Inverted’ reverses the colours to enhance contrast; ‘Greyscale’ 

changes the screen to only shades of grey, and ‘Greyscale Inverted’ is the 

Greyscale version of Inverted. The ‘Low Light’ option makes no change to 

colour, but instead dims the screen which can be useful when 

environmental light levels are low.  

 

Using Zoom with a pointer device 
If you use iPad with a pointer device, you can also set the following below 

Pointer Control: 

Zoom Pan: Choose Continuous, Centred, or Edges to set how the screen 

image moves with the pointer. 

Adjust Size with Zoom: Allow the pointer to scale with zoom. 



 
 

 
 

 

How to use Zoom – An Apple Magnification Feature 

 

This quick start guide is designed to help you get started using the Apple accessibility feature called 

Zoom which is a magnifier.  

 

Step 1: To turn on Zoom, go to settings                 , select General on the left-

hand side menu and locate Accessibility from the right-hand side. Zoom is the 

second option in the Accessibility menu. This will take you to the Zoom feature 

options screen. 

 

 

Step 2: Tap the button to the right of ‘Zoom’ at the top of the right-hand 

screen to turn on Zoom. This should turn the button green (unless you have 

changed the display screen features).  Until you are familiar with Zoom, 

always ensure that ‘Full Screen Zoom’ is selected in the Zoom menu called 

‘Zoom Region’. 

 

 

Step 3: There are now a number of different ways to operate the Zoom 

Accessibility feature. This is so Zoom can be customised for the individual.  

A. The first way is to tap three fingers on the screen two times (double-tap) to 

zoom in. This will magnify the whole screen. If you keep your fingers on the 

screen and move them up or down, this will adjust the magnification. Once 

zoomed in, you can move around the screen by placing three fingers on the 

screen and dragging them around the screen. Depending on which Apple 

operating system you use, you may also be able to move around the screen 

using one finger. Once you have finished, double-tap on the screen with 

three fingers to zoom back out. 

 

 

 

 



 
 

 
 

B. The second way to operate Zoom is by tapping the screen three times 

(triple-tapping) with three fingers. A small menu will appear. Depending on 

how far along the slider is at the bottom of the small menu, when you 

select ‘Zoom In’ the screen will be magnified by that amount. You can then 

move your finger along the slider at the bottom of the Zoom menu to 

adjust the amount of magnification before double tapping on the screen 

with three fingers to make the menu disappear. 

 

By selecting ‘Choose Filter’ using the Zoom menu, you can change the way 

the screen is displayed. ‘Inverted’ reverses the colours to enhance contrast. 

‘Greyscale’ changes the colour on the screen to shades of grey. ‘Greyscale 

Inverted’ is very similar to ‘Inverted’ but only uses shades of grey. ‘Low 

Light’ significantly dims the screen.  

 

 

C. The third way to operate Zoom is by using a Zoom controller. This can be 

located either by choosing to ‘Show Controller’ in the small menu as in part 

3B above or in the Zoom menu within Settings (see step 1). Once this is 

selected using either method, a small black circle with a white circle and 

arrows will appear. Within the Zoom menu in Settings you can adjust how 

visible the Zoom controller is when it is not in use by selecting ‘Idle 

Visibility’ under the ‘Show Controller’ option. Sliding your finger on the 

slider to the left will decrease visibility and to the right will increase 

visibility. You can also move the Zoom Controller to wherever you want it 

to be on the screen by dragging it with one or two fingers.  

 

Once you have set up the Zoom Controller it operates in the same way as 

described in step 3B when you tap on it with one finger, except that once 

you have zoomed in on the screen, you can use the Zoom Controller to 

move around the screen like a joystick. To do this, you rub your finger over 

the Zoom Controller (like a little stroke). The circle enlarges and the small 

circle in the middle moves where your finger moves. You can move quickly 

by moving the circle to the up, down, left or right arrow or slowly by 

moving the circle towards (not next to) the arrows. 

 

 

 

 

 



 
 

 
 

Step 4: So far you have used the Zoom feature to magnify the whole 

screen. However, you can also magnify part of the screen in a ‘window’ 

while keeping the rest of the screen at its usual magnification. Again, there 

are a number of ways to do this. You can use the ‘Window Zoom’ by 

selecting it in the Zoom Controller menu (see step 3B), in the small menu 

(see step 3C) or within the Zoom options of the Accessibility menu within 

Settings called ‘Zoom Region’. Once ‘Zoom Window’ is selected and you 

have zoomed in, a rectangular shaped window will appear and the screen 

within this will be magnified. This can be re-sized to suit your needs by 

tapping on the ‘Zoom Controller’ or triple-tapping on the screen with three 

fingers to make the Zoom menu appear. Select ‘Resize Lens’ and drag your 

fingers on the 8 small circles around the rectangular window to re-size. 

Once you have resized the ‘Zoom Window’, tap anywhere outside of the 

window to save this.  

 

To move around the screen within the ‘Zoom Window’, drag three fingers 

left, right, up or down’ anywhere on the screen. Alternatively, by tapping 

and keeping your finger on the small white tab at the bottom of the ‘Zoom 

Window’ (the handle) you can move the window around the whole screen. 

Tapping this once with one finger will also bring up the small Zoom menu. If 

you select ‘Choose Filter’ as described in Step 3B and filter, the filter will 

only apply to the window. When you have finished, open the Zoom menu 

and select ‘Zoom Out’. 

 

 
 

 

 

 

 

 

 

If you have any difficulties in using Zoom, please use the following link to find Apple User Guides 

which contain full details of Accessibility Features: 

http://support.apple.com/manuals/                              

Please note that accessibility features on electronic devices are updated regularly and therefore can 

change. This guide is designed to be as universal as possible for Apple devices, but you may find slight 

differences depending on the operating system (or iOS) your device is using.

Other useful hints include: 

In the Zoom menu within Settings, choose ‘Follow Focus’ – This feature enables you to use the onscreen 

keyboard at 1x magnification and it magnifies the text being typed. When you select ‘Follow Focus’, a 

second option ‘Smart Typing’ appears. If you then select ‘Smart Typing’, a magnification window will 

appear when you use a keyboard so that text is magnified but the keyboard is not.  Please note that 

older versions of iOS may have ‘Zoom Keyboard’ instead which means that both the main screen and 

the onscreen keyboard are magnified.  

In the Zoom menu within Settings at the bottom adjust Maximum Zoom Level - This will adjust the 

maximum amount of zoom available for the whole screen or magnification window.  

 

 

http://support.apple.com/manuals/
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Aim: For pupils with vision impairments to utilise the accessibility features 

Spoken Content and/or VoiceOver (depending on levels of functional vision) as 

well as an app designed for pupils with vision impairments in order to access 

print in their preferred format in a range of apps off and online.  

Purpose: Due to the majority of pupils with vision impairments requiring 

modified large print and/or Braille, by learning a range of strategies to access 

print in an electronic format both off and online pupils will expand their access a 

wide range of information.  

 

Let’s tailor it! - Baseline 

• What can they already do/explain? (Using the Skills Progression Checklist 

for Unit 5, baseline your pupil (B/L) to identify what skills they already 

have in order to progress through this unit.)  

• What do they want to be able to do? 

• What would their parent/carer like/need them to be able to do? 

• What would their teacher like/need them to be able to do? 

 

 

 

 

 

 

 

Unit 4 – Accessing Text 
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4A. Spoken Content and EasyReader 

 

Outcome 

The pupil will be able to apply the Speak Selection function to access 

words and phrases within appropriate apps, comparing this to Speak Screen 

using their preferred activation method and the EasyReader or an OCR app.  

 

 

Medium-Term Plan  

Lesson Outcome Key Skills Key Knowledge Links to 
Other Units 

Lesson 1: 
Introduction 
to Speak 
Selection 

Apply Speak 
Selection in order 
to access words 
presented in an 
electronic format. 

Activate Speak 
Selection 

Understand how 
Speak Selection 
can support 
access to 
reading words 

Unit 2: 
Lesson 1 

Lesson 2: 
Using Speak 
Selection to 
Access 
Multiple 
Lines 

Apply Speak 
Selection in order 
to access 
multiple lines of 
text presented in 
an electronic 
format. 

Activate Speak 
Selection 
Highlight 
multiple lines of 
text backwards 
and forwards 

Understand how 
Speak Selection 
can support 
access to 
reading multiple 
lines of text 
 

Unit 2: 
Lesson 1 

Lesson 3:  
Comparing 
Methods of 
Activating 
Speak 
Screen 

Compare 
applying the 
Speak Screen 
gesture in order 
to access pages 
of text in an 
electronic format 
on and offline, 
pausing and 
adapting speed 
on request to 
using the Speech 
Controller and 

Use the 
appropriate 
gesture to 
activate Speak 
Screen 
Use the Speak 
Screen menu 
Activate Speech 
Controller 
Use Speak on 
Touch  

Understand the 
purpose of 
Speak Screen to 
access the whole 
page 
Understand the 
similarities and 
differences 
between Speak 
Screen and the 
Speech 
Controller 
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identify their 
preference. 

Lesson 4: 
EasyReader 
and OCR 

The pupil can 
access texts in 
EasyReader 
and/or an OCR 
app, utilising 
inbuilt options in 
order to suit their 
needs. 

Locate and 
open 
EasyReader/  
OCR app 
Use the 
EasyReader/ 
OCR controls 
Locate the 
menus 
 

How EasyReader 
and OCR can 
help them to 
access texts 
Which options 
suit their vision 
needs 
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iPad Accessibility Skills 
Unit 4 - Accessing text 

Spoken Content Progression 

Speak Selection Introduce Developing Achieved 

Select text and locate speak from menu to read a word  
 

  

Use a drag gesture to highlight text     

Turn Speak Selection on and off from the Accessibility menu    

Adjust speaking rate     

    

Speak Screen    

Activate Speak Screen using a gesture     

Activate Speak Screen using Siri     

Activate Speak Screen using the button     

Pause and stop Speak Screen using the control     

Adjust speech speed    

Turn Speak Screen on and off from the Accessibility menu    

    

Advanced Spoken Content Skills    

Typing feedback    

Configure typing feedback (hear each character/word and typing predictions)    

Turn on Speak Autotext    

Hear typing predictions    

Personalise Spoken Content (voice/speaking rate/highlighted words as read)    
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iPad Accessibility Skills 
Unit 4 - Accessing Text 

iBooks Progression 

Basic Skills - Move around within audiobooks Introduce Developing Achieved 

Skip forward or back 
 

  

Change speed of speech 
 

  

Set a sleep timer 
 

  

Go to a chapter 
 

  

Go to a specific time 
 

    

  

Move around within books 
 

  

Page turn 
 

  

Go to previous page/specific page 
 

  

Close book 
 

  

    

Intermediate Skills    

Change book appearance    

Adjust screen brightness    

Change font and font size    

Change page background colour    

Automatically adjust page colour and brightness in low-light conditions     

Turn on vertical scrolling     

    

Marking up the text    

Add a bookmark    
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Highlight or underline text    

Add a note    

    

Share a selection of text    

Find and buy books and audiobooks    

    

Advanced Skills    

Organise books in the books app    

Create a collection     

Add to the collection    

Sort books in your collection/library    

    

Use the books app to access PDFs    

Open/Share/Print PDF    

Mark up PDF    

    

Remove books/audiobooks/PDFs    
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iPad Accessibility Skills 
Unit 4 - Accessing Text 

Dolphin EasyReader Progression 

Basic Skills Introduce Developing Achieved 

Navigate through the book 
   

Using a single tap to play and pause 
 

  

Using a swiping gesture to turn the pages  
 

  

Using the Next and Previous buttons 
 

  

Find and open books 
    

   

Intermediate Skills    

Using My Books list    

Find out more information about a book    

Search for an author of a title    

Sort your books    

Choose how to view your list    

    

Change the appearance of your text    

Text size    

Text font    

Change text spacing    

Change text background and highlight colours    

Change speech settings 
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Change sound    

Change pitch/volume/add pauses    

Choose different voice    

    

Advanced Skills    

Navigate through the book    

Using a single tap    

Using the Next and Previous buttons    

Navigate to a specific heading/page/bookmark    

Navigate using the progress slider    

Go to a bookmark    

Add a bookmark    

Find your bookmark    

Initial set up 
   

Create Dolphin account 
   

Sign into Bookshare 
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iPad Accessibility Skills 
Unit 4 - Accessing Text 

OCR - Microsoft  Progression 

Basic Skills Introduce Developing Achieved 

How to use Lens 
 

  

Choose what to capture    

Take the picture    

Review and edit    

    

Intermediate Skills    

Save and share image    

Listen to any text within your image immediately (Immersive Reader)    

    

Using the Narrator    

Listen to the text    

Pause Play    

Skip forward or back    

Change voice options    

    

Change how text looks in Immersive Reader     

Change size and font    

Change spacing    

Change colour themes    

Show windows of text at a time    
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Advanced Skills    

i) Emerging literary options    

Picture dictionary    

Highlight syllables in words    

Highlight parts of speech    

ii) Accessibility    

Use MS Lens with Accessibility features     
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Lesson 1: Introduction to Speak Selection 

 

Outcome 

Apply Speak Selection in order to access words presented in an electronic 

format.  

 

Links to Previous Learning 

Ensure that the pupil has successfully completed the appropriate gesture (single-

finger single tap and single-finger tap and hold) Lesson 1 from Unit 2 prior to this 

lesson to ensure they can apply appropriate gestures.  

 

Preparation 

Prepare an electronic text in an appropriate app i.e. iBooks, Word, Pages etc. 

There are instructions which follow on using an OCR app which can be used to 

support with this task. 

 

Key Vocabulary 

Speak Selection 

 

Activity 

Introduce the pupil to the Speak Selection function, encouraging them to identify 

when this could be useful i.e. to access unfamiliar words.  Discuss how access to 

electronic texts can enable access to print for the pupil. Model highlighting an 

individual word before providing guidance in order for the pupil to highlight 

named words and use the onscreen menu to select the speak option when 

reading a prepared, motivating text. Practise activating Speak Selection with 

more accuracy using unfamiliar words.  
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Tailor It! 

Present text at the pupil’s reading level i.e. CVC words or more complex 
sentences, remembering to start simply to develop the pupil’s confidence initially 
e.g. begin with lines of single letters before moving onto CVC words. 

Ensure the pupil’s specified electronic print size, spacing etc is used when 
creating documents electronically for the pupil to access. 

Modify the amount of print presented on the page. 

Explore the ‘Highlight Content’ option in the Setting menu to highlight words, 
sentences or words and sentences in the pupil’s preferential highlight style and 
colours.  

Adjust the speaking rate in the Settings menu to the pupil’s preference. 

 

Let’s Apply! 

 

• Encourage the pupil to apply Speak Selection to check and edit their own 

text i.e. in Notes or Pages.   

• Develop competency in locating the iBooks app and opening a motivating 

text from the bookshelf and/or list of titles before using Speak Selection to 

read words.  

• Encourage the pupil to identify and apply their own ideas about when 

Speak Selection could help them within the classroom or home 

environment.  

• Support the pupil to transfer activating Speak Selection to other appropriate 

apps i.e. Notes, iBooks or Pages. 

Explore ‘Define’ in the options bar for words the pupil is unfamiliar with. Compare 
this to using Siri in order to define words and encourage the pupil to identify their 
preferred method.  

If appropriate, demonstrate where the Speak Selection menu can be located 
within the Settings menu. 
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Think SMART! 

 

S – Do you expect the pupil to apply Speak Selection to familiar and unfamiliar 

words?  

M – Within how many attempts do you expect the pupil to activate Speak 

Selection? How many words do you expect to be read out? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R - Can they visually access the options bar in order to select the word? Are they 

confident in using a tap and hold gesture? (If not, then please refer to Lesson 1, 

Unit 2 to practise this skill further).  

T – How long will it take your pupil to confidently acquire this skill and understand 

how it can be utilised i.e. one or multiple lessons?   
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Instructions for Lesson 1: Using Speak Selection  
 

 

 

For those pupils who do not want to use VoiceOver, the iPad offers a variety of 
ways to support pupils by speaking selected text, screens and also providing 
typing feedback.   
 
 

Speak Selection  

In Speak Selection, the iPad will only speak that part of the screen that you 

select.  

  

Turn on Speak Selection  

• Tap on Settings  

• Tap on Accessibility  

• Go to Spoken Content  

• Tap Speak Selection ON.  

  

Use Speak Selection  

• Go to your text document 

• Double-tap at the start of the section you want to be read out to you.  

This will bring up an edit menu (at the top). You will also notice that the word you 

have double-tapped on will be highlighted. Small circles can be seen at the top 

left and bottom right of the highlighted box. 

• Drag either circle so that the highlighted area covers the text you want 

spoken. 

• Tap on Speak  

• When finished, tap anywhere else within the document to de-select your 

text. 

  

Speech can be paused and adjusted as previously. 
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Using Typing Feedback  
  

An extremely useful feature for pupils, Typing Feedback allows you to adjust 

what is spoken. You can choose to have the iPad speak each character or each 

word. You can also ask for it to identify Auto-text, text put in automatically by the 

iPad that you might otherwise be unaware of: auto-corrections and auto-

capitalisations.  

  

To turn on and customise Typing Feedback:   

• Tap on Settings  

• Tap on Accessibility  

• Go to Spoken Content  

• Tap on Typing Feedback to take you to the Typing Feedback menu. Here, 

you can select what feedback you would like to hear, whether you want to 

hear each character or just each word, and whether you want to hear the 

Auto-text. 

  

Spoken Content can also provide you with help – Character Hints (helpful for early 

spellers) and the option to tap and hold each word to hear typing predictions (when 

typing predictions have been enabled).   

 

Spoken Content 
 

Spoken Content is when the iPad speaks a selection of text. 
 

Turn on Spoken Content 

• Ensure the iPad is not on mute. 

• Tap Settings 

• Tap Accessibility 

• Go into Spoken Content 

• Tap Speak Selection ON 
 

How to select text to be read 

• Select text by holding finger on text and moving the markers to surround 
the text you want to hear. 

• Tap ‘Speak’ 
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Personalise Spoken Content 
The Spoken Content menu within Accessibility provides a variety of ways to 
personalise Spoken Content to suit your pupil’s needs.  
 
Choose voice 
Go into Voices 
Choose language and try some of the options.  
 
Adjust speaking rate 
Go to the Speaking rate option and tap.  
Move the slider along to adjust speed. 
 
Highlighted words as they are read 
Tap ON Highlighted Content button. 
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Instructions for Lesson 1: The iBook App 

 

 

 

Using the iBooks app to find and buy books and audiobooks 
 

• Tap on iBooks  

• Tap Book Store or Audiobooks to browse titles. If you are looking for 
something specific, tap on Search to use the Search function.  

• Tap on a book cover to learn more about it, preview the books, or put it on 
you ‘Want to Read’ list. 

• Tap Buy to purchase a title. Money will be taken from the account 
associated with your Apple ID. Alternatively, if the book is free, just tap Get 
to download it.  

 

Reading books and audiobooks 
 

• Tap on Books 

• To return to a book you are in the middle of reading, tap on the ‘Reading 
Now’ tab at the bottom. In this screen, you can scroll down to see books 
and audiobooks in your ‘Want to Read list’, to set reading goals and to see 
the record of books that you have already read.  

• To see all the books, audiobooks, series and PDFs in your library, tap on 
Library.  

• To read a book, simply tap the Reading Now or Library tab, then tap a 
cover to open a book.  

 

Moving around within audiobooks 
 

Skip forward or back 
You can touch and hold the rounded arrows. Alternatively, slide and hold the 
book cover. You may also be able to use headphone controls.  
Note: To change the number of seconds that skipping advances, go to Settings > 
Books, then scroll down to Audiobooks. 
 
Change speed of speech: tap the playback speed in the lower-left corner. 

Set a sleep timer: Tap , then choose a duration. 

Go to a chapter: Tap , then tap a chapter. 
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Note: Some audiobooks refer to chapters as tracks, or don’t define chapters. 
Go to a specific time: Drag the playhead, directly below the audiobook cover. 
The point where you started listening is marked with a grey circle on the timeline. 
Tap the circle to jump back to that spot. 
 

Moving around within books 
 

Use the following gestures:   
Page turn: Tap the right side of the page or swipe right to left. 
Go to previous page: Tap the left side of the page. Otherwise swipe left to right. 
Go to a specific page: Tap the page and move the slider at the bottom of the 

screen left or right. Alternatively, tap the search icon , enter a page number, 
then tap the page number in the search results. 
Close a book: Tap the centre of the iPad screen to bring up the controls. Then 
tap the close app . 
 

Change book appearance  
 

• Tap on Books 

• Go into the book you would like to read. 

• Tap the page 

• Tap the text icon  
 

Options to change the book’s appearance include: 
 
Adjusting screen brightness: Drag the slider left or right. 
 
Changing font size: Tap the large A to increase the font size or tap the small A 
to decrease it. 
 
Change the font: Tap Fonts to choose a different font. 
 
Change the page background colour: Tap a coloured circle. 
 

Automatically adjusting page colour and brightness in low-light conditions: 
Turn on Auto-Night Theme. (This is not supported by all books).  
 

Turning on Vertical scrolling: this allows you to scroll continuously through 
your book rather than turn each page.  
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Marking up the text 
 

Add a bookmark  
Although you will automatically be returned to the page you finished on, you 
might want to add a bookmark or two so that you can return to a part of the book 
again.  

• Tap the bookmark icon  to add a bookmark. Tap it again to remove the 
bookmark. 

• To see all your bookmarks, tap menu icon , then tap Bookmarks. 
 

Highlight or underline text 

• Within a Book, touch and hold a word, then move the grab points to adjust 
the selection.  

• Tap Highlight, then tap  to choose a highlight colour or underline. 

• To remove a highlight or underline, tap the text, then tap the bin icon. 

• To see all of your highlights, tap menu icon and then Notes. 

 

Add a note 

• Within a Book, touch and hold a word, then move the grab points to adjust 
the selection. 

• Tap Note, then enter note text. 

• Tap the page to close the note and continue reading. 

• To see all of your notes, tap , then tap Notes. Swipe left on a note to 
delete it. 

 

 

Sharing a selection of text  
 
Useful for school work, you can send blocks of text to others using Mail or 
Messages, or copy and paste a selection into Notes. (Sharing may not be 
available in all countries or regions.) 
 

• Within a book, tap and hold a word. Move the grab points so that they 
surround your whole selection.  

• Tap Share, then choose a method. 
(This is not available in all countries or regions.) 



 
 

106 
 

 
Organizing books in the iBooks app 
 
The iBooks app will automatically sort your books into Collections: ‘Audiobooks’, 
‘Want to Read’ and ‘Finished’, but you may wish to create Collections of your 
own.   
 

Create a Collection 

• Tap on iBooks. 

• Tap on Library 

• Tap on Collections 

• Then tap New Collection. Give your collection a name, then tap Done. 
 

Add Books to a Collection 

In the iBooks app, tap  below the book cover.  
Tap Add to Collection, and then choose which collection to add it to.  
You can add the same book to multiple collections. 

 

Sort books in your library/in a Collection 

• In the iBooks apps, tap on Library or go to a particular Collection. 

• Scroll down and tap next to Sort or Sort By. 

• Choose Recent, Title, Author, or Manually by tapping on your selection. If 
you choose Manually, you will need to touch and hold a book cover, and 
then drag it to the position you want. 

• Tap  to view books by title or cover. 
 
 

Using the iBooks app to access PDFs  
 
As well as books, the iBooks app is a really useful way to read PDF documents.  
 

Open a PDF: Tap the PDF attachment to open it, tap the Upload icon , then tap 
iBooks. 
 
Share or print a PDF: Open the PDF document, tap Upload, then choose a 
share option such as AirDrop, Mail, or Messages, or tap Print. 

Mark up a PDF: open the PDF and tap on the pen icon  to use the drawing 
and annotation tools (tap near the centre of a page if you don’t see this icon). 
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Remove books, audiobooks, and PDFs 
 
You can remove books, audiobooks, and PDFs from Reading Now and your 
library collections, or hide them on your iPad. 
 
Tap Library, then tap Edit. 
Select an option (i.e. delete, hide) 
 
For audiobooks, tap Library, then go to the Audiobooks collection. 
Tap the items you want to remove. 
Tap the bin icon and select an option. 
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Lesson 2: Using Speak Selection to Access Multiple 

Lines 
 

 

Outcome 

Apply Speak Selection in order to access multiple lines of text presented in an 

electronic format. 

 

Links to Previous Learning 

Revise activating Speak Selection to read out individual words, ensuring the 

pupil is demonstrating competency in highlighting individual works within a few 

apps.  

 

Ensure the pupil has successfully completed the appropriate gestures from 

Lesson 1, Unit 2 (single-finger single tap, single-finger tap and hold, single-finger 

tap and drag from left to right and right to left). 

 

Preparation 

Prepare an electronic text in an appropriate app i.e. iBooks, Word, Pages etc. 

 

Key Vocabulary 

Speak Selection 

 

Activity 

Model applying a tap and drag gesture from left to right across a line of text 

before requesting Speak Selection to read the line, discussing when this may be 

preferable to reading single words only. Extend to sentences, multiple lines of 

text and paragraphs. Provide graduated verbal guidance for the pupil to activate 

Speak Selection, drag the highlighter initially forwards and then backwards 

before selecting ‘Speak’. Discuss when this feature could be useful for reading 

tasks both within the classroom environment and at home.  
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Tailor it! 

• Explore if the ‘Highlighting Text’ option in the Settings menu would benefit 

the pupil.  

• Explore which voice the pupil prefers.  

• Does the pupil prefer all of the page read out to them? Introduce the ‘Select 

All’ feature before selecting ‘Speech’ and explore this method too before 

the pupil identifies which method they prefer. 

• Work with the pupil to identify particular times of the day, lessons etc. when 

utilising this feature may help to alleviate visual fatigue.  

• Explore the ‘Highlight Content’ option in the Setting menu to highlight 

words, sentences or words and sentences in the pupil’s preferential 

highlight style and colours.  

• Adjust the speaking rate in the Settings menu to the pupil’s preference. 

 

Let’s Apply! 

• Provide texts in iBooks for the pupil to access based on in-class topics to 

practise Speak Selection. Extend this use at home if possible.  

• Apply Speak Selection in order to read search results in Safari. 

• Encourage the pupil to identify and apply their own ideas about when 

Speak Selection could help them within the classroom or home 

environment. 

• Support the pupil to transfer activating Speak Selection to other appropriate 

apps i.e. Notes, iBooks or Pages. 

 

S – What kind of text do you expect the pupil to apply Speak Selection to?  

M – Within how many attempts do you expect the pupil to activate Speak 

Selection? How many lines, sentences, paragraphs do you expect them to have 

read out? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R - Can they visually access the handles to highlight the text? (If not, you may 

wish to move onto Lesson 4). Are they confident in using a tap and drag 

gesture? (If not, then please refer to Lesson 1, Unit 2 to practise this skill further).  

T – How long will it take your pupil to confidently acquire this skill and understand 

how it can be utilised i.e. one or multiple lessons?   
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Lesson 3: Comparing Methods of Activating Speak Screen 

  

 

Outcome 

Compare applying the Speak Screen gesture in order to access pages of text in 

an electronic format on and offline, pausing and adapting speed on request to 

using the Speech Controller and identify their preference.  

 

Links to Previous Learning 

Continue to develop competency in applying Speak Selection to identify 

unknown words and read out lines of text. 

 

Preparation 

Prepare an electronic text in an appropriate app i.e. iBooks, Word, Pages etc. 

 

Key Vocabulary 

Speak Screen 

 

Activity 

Introduce the pupil to the Speak Screen function, modelling how to activate this 

using the gesture before providing guidance to activate Speak Screen. Develop 

the pupil’s familiarity with Speak Screen icons, exploring how they can be used 

when accessing electronic texts. Challenge the pupil to pause and unpause the 

text, discussing when this might be useful i.e. when the teacher is talking. Then 

introduce the Speech Controller, comparing this to activating Speak Screen 

using a gesture. Encourage the pupil to explore both methods before identifying 

their preference. Develop their ability to identify when Speak Screen would be of 

benefit to alleviate visual fatigue. Challenge the pupil to apply Speak Screen to 

accessing electronic information in Safari.  
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Tailor It! 

• Compare using the gesture and Siri to activate Speak Screen, discussing 

the pupil’s preferred method and advantages and disadvantages of each 

method. 

• Explore which voice the pupil prefers.  

• Explore the ‘Highlight Content’ option in the Setting menu to highlight 

words, sentences or words and sentences in the pupil’s preferential 

highlight style and colours.  

• Adjust the speaking rate in the Settings menu to the pupil’s preference. 

• Adjust the idle opacity of the Speech Controller to suit the pupil’s visual 

needs.  

• Adjust the position of the Speech Controller to suit the pupil’s visual needs. 

• Explore the pupil’s preferences in using Reader mode in Safari (this can 

also include size of text, colour of text and background text if the pupil is 

accessing a later version of iOS). 

 

Let’s Apply  

• Provide texts in iBooks for the pupil to access based on in-class topics to 

practise Speak Screen. Extend to home use if possible.  

• Apply Speak Screen in order to find information online in relation to their 

topic.  

• Encourage the pupil to identify and apply their own ideas about when 

Speak Screen could help them within the classroom or home environment. 

• Support the pupil to transfer activating Speak Screen to other appropriate 

apps i.e. Notes, iBooks or Pages. 

 

 

Think SMART! 

S – How do you expect the pupil to identify their preference? Will they be able to 

explain why? 

M – Which functions do you expect them to be able to perform by the end of the 

lesson? If they are able to compare and contrast, how many similarities and 

differences can they give?  

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 
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R – Is the pupil capable of comparing the Speech Controller to the Speak Screen 

gesture yet? If not, the focus may be on performing the appropriate skills initially.  

T – Will the pupil be able to confidently apply Speak Screen and the Speech 

Controller in one lesson before being able to compare them or will they need 

more time? 
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Instructions for Lesson 3: Speak Screen 

 

 

In Speak Screen, the iPad will automatically speak the entire contents of the 
screen rather than just a part of it.  
 

Turn on Speak Screen 

• Tap on Settings 

• Tap on Accessibility 

• Go to Spoken Content 

• Tap Speak Screen ON. 
 

Use Speak Screen 
Go to your text document 
Swipe down from the top of the screen with 2 fingers and it will play 
automatically. 
 

Pausing Speak Screen 
Swipe down from the top of the screen for the Speak Screen menu 
Use the controls to pause or adjust the rate. 
 

Adjust speech speed on Speak Screen 
Swipe down from the top of the screen for the Speak Screen menu 
Use the controls to pause of adjust the rate. 
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Lesson 4: EasyReader and OCR 

 

Outcome 

The pupil can access texts in EasyReader and/or an OCR app, utilising inbuilt 

options in order to suit their needs. 

 

Links to Previous Learning 

For pupils who will be accessing this in a non-sighted way, they will need to 

initially move onto Unit 3b in order to develop their VoiceOver skills before 

returning to this Lesson. 

 

Preparation 

A small amount of downloaded texts presented in EasyReader or in an OCR 

app. Consider activating a RNIB Bookshare account for the pupil if this is not 

already in place in order to access a wide range of electronic texts that can be 

uploaded directly into EasyReader (https://www.rnibbookshare.org/cms/). Please 

note that text can be cut and pasted into EasyReader. 

 

Key Vocabulary 

EasyReader/OCR app 

 

Activity 

Use backward chaining in order to develop the pupil’s ability to locate, open and 

read texts in EasyReader or an OCR app, introducing key functions and 

exploring the pupil’s preferences in speaking rate, highlighted text, text size, 

colour etc. Initially model playing and pausing on request within a motivating text 

before expecting the pupil to complete this action. Then gradually expect the 

pupil to complete all steps in order to locate and open EasyReader or the OCR 

app before selecting a text and reading it using their own preferences. Discuss 

the advantages and disadvantages of using this app as opposed to Speak 

Screen introduced in Lesson 3.  

https://www.rnibbookshare.org/cms/


 
 

115 
 

Tailor It! 

• Identify if the pupil needs to access this in a sighted or non-sighted way 

(i.e. By using VoiceOver).  

• If the pupil is accessing EasyReader in a non-sighted way, will they be 

using their BrailleNote? 

• Explore the pupil’s audio settings preferences i.e. voice settings, 

pronounciation. 

• Explore the pupil’s text settings i.e. text size, font, margins, line spacing, 

letter spacing, text colour, background colour, sentence highlight colour 

and word highlight colour.  

• Identify if the pupil would prefer to switch to text view (this removes 

images).  

• If the pupil is not motivated by texts you can download from RNIB 

BookShare, consider using the ‘My Clipboard Texts’ option in the main 

menu to cut and paste text from another source.  

 

Let’s Apply! 

• Encourage the pupil to apply their developing skills to access texts at home 

and within the classroom environment. 

 

Think SMART! 

S – Which functions do you expect the pupil to be confident with by the end of 

the lesson? Which options will they have covered? What type of texts have they 

explored?  

M – How many functions do you expect the pupil to be confident with? How 

many options have they explored?  

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Is the pupil able to identify their visual preferences yet or do they need 

opportunities to explore their visual preferences i.e. tied into their functional 

vision assessment and low vision aid assessment.  

T – How does the pupil respond to new apps? Will they need more time to 

develop confidence before using the functions of this app.  
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Instructions for Lesson 4: Dolphin’s EasyReader App 
 

 

 

Many pupils will want and need access to books, for reading for pleasure and for 
school. Books are now widely available electronically, from local library services, 
from the RNIB Bookshare, from Kindle and a plethora of other resources and the 
iPad supports a variety of different apps providing varying access to libraries, 

ways to read and ways to organise, including the inbuilt Books app, the Kindle 
app and Dolphin’s EasyReader. Here, we shall look initially at EasyReader 
although instructions for the Books app can be found below.     
 

 

EasyReader and RNIB Bookshare 
 

EasyReader is the preferred app for reading books downloaded from the 
RNIB Bookshare, and has seamless connections to the Bookshare catalogue. 
Information on setting up an education account and adding pupils can be  
found here: 
https://www.rnibbookshare.org/cms/get-started 
Pupils will need a Username and Password in order to access their 
Bookshare account on EasyReader. 
  

Initial set-up 
 
Download the EasyReader app (freely available through the Apple App Store).  
 

Create a Dolphin account 
You can link to an existing Google account, which will mean your account will be 
activated automatically and be ready to use straight away.  
Alternatively, you can create a new Dolphin account using your email address: 

• Open EasyReader. 

• Select Sign up for a new Dolphin account.  

• Enter your email address and select Next. 

• Choose a secure password, at least 6 characters long. 
Note the email address and password you use to create your Dolphin 
account for future reference. 

Agree to the Terms & Conditions and select Sign Up.  
A pop-up will appear telling you that your account has been successfully created 
and that have been sent an email to confirm your account. Select OK. 

https://www.rnibbookshare.org/cms/get-started
https://itunes.apple.com/us/app/dolphin-easyreader/id1161662515?mt=8
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You will then need to go back and sign in to EasyReader: 
 

• Open EasyReader. 

• Select the Dolphin button to log into your Dolphin account. 

• Login using the email address and password you used to set up your 
Dolphin EasyReader app account. 

N.B. There is a Forgot Password option on the app sign in screen. 
 
After successfully signing in to the EasyReader app, the My Books page will 
appear. 
 

Sign in to Bookshare 
 

• Tap on EasyReader and log in. 

• Tap on ‘List of libraries’.  

• Find and select RNIB Bookshare, and then log in to Bookshare using your 
user name and password. 

 
You will stay signed in and should only have to do this the once. 
 

Finding & opening books 
 
When you open EasyReader, you will go straight to the ‘My Books’ list. This 
contains a list of all the books available for you to read. 

• Find the book in the ‘My Books’ list 

• Tap on the book cover image for your chosen title. EasyReader will open 
the book in the Reader. 

• If it’s a book you haven’t opened before, EasyReader will take you to the 
start otherwise it will return you to the last word, phrase or paragraph that 
was used or the start of the chapter last selected. 

 

Listening to a book 
 

• In the Reader, use the ‘Play’ button (bottom centre) to start reading 

• Use the Pause button to pause playback and Play to restart. Alternatively, 
you can Play/Pause using a 2-finger double tap. 

While EasyReader is reading, you can lock the screen in the usual and continue 
to listen to with headphones. 
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Reading a book 
As ‘Listening to a book’ but don’t press the ‘Play’ button.  
 

Using My Books list 
The My Books list lists all the books that are available for you to read, and there 
are a number of ways to use it.  

 

Find out more information about a book 
 

• Find the book in the ‘My Books’ list 

• Tap the ‘information’ button to the right of the title to open the Book 
information screen. This contains a full description of the book, as well as 
options to open or delete it.  

• Tap Close (top left) to return to the My Books list 
 

Search for an author of title 
The Search box can be found at the top of the list of books, underneath the 
menu line.  
N.B. This is a search within your books only. To search for new books, you would 
need to go to one of your libraries.  
 

Sort your books 
Tap the Sort button (icon with a down arrow at the top right of your screen) and 

choose a sort option: ‘Most recent’, ‘Title’, or ‘Author’.  
 

Choose how to view your list 
Tap the tile button (next to the Sort button) to toggle between viewing ‘My Books’ 
as a list or a grid. 
 

Changing the appearance of the text 
One of the strengths of EasyReader is the number of ways you can customise 
the appearance of your books. All of the following options can be found in the 

Text settings menu. This is reached by tapping the Text Settings icon  near 
the top right of the screen when you are in Reader.  
 
When you have made your changes, tap Close to go back to the Reader screen. 
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Change the text size: use the ‘Text size’ slider to increase and decrease the 
size of the text. The text in the Reader will wrap when the size is increased 
N.B. you can also increase or decrease the size of the text in the Reader using 
the pinch to zoom gesture 
 
To change the text font used in the Reader: in the Text settings menu, select 
the arrow to the right of Font to see other font options. Choose ‘back’ to return to 
the Text settings menu.  
 
To change the text spacing in the Reader: in the Text settings menu, use the 
sliders to change the margin sizes, line, and letter spacing.  
 
To change text, background and highlight colours  
 

• Option 1: change the colour theme. In the Text settings menu, tap the 
arrow next to Colour theme and select the appropriate option. Tap the back 
arrow to return to the main menu. 

• Option 2: choose your own text, background and highlight colours. At the 
bottom of the Text settings menu, there are options to choose text colour, 
background colour, sentence highlight colour and word highlight colour. 
The present choices are depicted. Tap the arrow key to the right of the 
existing colour choice for each to view other options. Tap on your choice 
and press Back to return to the Text settings menu.  

 
 
Speech settings 

 

Change the sound of the speech 
 

• In the Reader, tap the Audio settings icon  at the top right of the screen. 

• Tap on Voice settings. 

• Adjust the voice speed using the ‘rate’ slider. Use the play button at the 
bottom right of the screen to test the speed of the voice 

• Once you are happy with the voice speed, choose ‘back’ or ‘close’ at the 
top left of the screen to return to the Reader 

 

Change the pitch, volume and add pauses to the speech 
 

• In the Reader, tap the Audio settings button at the top right of the screen. 

• Select the Voice settings button 
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• Use the sliders to adjust the voice pitch, volume and pause length. Use the 
play button (bottom right) to test your new voice settings 

• Once you are happy with the audio settings, choose Back or Close to 
return to the Reader 

 

To choose a different voice 
 

• In the Reader, tap the Audio settings icon  

• Next to Voice, at the very top of the menu, you can see your existing voice 
name e.g. Daniel, English (United Kingdom). Tap the arrow key to the right 
of this to choose from a list of available voices, tapping on your selection. 

• Tap ‘back’ or ‘close’ to return to the Reader. 
 

 

Navigating your book 
You can navigate by heading, chapter, page number or bookmark, depending on 
how the book is structured. The default navigation is by heading. The book 

navigation icon  is in the bottom left corner of the screen near the play/pause 
button. 
 

To navigate through the book 
 

• Select the Book Navigation button  

• You can navigate your book by headings, page number or bookmarks; tap 
on the relevant tab.  

• If you tap on a particular heading or page number, for example, 
EasyReader will take you there.  

 

Navigate using a single tap 
If you are reading a book containing text, you can single tap anywhere in the 
book to move the highlight to that part of the book. 
 

Navigate using the next and previous buttons 
 

• You can use the Next and Previous buttons (located either side of the Play 
button) to skip forward and backward in your book.  
 

By default, EasyReader will skip by sentence in books containing text, or by 30 
seconds in audio books but you can adjust this using the Navigation icon (looks 
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like a small timer at the bottom right of the screen) and choosing an alternative 
value. 
 

• You can also swipe to the right with two fingers to skip forward. Swipe to 
the left with two fingers to skip backward 

 

Navigate to a specific heading, page or bookmark 
Tap the Book navigation icon.  
EasyReader will open a list of all the headings in a book. Using the tabs across 
the top of the screen, you can also switch to view: 
- A list of all of the pages in the book 
- A list of all of the bookmarks which you have added to the book 
Choose a heading, page or bookmark. EasyReader will skip straight to that 
section in the book 
 

Navigate using the progress slider 
You can also navigate your book using the progress slider. To do this: 

• Tap on the progress bar. This may be at the top centre or at the bottom 
centre of your screen, with a percentage marked at the end, and on some 
iPads you will need to tap to see a slider (on others, the slider is always 
there).  

• Move the slider left or right to navigate through your book. 
 

Go to a bookmark 
EasyReader will automatically return you to the place you left off in a book, but 
you may wish to bookmark text to return to later.  
 
To add a bookmark 
 

• In the Reader, tap on the part of the book which you would like to set as a 
bookmark. 

• Tap the Bookmark icon, which will be at the top or bottom of your screen.  

• The Bookmark menu will appear. This gives you the options of adding a 
text note about your bookmark (tap in the box to start typing it) or else an 
audio note, which can be done by tapping the microphone button.  

• Tap the Save button to return to Reader. The section of the book where 
you added a bookmark will now include a bookmark symbol.  
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Finding your bookmarks 
 

• Tap the Book Navigation icon and choose Bookmarks.  

• This will give you some of the text that you have bookmarked, indicate how 
far through the book the bookmark has been placed, and you can read any 
notes about your bookmark by tapping the pen icon.  

• Tap on the relevant bookmark to be taken to that place in the text. 
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 Instructions for Lesson 1: OCR 

 

 

OCR (Optical Character Recognition) software converts images of typed, 
handwritten or printed text into machine-coded text – text that software like Notes 
and Word recognise as writing rather than an image. This is particularly helpful if 
you are sight-impaired or struggle to read text that is small or has poor contrast 
or a fussy font as it can suddenly render things like worksheets, medicine labels, 
washing instructions on clothes or articles in a magazine accessible.   

There are many OCR apps available for download to the iPad. Here we will look 
at just one, Microsoft Office Lens, which is free to download. Other options 
include KNFB Reader, Seeing AI (Microsoft) and OCR Scanner. 

  

How to use Lens  

1. Choose what to capture  

As soon as you open Microsoft Lens, you can choose a capture mode: 
Whiteboard, Document, Business Card or Photo.   

Whiteboard:  This mode is best used for capturing handwritten notes and 
sketches on a whiteboard or similar large surface like a flip-chart. Lens will adjust 
your images so that the background isn’t too bright and the ink strokes are easier 
to see.  

Document: best used for small words written or typed onto a small surface, like 
a page or note, forms, receipts, posters and menus.   

Business Card: this mode captures information from a business card, and will 
save to your Contacts app.  

Photo: best for capturing photos and images.   

This menu may be on the right side of the screen underneath the shutter bottom, 
or else can be reached by swiping left or right near the bottom of the screen.   
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Step 2: Take the picture  

After you’ve selected your capture mode, you can either take a new photo with 
your camera, or else import an existing image.   

To take a picture with your iPad, point the camera at the item you want to 
capture and make sure that the orange frame in the camera outlines the item you 
want to capture.  You can change your camera’s flash setting by tapping the 
Flash icon in the upper right corner of the capture window.  

When you’re ready to take the picture, tap the round Shutter button at the bottom 
centre of your screen.  

N.B. People who are blind or have low vision can use the VoiceOver feature in 
iOS to get real-time voice guidance in Microsoft Lens — such as “move right,” 
“move up,” and more. For more information, see Accessibility in Microsoft Lens 
for iOS.  

If you prefer, you can import an existing image from any Photo Album on your 
device.   

• In the Microsoft Lens capture screen, tap the Pictures icon (which may be 
at the right, or in the lower left corner of the screen).   

• Navigate to the photo album containing the picture you want to use, and 
then tap it to import it into Microsoft Lens.  

  

Step 3: Review and edit  

Microsoft Lens lets you edit captured images before you save them, so they 
look exactly how you want. You have the option to adjust the borders of an 
image after you capture it, or to capture multiple images one after the other and 
edit them later.   

Tap any of the icons that appear in the lower tray to begin editing or adjusting a 
captured image.  

You can Add a new image to your scan, apply a Filter to the 
image, Crop, Rotate, or Delete the image, or annotate it with the Pen or 
with Text.   

Filters are used to quickly apply visual enhancements to selected image (for 
example, to remove all colours from a document).  

https://support.microsoft.com/en-us/office/9a6cb4e2-6ceb-438d-829e-b3c7e977b5d8
https://support.microsoft.com/en-us/office/9a6cb4e2-6ceb-438d-829e-b3c7e977b5d8
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By using the optional Crop feature, you can trim away any unwanted parts of the 
image by excluding them from your selection. When you have finished cropping 
the image, tap Confirm in the lower right corner. If you want, you can then 
continue editing the current image with any of the other editing tools.   

When you’re done editing your images, tap Done in the lower right corner.  

You might now choose to Save and Share your image. Alternatively, you might 
wish to listen to the text in your document immediately.  

  

Option 1: Save and share  

If your image was captured in Whiteboard, Document, or Photo mode, you can 
save it to your Photo Library, as a PDF, or alternatively save it to 
OneNote or OneDrive. PDF files extract the text information from a captured 
image. You can search the text contents of a PDF file and highlight or copy any 
part of the page with your preferred PDF Reader app.  

You can also save the image as either a Word or a PowerPoint document in 
your OneDrive account.   

  

Microsoft Word: contains powerful OCR software, capable of deciphering all 
legible text in your document, whether typed, handwritten or printed. It will also 
capture the general layout of the document you have scanned. If you intend to 
apply OCR to your image, therefore, you should select to save as a Word file.   

Microsoft PowerPoint: can recognise handwritten lines and strokes that are 
transformed into drawing objects that can be re-coloured, resized, moved 

around, and edited. You can also remove the background of drawings, which 
makes it easier to reuse them in other presentations.  

If your image was captured in Business Card mode, tap OneNote to save it as a 
vCard (.vcf file).   

Captured images saved as Word, PowerPoint, or PDF files will be in 
your Documents folder on OneDrive, so you can access them from any of your 
devices. PDF files can also be saved locally on your iPad, and you can edit the 
save location for your PDF by tapping the Save button.  
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Option 2: listen to any text within your image immediately 

If you are more interested in understanding the written content of 
your document immediately, do not choose an option within the ‘Save To’ menu. 
Instead look at the ‘Share To’ menu at the bottom and tap on Immersive 
Reader.  

Warning: it might take a little while to open!  

  

Using the narrator 

Listen to the text: When the document opens, tap on the green Play button at 
the bottom of the screen. Each word is highlighted as it is read.   

Pause play:  The Play button toggles to become Pause when the narrator is 
reading. You can either press the Pause to stop and play to start up again. 
Alternatively, double-tap the screen.  

Skip forward or back: tap on the screen where you want narration to start, then 
tap Play.   

 

Voice options  

To change the speaking speed of Immersive Reader, tap on Voice Settings next 
to the Play button.   

You can swipe the slider left or right to decrease or increase voice speed.  

Tap on Male or Female to change the gender of the speaker.  

swipe right or left until you hear “Speak button,” double-tap the screen, and 
swipe up or down to adjust the speed in the Speaking Rate slider. The slider lets 
you control the speed to your personal preference. To dismiss the slider popup, 
tap the screen. When you hear “Dismiss popup”, double-tap the screen.  

  

Change how text looks in Immersive Reader  

Tap on Text Settings (two A’s) at the top of the screen.  
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Change text size: move the slider until you can see the text of your document 
reach the desired size. The font size is indicated under the centre of the dial.  

Increase spacing: toggle the button ON to increase spacing. This is the spacing 
both between letters and lines.  

Change Font: tap next to your preferred font option.  

Change colour themes: the little coloured buttons show a small selection of the 
colour themes you can apply to Immersive Reader. Tapping on the More colours 
label will bring up many more. Tap on your preferred option.   

Show windows of text at a time: along from the Text settings icon is an icon 
that looks like an open book. Tap on this to find an option called Line Focus. The 
default option is for the whole body of text to be available at once, but by toggling 
the button on you can select to turn Line Focus on. You can choose, by tapping 
on one of the 3 boxes below, whether to see just 1 line of text when reading, 3 lines of 

text, or 5 lines of text.   

  

For all options, click on the X at the top right of the menu to close and return to 
the text.  

  

Emerging literacy options  

There are some lovely features within Immersive Reader to support the teaching 
of literacy.   

Picture Dictionary: this is an option within the Reading menu at the top (icon 

shows an open book). Toggle Picture Dictionary (Boardmaker) ON to have 
an image pop up for each word you tap in the main screen. Children will also 
have the option to re-listen to the word being said by tapping on the small ‘Listen’ 
box to the top left.   

 

Highlighting syllables in words: this option is available in the middle menu at 
the top, a picture of a line of text with a magic wand. Toggle ON Syl-la-bles to 
break down longer words in the text into their constituent syllables to aid young 
reader.  
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Highlighting parts of speech: in this same ‘Magic wand’ menu, you can choose 
to have different parts of speech within the text – nouns, verbs, adjustives and 
adverbs - highlighted in different colours by tapping the toggle ON next to each 
option. Colour choices for each have been made but a drop-down menu next to 
each gives the option to change to something more suitable.   

  

Accessibility  

To make it easier to work with Microsoft Lens, you can connect a keyboard to 
your device with either Bluetooth or USB.  

Microsoft Lens is entirely compatible with the VoiceOver. Details can be found 
here:  

Microsoft Lens for iOS - Office Support  

  

In addition, the Accessibility settings in iOS and iPadOS can help you use 
Microsoft Lens in a way that works best for you. On your iPhone or iPad, go 
to Settings > Accessibility to turn on features like VoiceOver. 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

https://support.microsoft.com/en-us/office/microsoft-lens-for-ios-fbdca5f4-1b1b-4391-a931-dc1c2582397b
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4b. VoiceOver 

 

 

Outcome 

The pupil will be able use correct Voiceover gestures and features to interact 

with a range of information on and off-line.  

 

Medium-Term Planning 

 

Lesson Outcome Key Skills Key 
Knowledge 

Links to 
Other 
Units 

Lesson 5: 
Introduction 
to VoiceOver 

The pupil can use 
the correct 
Voiceover gesture 
to identify apps, 
scroll between apps 
from left to right 
and right to left, 
open apps and 
scroll between 
screens to locate 
more apps as well 
as turn Voiceover 
on and off using the 
shortcut feature. 

Apply basic 
VoiceOver 
gestures 

Correct 
vocabulary for 
VoiceOver 
gestures 
The purpose of 
screen-readers 
How an in-built 
screen-reader 
can support 
access to an 
iPad 
Which 
gestures suit 
the pupil best 

Unit 2, 
Lesson 1 

Lesson 6: 
Using 
VoiceOver to 
Access 
Texts 

The pupil will be 
able to apply 
VoiceOver gestures 
to listen to text 
presented in apps 
by successfully 
opening, pausing, 
unpausing, reading 
an electronic text 
from the top of the 

Applying learnt 
gestures to 
accessing 
texts 

How 
VoiceOver can 
enable access 
to reading  
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screen and 
navigating through 
the text on request.  

Lesson 7: 
Using 
VoiceOver in 
Safari 

The pupil can apply 
VoiceOver to 
navigate webpages 
in Safari, 
comparing their 
experience with 
and without Reader 
mode in order to 
find key 
information. 

Activating 
Safari Reader 
Applying 
VoiceOver 
gestures to 
navigating 
Safari 

How Safari 
Reader can 
support 
navigation in 
Safari 
The 
importance of 
accessing 
decluttered 
text 

 

Lesson 8: 
Introduction 
to the 
VoiceOver 
Rotor 
Feature 

The pupil can 
identify their 
preferred gesture to 
activate and 
navigate the 
VoiceOver Rotor 
feature. 

Activate the 
VoiceOver 
Rotor 
Use Rotor 
gestures 

Which 
VoiceOver 
Rotor gesture 
suits their 
needs  
The function of 
the Rotor 

 

Lesson 9: 
Applying the 
VoiceOver 
Rotor to 
Safari 

Compare and 
contrast navigating 
webpages using 
VoiceOver with and 
without the Rotor. 

Applying the 
Rotor to 
navigating 
Safari 
Utilising the 
Rotor and 
Reader in 
conjunction 
with each other 

Similarities and 
differences 
between using 
and not using 
Rotor in Safari 
Which method 
suits their 
needs 
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iPad Accessibility Skills 
Unit 4 - Accessing Text 

VoiceOver 1 Progression 

Basic Skills Introduce Developing Achieved 

Use the shortcut function to start and stop VoiceOver 
   

Use a swiping gesture to move onscreen  
 

  

Use a single finger double-tap gesture to open apps 
   

Use a split-tap gesture to open applications     

Read the current item     

Use a three-finger gesture to move between screens     

Pause and unpause VoiceOver    

Read from the top of the screen     

    

Intermediate skills    

Use Item Chooser    

Use the screen curtain    

Mute and unmute VoiceOver     

Unlock iPad    

Ask for help    

Locate VoiceOver menu in the Accessibility Menu in Settings     
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Advanced skills    

Go to Dock and App Switcher    

Go to Control Centre and Notification Centre    

Hear Status Bar information    

VoiceOver 2 (with Rotor and external keyboard) Progression 

Advanced skills Introduce Developing Achieved 

Using the VoiceOver Rotor 
 

  

Activate the Rotor 
 

  

Navigate the Rotor to locate an option 
 

    

  

Understanding Rotor options    

Review text as you type with Characters, Words, and Lines      

Move through the organisation of a page or screen    

Move from link to link    

Move through a page    

    

Customise VoiceOver rotor    

Choose rotor options    

Have VoiceOver confirm rotor actions    

Add popular commands e.g. Language/Speed/Zoom/Punctuation    

    

Use VoiceOver with external Apple keyboard    

Choose VoiceOver modifier key    

Common VoiceOver keyboard commands    

Quick Nav using the arrow keys    
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Lesson 5: Introduction to VoiceOver 

 

Outcome 

The pupil can use the correct Voiceover gesture to identify apps, scroll between 

apps from left to right and right to left, open apps and scroll between screens to 

locate more apps as well as turn Voiceover on and off using the shortcut feature. 

 

Links to Previous Learning 

Ensure the pupil has successfully completed Lesson 1, Unit 2 and is therefore 

competent in naming and applying gestures. 

 

Preparation  

Add VoiceOver to the Accessibility Shortcut menu within Settings. 

 

Key Vocabulary 

VoiceOver, single-finger single tap, single-finger double tap, triple-finger swipe, 

Home button, single-finger swipe 

 

Activity 

Demonstrate triple-clicking the Home button in order to activate VoiceOver using 

the shortcut feature. Model using a single-finger swipe VoiceOver gesture to 

identify apps in a single line on the Home Screen. Provide opportunities for the 

pupil to locate a specified app using Voiceover, gradually increasing the range of 

apps to search through on the Home screen from left to right. They may enjoy 

playing Hide and Seek using a familiar app icon. Once the pupil is successfully 

able to scroll from left to right, practise scrolling from right to left. Develop the 

searching technique by asking the pupil to use a three-fingered swiping gesture 

to scroll to another screen to search for an app. Once the pupil has located a 

named app, provide guidance for the pupil to open it. Ensure that the pupil 

associates the correct gesture name with the appropriate gesture.  
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Tailor It! 

• Compare activating and deactivating VoiceOver using the shortcut feature 

to Siri and identify pupil’s preference.  

• Identify the pupil’s preferred gesture to open an app using VoiceOver by 

comparing a double-tap gesture to a split-tap gesture. Which one do they 

prefer? Extend to opening an app using Siri instead of the single-finger 

double-tap gesture.  

• Change the speaking rate to suit the pupil. 

• Change the voice to suit the pupil’s preference.  

• Adapt the Verbosity within the Settings menu to customise how much 

information is read out. 

• Depending on the level of functional vision, explore if the pupil prefers the 

use of the large cursor within the Settings menu.  

 

Let’s Apply! 

• Use motivating apps to encourage the pupil to practise basic VoiceOver 

gestures. 

• Consider using the apps ‘Ballyland Stay Still, Squeaky!’ and ‘Ballyland™ 

CosmoBally™ in Space’ or VO Lab depending on the developmental age 

of the pupil as a fun way to practise VoiceOver skills.  

• Demonstrate how to turn VoiceOver on and off in the Settings menu. 

 

Think SMART! 

S – Which gestures do you expect the pupil to be able to demonstrate by the end 

of the lesson?  

M – How accurate do you expect them to be with their gestures? How many 

attempts to locate and/or open an app before they are successful? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Check that the pupil is ready to begin VoiceOver (in relation to their fine 

motor skills and cognitively).  

T – Will the pupil be able to perform all of these gestures in one lesson or do 

these skills need to be broken down into a number of lessons?  
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Instructions for Lesson 5 

 

  

Voiceover is a gesture-based screen reader that enables non-visual access to 
the iPad. You can hear everything that is happening on the screen and, by using 
simple gestures, you can interact with items, use apps and explore locations and 
context.  
 

How to turn VoiceOver ON/OFF 
There are several ways to do this:   
 

• Use Siri. Ask her to “Turn on VoiceOver” and then to “Turn off VoiceOver” 
when you are finished.   

• Triple-click the Home button and select VoiceOver (on iPads with a Home 
button, if accessibility shortcut is configured for VoiceOver). Do this again 
to close. 

• Triple-click the top button (on other iPad models). Do this again to close.  

• via the Control Centre: swipe down from top right of the screen. Select 
Accessibility Options icon (looks like a little man) and then select 
VoiceOver. Do this again to close. 

• via Settings: tap Settings, tap Accessibility, and then tap next to 
‘VoiceOver’ to toggle it ON.  Do this again to turn if OFF.  

 

Learning and practicing VoiceOver gestures  
VoiceOver uses the basic gestures that are used elsewhere on the iPad. 
However, it changes what they do so that you can hear the descriptions without 
activating the buttons. 
 
The key VoiceOver gestures are: 

• The 1-, 2-, 3- and 4-finger tap 

• The 1-, 2-, 3- and 4-finger double-tap 

• The 1-, 2-, 3- and 4-finger triple-tap 

• Swiping up, down, left and right with 1, 2 and 3 fingers 
 
It is essential that pupils are able to render these gestures accurately if they are 
to use VoiceOver successfully. iPad helpfully provides a practice arena called the 
VoiceOver ‘Help Mode’. In Help Mode, you practice a gesture safe in the 
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knowledge it won’t actually do anything! VoiceOver will simply announce the 
gesture and state what it does.  
 

How to access Help Mode 

 

• Tap on Settings 

• Tap on Accessibility 

• Tap on ‘VoiceOver’ 

• Turn VoiceOver ON, and then tap ‘VoiceOver Practice’. 

• You will need to then double-tap the screen to enter VoiceOver Practice 
(as VoiceOver is now active, a simple tap will announce what item you 
have pressed rather than activate it). 

 
To come out again, tap on Done and then double-tap to come out.  
 

Customising VoiceOver voice settings 
Before going any further, you might like to customise VoiceOver so that it is set 
up in the way that best suits you. You can customise these settings from the 
VoiceOver menu (reached by tapping on Settings and then Accessibility). 
VoiceOver should be turned OFF. 
 

Speaking rate  
At the VoiceOver Menu, ‘Speaking rate’ is the first menu option. 
Move the slide left and right to change how quickly the voice speaks (moving it to 
the right makes it faster).    
 
Speech  
The voice used by default is Samantha, a female American voice, but users can 
choose between male and female voices as well as different accents from within 

the UK and English-speaking world.  

• At the VoiceOver menu, tap on ‘Speech’ and then ‘Voice’. 

• The voices are named and categorised according to accent.  Tap next to 
each voice to download a sample.  

• When the sample has downloaded, tap on the arrow to see a play button. 
When you have listened to it, tap on the back arrow above to return to the 
original menu.  

• You can try other voices in the same way. Otherwise, select one that you 
have downloaded by tapping to the left of the name to tick it.  
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Pitch 
You can make the voice pitch higher or lower in the Voiceover > Speech menu. 
Use the slider to increase or decrease pitch.  
Underneath is a toggle key for ‘Use Pitch Change’. Toggling this ON would mean 
that the pitch will get lower towards the end of a sentence or a list, just like it 
does when speaking. Tap to select or deselect.   
 
Verbosity  
Verbosity determines what information is read, such as punctuation, capital 
letters, embedded links, table headers, emojis, and similar.  

• In the VoiceOver menu, tap on Verbosity 

• You can see a list of all the things that VoiceOver can tell you about. For 
some options, there is simply an ON/OFF toggle button which you tap, for 
example, Table Headers and Speak Emojis. 

• For others, there is a sub-menu with additional options which can be 
reached by tapping the arrow to the right of the menu item. For example, 
the Capital Letters menu offers different ways for VoiceOver to alert you to 
capitals: Speak Cap, Play Sound; Change Pitch; or Do Nothing. Tap on 
your choice. Alternatively tap the back arrow to return to the previous 
Verbosity menu. 
 

Starting with VoiceOver gestures 

 

Explore the screen 
 

Highlight and hear what is under your finger: single-tap the screen with 1 
finger. 
Scroll to next pages: swipe left with 3 fingers to scroll right, and right with 3 
fingers to scroll next. 
Scroll to pages above or below: swipe up with 3 fingers to scroll down, and 
down with 3 fingers to scroll up. 
 

Interact with items 
 

Select an item: after single-tapping the screen with 1 finger to hear the item, 
double-click the screen to open. 
To Select the next item: (only useful if you know the layout of you iPad screen), 
flick right or left with one finger.  
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Lesson 6: Using VoiceOver to Access Text 

 

Outcome 

The pupil will be able to apply VoiceOver gestures to listen to text presented in 

apps by successfully opening, pausing, unpausing, reading an electronic text 

from the top of the screen and navigating through the text on request.  

 

Links to Previous Learning 

Ensure that the pupil is able to successfully apply a single-finger single tap, a 

single-finger double tap, a single-finger swipe to the left and right as well as a 

triple-finger swipe gesture to the left and right using VoiceOver (Lesson 1, Unit 

3b). 

 

Preparation 

Prepare an electronic text in iBooks. 

 

Key Vocabulary 

VoiceOver, single-finger swipe, single-finger single tap/split-tap, double-finger 

single tap, double-finger swipe up, double-finger swipe down, triple-finger swipe 

 

Activity 

 Explain how information in print accessed by their peers in class can also be 

read using VoiceOver. Use examples such as texts to demonstrate this. Discuss 

the purpose of accessing texts in iBooks in order to listen to texts for home and 

school use. Model and provide guidance in order to select lines of text to be read 

with Voiceover, pause and un-pause using a two-finger single tap and scroll to 

the next screen using gradually more complex texts and formats.  

Employ role-play scenarios to model and practise pausing and unpausing 

VoiceOver in iBooks. Explain what happens if you touch the screen or buttons 

after pausing VoiceOver. What can you do to start VoiceOver again? 

Demonstrate using a two-finger swipe gesture to command VoiceOver to read 
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from the top of the screen. Encourage the pupil to read texts from the top of the 

screen and use this as a problem-solving strategy when pausing/unpausing has 

been misapplied. 

Develop the pupil’s ability to use a precise gesture to command VoiceOver to 

read from the top of the screen to locate key information. Talk over VoiceOver so 

that the pupil can’t hear. What gesture can you use to listen to the page again? 

Ask the pupil to model how to do this and support them to improve their 

technique if appropriate. Model also accidently tapping the screen so that it only 

reads out one line of text. Encourage the pupil to identify the two-finger drag up 

gesture to command VoiceOver to read from the top of the screen again. Identify 

at least one situation in which this gesture is useful in the classroom.  

Once the pupil is developing competency in this gesture, provide chaining to 

encourage them to locate iBooks, open the library, navigate the library to find a 

named book and open this with VoiceOver.  

 

Tailor It! 

• Ensure the Voiceover reading pace suits the pupil. 

• Ensure that the Voice suits the pupil. 

• If the pupil uses a BrailleNote, they could use access this alongside in 

order to have the print available in an auditory and Braille format.  

 

Let’s Apply! 

• Discuss the purpose of accessing texts in iBooks in order to listen to texts 

for home and school use. 

• Transfer access to texts using the taught gestures skill in other apps i.e. 

Pages. 

• Encourage the use of VoiceOver within the classroom to enable the pupil to 

access texts quickly and easily.  

 

Think SMART! 

S – Which gestures do you expect the pupil to learn and apply by the end of the 

lesson? Will the pupil be able to demonstrate these in iBooks and other apps 

too? 
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M - How accurate do you expect them to be with their gestures? How many 

attempts before they are successful? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Is the pupil confusing gestures? Perhaps they need more time to complete 

Lesson 2, Unit 3?  

T - Will the pupil be able to perform all of these gestures in one lesson or do 

these skills need to be broken down into a number of lessons in order to 

confidently apply within iBooks? 
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Instructions for Lesson 6: More VoiceOver Gestures 

 

Listening to content  
 

Read aloud from the current position: swipe down with 2 fingers. 
Read aloud from the top: swipe up with 2 fingers. 
Read whole screen: swipe down from the top. 
Pause/resume reading: single-tap the screen with 2 fingers. 
 

Using the Screen curtain 
The screen curtain blacks out the screen so that the user has privacy. To the 
sighted user, the screen appears to be off although there is still full functionality.  
 
To activate or de-activate the screen curtain, triple tap on the screen with three 
fingers. 
 

Unlock iPad 
 

• On an iPad with a Home button, press the Home button (Touch ID must be 
enabled). 

• Otherwise, press the Sleep/Wake button at the top. If Face ID is enabled, 
drag up from the bottom of the screen until you hear 2 tones. 
 

You may be prompted to enter your passcode.  
 

Asking for help 
VoiceOver help is there to assist if you get stuck.  

• To activate: double-tap the screen with 4 fingers.  

• To deactivate: use 2 fingers to scrub back and forth on the screen.  
 

Toggle VoiceOver ON and OFF 
Double-tap the screen with three fingers.  
 

More on Gestures 
 

Go to Home screen: swipe 1 finger from bottom of the screen. Lift finger on the 

2nd sound. Alternatively, press the Home button. 
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Go to Dock: Swipe 1 finger from the bottom of the screen until you hear the 2nd 

screen. Then swipe down. Double-tap to select your option. 

Go to App Switcher: Swipe 1 finger up from the bottom of the screen. Lift finger 

on the 3rd sound. Alternatively, double-click the Home button. To browse the 

open apps, swipe left or right to find the app you want, and then double-tap to 

select.  

Go to Control Centre:  

• swipe 1 finger down from the top of the screen. Lift finger on the 2nd 
sound.  

• tap any item in the status bar, then swipe up with three fingers.  

• to dismiss, do a 2-finger scrub (3 times, quickly move 2 fingers back and 
forth in a ‘z’ shape).  

 
Go to Notification Centre:  

• swipe 1 finger down from the top of the screen. Lift finger when you hear 
the 3rd sound.  

• tap any item in the status bar, then swipe down with three fingers.  

• to dismiss the notifications screen, do a 2-finger scrub (as above). 
 
Hear Status Bar information:  

• tap the status bar at the top of the screen.  

• swipe left or right to hear the time, battery life, Wi-Fi strength, status of 
downloads etc.  

 

Search from Home Screen:  

• tap anywhere on the Home Screen outside the status bar. 

• swipe down with three fingers.  
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Lesson 7: Using VoiceOver in Safari 

 

 

Outcome 

The pupil can apply VoiceOver to navigate webpages in Safari, comparing their 

experience with and without Reader mode in order to find key information.  

 

Links with Previous Learning 

Ensure that the pupil is confident in applying basic VoiceOver gestures 

introduced in Lesson 1 and 2, Unit 3. 

 

Preparation 

Identify motivating webpages or pages linked to topics which have Safari Reader 

mode available.  

 

E-Safety 

Ensure that the pupil is able to follow e-safety school guidance in order to 

recognise any inappropriate content and knows how to report concerns. 

 

Vocabulary 

Reader mode 

 

Activity 

Introduce the Reader mode in Safari, using VoiceOver and functional vision if 

appropriate in order to locate the icon and select this mode. Successfully 

navigate through a webpage using Reader mode with VoiceOver in order to 

answer simple questions or retrieve facts. Make comparisons between 

webpages with and without Reader mode enabled and identify benefits of using 

Safari Reader if it is available. Begin with familiar webpages before exploring 

unfamiliar pages, asking the pupil to find key information from these webpages. 
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Tailor It! 

• Utilise options within Reader mode in order to suit the pupil’s visual needs. 

 

Let’s Apply! 

• Provide opportunities to access a number of websites using VoiceOver, 

applying their ability to locate Reader mode and activate this as well as 

problem-solve if they cannot find it i.e. Reader mode is not available. 

• Encourage the use of VoiceOver and Reader mode within the classroom 

environment and at home to quickly access information online. 

 

Think SMART! 

S – What research skills do you expect the pupil to perform? What kind of 

websites do you expect the pupil to access? Are these both familiar and 

unfamiliar websites? 

M – How many questions do you think they can answer? How many attempts will 

it take to find the information/Reader mode button? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Ensure the pupil is confident in applying taught VoiceOver gestures to date? 

Have they had any experience of accessing the internet before or do they need 

some pre-teaching before introducing this lesson? 

T – Will the pupil be able to successfully locate and activate Reader mode before 

locating information in websites and comparing this to without Reader mode in 

one lesson or does this lesson need to be broken down further? 
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Lesson 8: Introduction to the VoiceOver Rotor 

Feature 

 

Outcome 

The pupil can identify their preferred gesture to activate and navigate the 

VoiceOver Rotor feature. 

 

Preparation 

Ensure VoiceOver is either available as a shortcut feature or on.  

 

Key Vocabulary 

VoiceOver Rotor 

Activity 

Model activating the VoiceOver Rotor and listening to the options using all of the 

available gestures. Encourage the pupil to practise activating the VoiceOver 

Rotor using all of the gestures and identify their preferred method. Then provide 

guidance in order for the pupil to access the VoiceOver Rotor menu and choose 

an option. Discuss when the VoiceOver Rotor can be used to change how they 

can utilise VoiceOver to access information onscreen.  

 

Tailor It! 

• Ensure the pupil chooses their preferred method to activate the VoiceOver 

Rotor and practises this method.  

• Control the amount of options and their function within the Rotor within the 

Settings menu i.e. starting with two.  

 

Let’s Apply! 

• If suitable for the pupil’s developmental level, provide opportunities to 

develop VoiceOver Rotor skills using the Ballyland Rotor app. 
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• Gradually increase the amount of options within the Rotor from the Settings 

menu. 

 

Think SMART! 

S – Will you expect the pupil to activate and navigate the VoiceOver Rotor within 

the lesson?  

M – Within how many attempts do you think it will take for the pupil to activate 

the Rotor on each occasion? On how many occasions will it take the pupil to 

successfully activate the Rotor? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Are there some gestures which you know will be easier for the pupil to 

perform than others so you can just focus on those? Are they confident in 

performing a flick up and down yet or do they need more practise before applying 

it to the Rotor? 

T – Will the pupil be able to successfully activate and navigate the Rotor within 

one lesson as well as understand its purpose or do they need to achieve this 

over a number of lessons? 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

147 
 

Instructions for Lesson 8: Using the VoiceOver Rotor 
  
  

 

 

The Voiceover rotor is a virtual control that acts like a dial when VoiceOver is on. 
It allows you to move through a document, navigate web pages, edit documents 
and much more. It also enables you to change how VoiceOver works, adjusting 
settings and accessing additional commands and features including special input 
methods such as Braille or Handwriting. 
 
Although it is a very sophisticated device, it always works in the same way: 

• With VoiceOver ON, rotate two fingers on your screen as if you’re turning a 
dial. If you prefer to use one finger on each hand, simultaneously drag up 
with one finger and drag down with the other. 

• VoiceOver speaks the rotor setting. Keep rotating your fingers to hear more 
settings. Stop rotating your fingers when you hear the setting you want. 

• Quick swipe up or down to change the setting depending on the option 
chosen e.g. for volume, it will make it louder or quieter; for speed, it will 
make it faster or slower.  

 
The available rotor settings and their effects depend on what you’re doing. For 
example, if you choose Headings when you’re browsing a webpage, swipe down 
or up to move the VoiceOver cursor to the next or previous heading. 
 

Understanding rotor options 
 
With all of these options, you can move from one item to the next by flicking on 
the screen from top to bottom with one finger. You can move VoiceOver to the 
previous item by flicking from bottom to top.  
 
 
 
 

Review text as you type with Characters, Words, and Lines  
 

Characters: Reads one character at a time.  
Words: Reads one word at a time.  
Lines: Reads one line at a time.   
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Move through the organisation of a page or screen  
 

Containers: Moves from one onscreen container to the next. The Dock and 
Home screen, for example, are containers.   
Headings: Moves from one heading to the next. Try using this rotor in Settings > 
Mail, Contacts, Calendars.  
Landmarks: Moves between banners, navigation, and buttons in HTML content 
(such as a webpage or HTML email).  
Same Item: Moves from one item to the next item of the same kind. Try this with 
the links in the results of a Safari web search.  
Vertical Navigation: Moves up or down with one-finger vertical flicks. Try this on 
the Home screen.  
Static Text: Moves from one line of static HTML text to the next. Static text is the 
main text on the page—not links or button names, for example.  

 

Move from link to link  
 

Links: Moves from one link to the next.  
Visited Links: Moves from one link to the next, but only those that you've 
already clicked.  
Non-visited Links: Moves from one link to the next, but only those that you 
haven't clicked yet.  
In-Page Links: Moves from one in-page link to the next on a webpage.  

 

More ways to move through a page 
 

Tables: Moves the VoiceOver cursor to the start of a table on a webpage.  
Lists: Moves the VoiceOver cursor to the start of a list on a webpage.  
Buttons: Moves from one button to the next in HTML content.  
Form Controls: Moves between buttons and menus when using a form.  
Text Fields: Moves from one text field to the next in HTML content.  
Search Fields: Moves from one search field to the next in HTML content.  
Images: Moves to images.  

 
Customise the VoiceOver rotor 
Some of the options above are on the rotor by default, and some are optional.  
To choose your rotor options:  

• Select Settings 

• Select Accessibility 
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• Go to VoiceOver and then Rotor 
Now select the options you want. 

Alternatively drag  icon to reorder settings. 
 
To have VoiceOver confirm rotor actions:  

• Select Verbosity 

• Turn ON Speak Confirmation. 
 
Here are some of the more popular commands to add to the rotor:   

Language  
To change the voice VoiceOver uses. There are many options, including male 
and female and a variety of different accents and dialects.   

Speed  
This option allows you to adjust the text-to-speech voice speed quickly.  

Zoom  
You can use VoiceOver and Zoom simultaneously. Controlling Zoom on the roto 
allows quicker enlargement and shrinking of the screen.   

Punctuation  
Sometimes you want to hear every piece of punctuation, whereas others you will 
just want the text. This control enables you to quickly adjust the amount of 
punctuation VoiceOver speaks.  
 
 

Using VoiceOver with an external Apple keyboard 
  

Using an external keyboard is a rather different experience to using the 

integrated keyboard as it enables you to use keyboard shortcuts to active 

VoiceOver commands. 

You can also use VoiceOver help to learn the keyboard layout and the actions 

associated with various key combinations. This means that although VoiceOver 

tells you what keys you are pressing and what keyboard commands they are 

associated with, it doesn’t perform the associated action – in the same way that 

the VoiceOver Practice screen enables you to try out VoiceOver gestures without 

them taking effect.  
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Choosing the VoiceOver modifier key 
  
The VoiceOver modifier key is a key or set of keys you press to change the way 
the keyboard works and thus enable you to control VoiceOver. As with other 
screen readers, you can set the modifier to be the Caps Lock key. You can also 
choose to use the Control and Option keys (pressed simultaneously).  

• Select Settings 

• Select Accessibility 

• Select VoiceOver, for the VoiceOver men 

• Select Typing 

• Finally, select Modifier Keys 

• Choose which modifier you would like to use (the Caps Lock key or the 
Control + Option keys) and double tap to select. 

  

Common VoiceOver keyboard commands 
 
The modifier is abbreviated as “VO” in the tables below; for VO you should insert 
the modified key/s you selected. 
  

Action Shortcut 

Turn on VoiceOver Help VO-k 

Turn off VoiceOver Help Esc (escape) 

Select the next or previous item VO-Right Arrow or VO-Left Arrow 

Activate the selected item VO-Space bar 

Touch and hold the selected 
item 

VO-Shift-M 

Read from the current position VO-A 

Read from the top VO-B 

Pause or resume reading Control 

Copy the last spoken text to the 
clipboard 

VO-Shift-C 

Search for text VO-F 

Mute or unmute VoiceOver VO-S 

Go to the Home Screen VO-H 

Move to the status bar VO-M 

Open the notifications screen Move to the status bar (O-M) then 
Option-Up Arrow 

Open Control Centre Move to the status bar (VO-M) then 
Option-Down Arrow 

Open Search Option-Up arrow 
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Open the App Switcher VO-H-H 

Switch apps Command-Tab or Command-Shift-
Tab 

Open the Item Chooser VO-I 

Change the label of the 
selected item 

VO-/ 

Start, stop or pause an action VO-Hyphen 

Swipe up or down VO-Up Arrow or VO-Down Arrow 

Adjust the rotor VO-Command-Left Arrow or VO-

Command-Right Arrow 

Adjust the setting specified by 
the rotor 

VO-Command-Up Arrow or VO-
Command-Down Arrow 

Turn the screen curtain ON or 
OFF 

VO-Shift-F11 

Return to the previous screen Esc (escape) 

 
  

Quick Nav using the arrow keys 
  

Turn on Quick Nav to control VoiceOver using the arrow keys. 
 

Action  Shortcut  

Turn Quick Nav on or off  Left Arrow-Right Arrow  

Select the next or previous 
item  

Right Arrow or Left Arrow  

Select the next or previous 
item specified by the rotor  

Up Arrow or Down Arrow  

Select the first or last item  Control-Up Arrow or Control-Down 
Arrow  

Tap an item  Up Arrow-Down Arrow  

Scroll up, down, left, or right  Option-Up Arrow, Option-Down Arrow, 
Option-Left Arrow, or Option-Right 
Arrow  

Adjust the rotor  Up Arrow-Left Arrow or Up Arrow-Right 
Arrow 
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Lesson 9: Applying the VoiceOver Rotor to Safari 

 

 

Outcome 

Compare and contrast navigating webpages using VoiceOver with and without 

the Rotor. 

 

Links to Previous Learning 

Ensure the pupil is confidently able to activate the VoiceOver Rotor and scroll 

through the options.  

 

Preparation 

Identify suitable webpages for the pupil to access. If the pupil preferred using the 

Reader mode, ensure identified webpages have this mode available.  

 

E-Safety 

Ensure that the pupil is able to follow e-safety school guidance in order to 

recognise any inappropriate content and knows how to report concerns. 

 

Key Vocabulary 

VoiceOver Rotor 

 

Activity 

Model applying the Web Rotor to navigate headings on familiar webpages. Ask 

the pupil to apply the Web Rotor to initially locate named headers before locating 

key/named information. Compare this experience to navigating web pages using 

VoiceOver without the Web Rotor and identify when benefits of navigating the 

webpage by locating headers using the Web Rotor. Then challenge the pupil to 

locate key information from unfamiliar webpages, applying Reader and the Web 

Rotor when appropriate. Finally, apply the VoiceOver Rotor in order to navigate 
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results from a familiar search engine using and locate a named Header before 

opening the webpage. 

 

Tailor It! 

• Apply the pupil’s preference in utilising Safari Reader mode from Lesson 3. 

 

Let’s Apply! 

• Extend the pupil to applying the VoiceOver Rotor in Safari to locate links, 

tables, lists, buttons, form controls, text fields, search fields and images 

before navigating these.   

• Extend the pupil to applying the VoiceOver Rotor to navigate text and 

pages i.e. in order to check a spelling (Characters) or a line of text (Line).   

 

Think SMART! 

S – Which ways do you expect the pupil to navigate the webpages i.e. links 

and/or headings when using the Rotor? Do you expect the pupil to identify 

general similarities and differences or related specifically to ease of access? 

M – How many ways do you expect the pupil to demonstrate? How accurate do 

you expect the pupil to be? 

A - What level of scaffolding will the pupil need be able to achieve the outcome 

on this occasion? 

R – Is the pupil able to compare and contrast within this context or will the focus 

be on identifying preference and/or explaining their reasoning why? 

T – Will the pupil be able to have enough experience of navigating webpages 

with and without the Rotor within one lesson or do they need more time to 

complete this task? 

 

 

 

 



 
 

 
 

 

How to use VoiceOver – An Apple Screen Reader 

 

This quick start guide is designed to help you get started using the Apple accessibility feature called 

VoiceOver which is a screen reader. It is highly recommended that you use the VoiceOver Practice 

option to rehearse the Voiceover gestures (finger movements) as the gestures are different than those 

you usually use on an iPad. You will find the instructions on how to do this below. 

 

Step 1: To turn on VoiceOver, go to settings                 , select General on the left-

hand side menu and locate Accessibility from the right-hand side. VoiceOver is 

the first option in the Accessibility menu. To turn this on, tap the button on the 

right of VoiceOver. The button should turn green and a black window will appear 

around the first top left item on your screen called the VoiceOver cursor. 

Alternatively, you can use the VoiceOver shortcut option (please see step 8). To 

turn VoiceOver off, use a double tap gesture. 

 

Step 2: You can adjust the speaking rate by double-tap and holding on Speaking 

Rate while moving your finger to the left (towards the tortoise) to slow down 

VoiceOver or to the right (towards the hare) to speed the speaking rate up. 

 

Step 3: When you turn on VoiceOver, the option VoiceOver Practice will appear 

underneath in blue. You will need to double tap (tap two times) to open 

VoiceOver Practice. Instead of using a double tap gesture, you can also touch 

and hold with one finger whilst tapping with another finger. Once open, you can 

practice the following basic gestures. 

 

Step 4: Touch or drag your finger over the screen and VoiceOver will read each 

item that is touched. VoiceOver always starts at the top left of the screen. You 

can also scroll through all the items by swiping to the left or right with one finger. 

To find a particular item on a screen, triple-tap with two fingers to open Item 

Chooser which will give you a list of all the items on the screen. Then you can 

search for an item in the search field, swipe left or right to move through the list 

alphabetically or touch the right of the screen and scroll through the table index.  

 

Step 5: To choose an item, double-tap with one finger. You can also touch and 

hold and tap with another finger to choose an item (called a split-tap) 



 
 

 
 

Step 6: To move between screens, drag three fingers to the left or right. 

VoiceOver will automatically make a beeping noise to indicate a new screen. By 

swiping three fingers down, Spotlight Search will open at the top of the screen 

which can be used to find any content on the iPad including apps. 

 

Step 7: To scroll up and down on a screen, again use three fingers to swipe up or 

down. It is important to note that in split screens such as those found in Settings, 

you need to tap either the left or right column to indicate which column you 

want VoiceOver to read. 

 

 

Step 8: Instead of having to turn VoiceOver on and off using the VoiceOver menu 

in Settings (see step 1), you can set up a shortcut so that VoiceOver will turn on 

and off when you triple-tap the Home Button. To do this, open Settings, select 

General from the menu on the left-hand column and then Accessibility from the 

right-hand side column. Scroll to the bottom of the Accessibility menu (the right-

hand column) and select Accessibility Shortcut. Now select VoiceOver from the 

right-hand side. Come out of Settings and press the Home Button 3 times. 

VoiceOver will then automatically be activated. Repeat to turn VoiceOver off. 

 

 

 

 

 

 

 

 

 

 

If you have any difficulties in using VoiceOver, please use the following link to find Apple User Guides 

which contain full details of Accessibility Features: 

http://support.apple.com/manuals/ 

Please note that accessibility features on electronic devices are updated regularly and therefore can 

change. This guide is designed to be as universal as possible for Apple devices, but you may find slight 

differences depending on the operating system (or iOS) your device is using.  

Other useful hints include: 

In the VoiceOver menu within Settings, scroll down and choose Large Cursor- This will make the cursor 

bigger and bolder which will make it easier to see for children and young people with functional vision. 

Tap the screen four times with three fingers – This will turn the ‘screen curtain’ on which will make the 

screen appear blank. It is useful for privacy or if the display is not needed. Repeat the gesture to make 

the text appear again. 

Triple-tap with three fingers – This will mute VoiceOver. Repeat to unmute. 

Two-finger swipe up – This will read all items from the top of the screen. 

 

http://support.apple.com/manuals/


 
 

 
 

 

How to use VoiceOver in iBooks     

 

This quick start guide is designed to help you get started using the Apple accessibility feature called 

VoiceOver which is a screen reader in iBooks. This will read the book out loud and can even describe 

pictures if this has been set up when the electronic copy of the book was made. It is highly 

recommended that you are familiar with our VoiceOver guide and use the VoiceOver Practice option to 

rehearse the following steps using gestures (finger movements) before opening iBooks as the gestures 

are different than those you usually use on an iPad. 

 

Step 1: Turn VoiceOver on. This can be done before or after iBooks is open (see 

VoiceOver guide). VoiceOver will automatically begin reading and turning the 

pages. 

 

 

Step 2: To pause VoiceOver, tap on the screen with two fingers. It doesn’t 

matter whereabouts you tap or even if you use one finger from one hand and 

one finger from the other hand. To unpause VoiceOver, tap on the screen with 

two fingers again. 

 

Step 3: If you tap on a line of text with a single finger, it will read the line and                                                                                                                

then stop. 

 

 

 

Step 4: To continue reading from where it stopped, stroke two fingers down the 

screen. Again it doesn’t matter which fingers or used or where on the screen this 

is performed. 

 

 

Step 5: By stroking two fingers towards the top of the screen, VoiceOver will 

read from the top of the screen. 

 



 
 

 
 

Step 6: To move to the next screen, stroke 3 fingers from the right to the left of 

the screen. As long as three fingers are touching the screen, it doesn’t matter 

which ones are used. To move to the previous screen, stroke 3 fingers from the 

left to the right of the screen. 

 

 

 

 

 

 

 

 

 

Now that you are confident with the gestures to use VoiceOver in iBooks, open iBooks and have a try!  

If you have any difficulties in using VoiceOver in iBooks, please use the following link to find Apple User 

Guides which contain full details of Accessibility Features: 

http://support.apple.com/manuals/ 

 

Please note that accessibility features on electronic devices are updated regularly and therefore can 

change. This guide is designed to be as universal as possible for Apple devices, but you may find slight 

differences depending on the operating system (or iOS) your device is using.  

 

 

 

 

Other useful gestures include: 

A single three-finger tap – This will give you any additional information such as whether text is selected. 

A single four-finger tap at the top of the screen  - This will select the first item on the page. 

A single four-finger tap at the bottom of the screen – This will select the last item on the page. 

Tap the screen four times with three fingers – This will turn the ‘screen curtain’ on which will make the 

screen appear blank. Repeat the gesture to make the text appear again. 

http://support.apple.com/manuals/
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Aim 

For pupils with vision impairments to confidently input text and use their voice 

with an iPad to successfully complete a range of tasks required within their 

education setting.  

 

Purpose 

Within education settings, there is often a focus on meeting outcomes by writing 

tasks. For pupils with vision impairments, this can be tiring and it may not reflect 

the pupil’s true ability. By providing pupils with a toolkit of alternative ways of 

producing work, they are enabled to produce work towards lesson outcomes 

using a range of strategies alongside their fully-sighted peers.  

 

Let’s tailor it! - Baseline 

• What can they already do/explain? (Using the Skills Progression Checklist 

for Unit 5, baseline your pupil (B/L) to identify what skills they already have 

in order to progress through this unit.)  

• What do they want to be able to do? 

• What would their parent/carer like/need them to be able to do? 

• What would their teacher like/need them to be able to do? 

 

 

 

 

 

Unit 5 – Alternative Ways of 

Recording 
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5a. Voice-Recording 

 

 

Outcome 

The pupil can use in-built speech-to-text tools on an iPad in order to record their 

work. 

 

Medium-Term Plan 

 

Lesson Outcome Key Skills Key 

Knowledge 

Links to 

Other 

Units 

Lesson 1: 

Developing 

Confidence in 

Voice-

Recording 

Confidently 

engage in 

a recording 

app to 

voice 

record. 

•To hold a 

sentence 

•Record clearly 

•Activate basic 

voice-recording 

apps 

•How and 

when 

voice-

recording 

apps can 

help to 

produce 

work 

Unit 5b 

Lesson 2:  

Applying 

Images to 

Recording 

Apps 

 

The pupil 

can 

demonstrat

e how to 

record 

sequentiall

y using the 

built-in 

camera 

app. 

•Use the camera 

to take clear 

photos of a 

whole 

object/images 

•Import images 

into recording 

apps 

•Record multiple 

sentences in 

succession 

•What 

distance or 

position is 

needed to 

take a 

good photo 

and how 

this 

changes 

depending 

on a range 

of factors 

i.e. size of 

the object 

Unit 3: 

Lesson 3 
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•How and 

when more 

complex 

recording 

apps can 

be used to 

complete 

tasks 

Lesson 3: 

Using 

Dictation 

Orally 

record 

clear 

sentences 

in 

appropriate 

word-

processing 

apps using 

Dictation. 

•Activate 

Dictation 

•Use clear 

sentences 

including 

punctuation to 

record 

•How and 

when 

Dictation 

can help to 

produce 

work 
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Camera App for photos Progression 

Basic Skills Introduce Developing Achieved 

Take a photo 
 

  

Take a panoramic photo 
 

  

take a selfie 
 

  

    

Intermediate Skills    

Photo Options    

Using the flash    

Adjust focus and exposure    

Align your shots    

Adjust the shutter sound volume    

Use the timer    

Zoom in or out    

    

Advanced Skills    

Take Burst Shots    

Take a Live Photo    

Adjust HDR camera settings on iPad    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the In-Built Camera App for Videos Progression 

Basic Skills Introduce Developing Achieved 

Record a video 
 

  

    

Advanced Skills    

Record a slo-mo video    

Capture a time lapse video    

Using the Camera App for photos Progression 

Basic Skills Introduce Developing Achieved 

Take a photo 
 

  

Take a panoramic photo 
 

  

take a selfie 
 

  

    

Intermediate Skills    

Photo Options    

Using the flash    

Adjust focus and exposure    

Align your shots    

Adjust the shutter sound volume    

Use the timer    

Zoom in or out    
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Advanced Skills    

Take Burst Shots    

Take a Live Photo    

Adjust HDR camera settings on iPad    

Editing photos and videos 
 

  

Adjust light and colour 
 

  

Apply filter effects 
 

    

  

Crop, rotate, or flip a photo or video     

Crop manually or to a preset ratio    

Rotate    

Flip    

    

Straighten and adjust perspective    

Mark up a photo    

Trim a video    

View photos and videos    

Share or print photos    

    

Taking photos in Photo Booth    

Take a photo    

Delete a photo    

Share a photo    

Copy a photo    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 
Input text using the onscreen keyboard with 
VoiceOver 

Progression 

Basic Skills Introduce Developing Achieved 

Enter text with onscreen keyboard 
 

  

Standard typing    

Touch typing    

Direct touch typing    

Change typing mode    

    

Intermediate Skills    

Edit text with onscreen keyboard    

Move the insertion point    

Delete a character     

Select text    

Cut/copy/paste    

Undo    

    

Advanced Skills    

Change keyboard settings    

Change Feedback options     

Change Rotor options    

Change Verbosity options    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Input text using Braille screen input Progression 

Basic Skills Introduce Developing Achieved 

Set up Braille Screen Input 
 

  

Turn Braille Screen Input on and off    

    

Advanced Skills    

Supplement iPad keyboard Braille with gestures    

Learn most common gestures (see instructions) 
   

Change Braille Screen Input settings    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 
Notes App Progression 

Basic Skills Introduce Developing Achieved 

Create a note 
 

  

Format a note 
 

    

  

Add a Checklist 
 

  

Add Checklist  
 

  

Add items 
 

  

Increase/decrease indentation 
 

  

Mark an item as complete 
 

  

Re-order an item 
 

  

Manage items in the list 
 

  

    

Intermediate Skills    

Add and edit a table    

Add table    

Enter text    

Move to the next cell or row    

Format a row or column    

Add/Delete/Move a row or column    

See more columns    

Convert table to text    
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Change how Notes is displayed 
 

  

Make the note fill the screen 
 

  

Show lines or grids in Notes 
 

    

  

Draw or write using the Apple Pencil or your finger 
 

  

Draw or write in a note 
 

  

Change colour or tools 
 

  

Adjust the handwriting area 
 

  

    

Advanced Skills    

Select and edit drawings and handwriting    

Use handwritten addresses, phone numbers, dates, and more    

Add attachments to notes    

Add a photo or video    

Draw on a photo attachment    

To save photos and videos taken in Notes to Photos    

    

Scan    

To scan a document into a note using the camera     

Add more pages    

Crop the image 
 

  

Apply a filter 
 

  

Rotate the image 
 

  

Mark up the document 
 

  

Delete the scan 
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Add info from another app to a note  
 

    

  

Lock your notes on iPad 
 

  

Set up your Notes password 
 

  

How to lock a note    

How to open a locked note     
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Microsoft Word app Progression 

Basic Skills Introduce Developing Achieved 

Create a document 
 

  

Be familiar with the Home tab    

Save a document    

Navigate a document    

    

Page layout    

Choose margins    

Choose orientation    

Choose size    

Choose columns    

Choose breaks    

    

Enter text    

Undo and Redo actions    

    

Format text    

Select a word or paragraph    

Change the font    

Change the font size    

Add Bold/Underlining/Italics    
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Add more formatting options    

Highlight text 
 

  

Change font colour 
 

  

Add bullet or numbered lists 
 

  

Indent a paragraph    

Paragraph formatting    

Apply a style    

    

Format text with shortcut bar    

Indent a paragraph (this button may not be present depending on iPad 
model)    

Undo and Redo    

Cut/Copy/Paste    

Predictive text and correction    

Bold/underline/italicise text    

    

Alternative editing options    

Using editing options displayed above word or paragraph    

Using gestures    

    

Print    

Use sharing and sending options    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Microsoft Word app Progression 

Intermediate Skills Introduce Developing Achieved 

Insert Tab 
 

  

Insert page break    

Add a table    

Take a photo/add a photo    

    

Draw Tab    

Draw shapes and objects    

Annotate documents    

Use the eraser    

Switch between the eraser, pencil, pens and highlighters    

Make the pencil/pen/highlighter thicker or thinner    

    

Review Tab    

Proofing Tools    

Smart Lookup    

Word Count     

Read Aloud    

    



 
 

168 
 

View Tab 
 

  

Find and replace 
 

  

Choose between print layout or mobile view    

View document headings    

Use Immersive Reader    

Ruler display    

One page/page width    

Zoom in or out    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Microsoft Word app Progression 

Advanced Skills Introduce Developing Achieved 

Insert Tab 
 

  

Add Shapes/Text Box/Icons 
 

  

Insert Hyperlinks    

Add Comments    

Add Headers and Footers    

Add Page Numbers    

Add Footnotes and Endnotes    

Add mathematical and scientific equations    

    

Draw Tab    

Add more pens/pencils/highlighters    

Rearrange the pens icons in your list    

    

View and Review Tab    

Add or remove comments    

Display for review    

Accept or reject changes made to a document    

Use In-built help    

Install Add-ins    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Microsoft Excel app Progression 

Basic Skills  Introduce Developing Achieved 

Open up App settings 
 

  

Open a saved spreadsheet    

Open spreadsheet/file shared with you    

Open new spreadsheet from Template     

Open new blank spreadsheet    

Save and name a spreadsheet     

Set autosave    

Share a spreadsheet whilst you are working within it    

Share a  spreadsheet from a saved area    

Rename a spreadsheet    

Delete a spreadsheet    

Be familiar with the various interfaces/menus    

Add new sheets    

Rename sheets    

Move sheets    

Duplicate sheets    

Print    
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Data Entry    

Enter text in a cell 
 

  

Undo/Redo 
 

  

Resize rows and columns 
 

  

Identify the context menu    

Cut/Copy/Past/Edit in a cell    

Comment to mark up work     

Use the Speak selection    

Select multiple cells    

Change font type/size/colour    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Microsoft Excel app Progression 

Intermediate Skills Introduce Developing Achieved 

Intermediate Skills - Formatting Cells and Groups of Cells 

 

  

Edit cell borders 

 

  

Merge cells    

Word wrapping    

Formatting numbers e.g. currency, decimal, date/time/percentage    

Insert and delete rows and columns    

Change cell size    

Clearing content in a cell    

Clearing format in a cell    
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iPad Accessibility Skills 
Unit 5 - Alternative ways of recording - Voice Recording and 
Inputting Text 

Using the Microsoft Excel app Progression 

Advanced Skills - Sorting and Filtering Data Introduce Developing Achieved 

Using Autosum 
 

  

Using Average    

Add maths functions using formula and standard spreadsheet functions    

Sort and filter data    

    

Advanced Skills - Inserting Add ons    

Insert a table 
   

Editing a table 
   

Insert a photo    

Editing a photo    

Insert a shape    

Edit a shape    

Insert a text box    

Edit a text box    

Insert an icon    

Edit an icon    

Insert a chart    
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Edit a chart    

Drawing using Apple Pen/finger    

Be familiar with the View Menu    

Use the Search feature    
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Lesson 1: Developing Confidence in                            

Voice-Recording 

 

Outcome 

Confidently engage in a recording app to voice record.  

 

Preparation 

You will need to downloaded apps such as PlayButton or iTalk.  

 

E-Safety  

Discuss gaining consent before taking photos of others. 

 

Key vocabulary 

Record, play, stop 

 

Activity 

Model using a simple recording app i.e. PlayButton, iTalk or the inbuilt camera 
with video function as a tool to record developing ideas which can be played 
back. Develop familiarity with the appropriate recording app and its icons, 
encouraging the pupil to plan what they are going to say before recording 
their ideas using a ‘Think, Say, Record’ technique. The pupil may begin by 
recording words before extending to short sentences etc., developing their 
confidence in recording and hearing their voice. Discuss the purpose of the app 
and when it would be an appropriate alternative/supplement to an adult scribing 
or the pupil writing/brailling. Begin to encourage the pupil to listen and improve 
their sentences to make them clearer.  
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Tailor It! 

• Use images, models, real objects etc. as stimuli.  

• Model sentences for the pupil to record if required. 

• Use VoiceOver to access Playbutton or iTalk in line with their VoiceOver 

skills (see Unit 5b).  

 

Let’s Apply! 

• Provide in-class opportunities to apply the familiar recording app to support 

access.  

• Apply the familiar recording app to support the pupil to hold sentences i.e. 

while they are brailling their sentence.  

• Encourage the pupil to apply their developing recording skills to apps such 

as Doodlecast, Puppet Pals and/or Chatterpix Kids. 

 

Think SMART! 

S – How clear do you expect the pupil to be? What do you expect them to have 

recorded i.e. sentence, word? 

M – How many words or sentences do you expect them to record? On how many 

occasions do you expect them to be clear i.e. meaning is understood?  

A - How much scaffolding does the pupil need to achieve the outcome? 

R – Is the pupil verbal? If so, is their voice intelligible enough that they will be 

able to progress in the unit and eventually use Dictation? 

T – Was the pupil very confident and clear in voice-recording during one lesson 

or do they need more occasions to develop their ability to speak clearly and 

confidently? 

 

 

 

 

 

 



 
 

177 
 

Instructions for Lesson 1: Using the In-Built Camera 
App for Videos 

 

Videos 
 
The iPad's Camera app can also be used to record videos, including slow-motion 
and time-lapse videos.  

Record a video 
 

• Tap on Camera app 

• Choose Video mode. 

• To start recording, tap the Record button (the round red button) or press 
one of the volume buttons. A green dot will appear at the top of the screen 
to show when you are recording. 

• To stop recording, tap the Record button or press the volume button again.  
 
You can change default video recording settings by going to Settings  > 
Camera > Record Video.  
 

Record a Slo-Mo video 
 

• Tap on Camera app 

• Choose Slo-Mo. 

• Tap the record or a volume button to start and then stop recording, in the 
usual way. 

 
You can also opt to have just a part of the video playing in slow motion: 

• Tap the video thumbnail 

• Tap Edit 

• Use the vertical bars below the frame viewer to select the section you want 
in slow motion. 

• You can now change the frame rate (to set the slow-motion effect) and the 
resolution.  

 
To change Slo-mo recording settings, go to Settings  > Camera > Record Slo-
mo. 
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Capture a time-lapse video 
You would use this to capture something that happens slowly over time – a 
Morning Glory flower opening, a sunset, children flooding into school. 

• Go into Camera and choose Time-lapse mode. 

• Set up your iPad to capture the event.  

• Tap the Record button to start recording; tap it again to stop recording. 
 
Some iPad models enable you to adjust Auto FPS settings, which can improve 
the video quality in low light levels. Go to Settings  > Camera > Record Video, 
then do one of the following: 

• On iPad Air (4th generation), tap Auto FPS, then apply Auto FPS to only 
30-fps video or to both 30- and 60-fps video (iPadOS 14.2 or later). 

• On iPad Pro 11-inch and iPad Pro 12.9-inch (3rd generation and later), turn 
on Auto Low Light FPS. 
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Lesson 2: Applying Images to Recording Apps 

 

 

Outcome 

The pupil can demonstrate how to record sequentially using the built-in camera 

app. 

 

Links to Previous Learning 

Continue to encourage the pupil to develop their ability to think, say and then 

record in order to produce oral sentences which are clear and concise before 

listening to them in order to improve them.   

 

Preparation 

You will need to download apps such as My Story for iPad and Videolicious. 

 

E-Safety  

Discuss gaining consent before taking photos of others.  

 

Key Vocabulary 

Record, play, stop, Camera, Photos 

 

Activity 

Using the built-in camera app, discuss the purpose of taking photos as a tool to 
record information. Develop the pupil’s ability to take photos of whole objects 
using the capturing button. Once the pupil is confident with the camera function, 
introduce an app such as ‘My Story for iPad’ or ‘Videolicious’ as a tool to produce 
longer pieces or work which include images. Model completing all the necessary 
steps to produce a recorded piece of work e.g.  a story, instructions, recount etc 
before providing backwards chaining for the pupil to import images into the app 

and record accompanying sentences. 
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Tailor It! 

• Command Siri to take photos and find images. 

• Challenge the pupil to take photos of objects at different distances 

depending upon their level of functional vision. 

• In association with Lesson 3, Unit 3, apply Magnifier when using the 

camera app. 

• Although pupils who are severely sight impaired or have no functional 

vision at all may still enjoy taking photos using VoiceOver, you may like to 

also model using Siri in order to produce Notes (“Create Note” or “Write 

Note”), encouraging the pupil to produce gradually more sentences using 

Siri which are clear. 

• Engage in real experiences i.e. linked to their school curriculum as a 

stimulus such as decorating a cake or planting a bulb. 

• In line with their VoiceOver skills, if appropriate, model how to apply 

VoiceOver to activate the camera. 

 

Let’s Apply! 

• Demonstrate how to copy images from Safari into the camera roll in order 

to use as a stimulus, ensuring that images are accessible for the pupil. 

• Look for opportunities for the pupil to meet outcomes in class by taking 

images and voice-recording as an alternative way to record work. Teachers 

could be encouraged to utilise this strategy with the rest of the class, 

asking the pupil with vision impairment to assist where appropriate. 

• Encourage homework to be produced in this format where appropriate. 

• Demonstrate this lesson to other professionals working with the pupil who 

can also apply familiar recording apps i.e. Habilitation, OT, SALT.    

• Utilise apps such as My Story for iPad as a home-recording tool so that the 

pupil can demonstrate how they successfully completed an additional 

curriculum outcome within the home environment i.e. spread butter on 

toast.   

 

Think SMART! 

S – Which app do you expect the pupil be able to successfully record in? What 

do you expect them to have recorded? What do you expect them to have taken 

photos of? At what distance?  
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M – How many sentences will you expect to be clear and/or linked to the image? 

How many clear images do you expect the pupil to have produced?  

A - How much scaffolding does the pupil need to achieve the outcome? 

R - Is the pupil verbal? If so, is their voice intelligible enough that they will be able 

to progress in the unit and eventually use Dictation? If their voice is not 

intelligible enough, the pupil could focus on their camera skills.  

T - Will the pupil be able to successfully take clear photos of whole objects 

before recording sentences within one lesson or will the activity need to be 

broken down over a number of lessons i.e. the first lesson be focussed on taking 

photos.  
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Instructions for Lesson 2 

 

Taking and editing photos and videos with Camera, Photos and 
Photo Booth 

 

Taking photos 
 

• Tap on the Camera app icon on the Home Screen  

• Alternatively, swipe left on the Lock screen. 
 

Either option will take you directly into Photo mode, which is the basic option for 
taking photos. If you hold the iPad up, you will see the image the lens (on the 
back of your iPad) is capturing. 
 

• Tap the Shutter button, or press either volume button, to take the picture.  
 
The iPad has a variety of different photo options to try, which are accessed via 
the Mode Selector at the bottom right. Depending on your iPad model, these may 
include Video, Slow-Mo, Pano and others. The current option is high-lighted in 
yellow. Flick up or down to see other options, and tap to select.  
 

Taking a panoramic photo 
 

• Select Pano mode from the photo screen.  

• A line with an arrow will appear in the centre of the screen. To take your 
Panorama, press the round white Shutter button and slowly, smoothly 
you’re your iPad around in the direction of the arrow. You can tap the arrow 
if you’d like the pan the opposite way. Vertical panning is also possible by 
turning the iPad 90 degrees to landscape orientation. 

• When you have finished, tap the Shutter button again. 
 

Taking a selfie 
 

• Depending on your iPad model, tap either  or  to switch from the 
rear to the front camera. 

• Hold your iPad in front of you, and tap either the Shutter or a volume button 
to take the picture. 
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You can also take a ‘mirrored’ selfie, which captures the shot as you are seeing it 
in the iPad screen. Do this by going to Settings, tapping on Camera, and then 
turning on Mirror Front Camera or Mirror Front Photos.  
 

Photo options 
 
Using the flash  

To turn the flash on or off on models that support it, tap the flash icon , and 
then choose Auto (for automatic flash), On, or Off. 
 

Adjusting focus and exposure 
These are automatically set by the iPad camera but you can manually adjust 
them in this way:  

• When in the Photo screen, tap on the screen to reveal the automatic focus 
area and exposure setting. 

• Tap where you want to move the focus area. 

• Change exposure (light settings) by dragging the light settings icon  up 
or down to adjust the exposure. 

 
To remove the auto focus and exposure settings for future photos, touch and 
hold the focus area until you see AE/AF Lock. Then tap the screen to Unlock 
settings. 
 

Align your shots 
To display a grid on the camera screen that can help you straighten your shots, 

go to Settings  > Camera, then turn on Grid. 
 

Adjust the shutter sound volume 

• This can be adjusted using the volume buttons on your iPad. 

• Alternatively, when Camera is open, swipe down from the top right of the 
screen to open the Control Centre, then drag the volume icon slider up or 
down. 
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Using the timer 
To set a timer, ensure your iPad is steady and the photo is set up. When ready, 

tap the timer icon , then select your delay: either 3s or 10s. The iPad will 
automatically capture the image at that time. 

 

Zooming in or out  
On all models, you can pinch the screen to zoom in or out.  
Alternatively, drag the slider on the left-hand side of the screen up or down. 
Moving the dial up makes you zoom in, and down, zoom back out again.  
 
 

Advanced photo options 
 

Take Burst shots 
Burst takes multiple high-speed photos so that you have a range of photos to 
choose from.  

• Choose Photo or Square mode. 

• Touch and hold the Shutter button to take rapid-fire photos. The counter 
shows how many shots you took. 

• Lift your finger to stop. 

• To select the photos you want to keep, tap the Burst thumbnail, then tap 
Select. 

• Gray dots below the thumbnails mark the suggested photos to keep. 

• Tap the circle in the lower-right corner of each photo you want to save as 
an individual photo, then tap Done. 

To delete the entire group of Burst photos, tap the thumbnail, then tap . 
 

Take a Live Photo 
On some iPad models, there is the option to take a Live Photo. This is where the 
iPad captures images and audio from just before and after you take your photo 
as well as when you actually press the shutter button. To choose Live Photo: 

• Choose Photo mode 

• Tap  to turn Live Photos on (yellow is on) or off. 

• Tap the Shutter button to take the shot. 
 
In your albums, Live Photos are marked with “Live” in the corner. 
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Adjust HDR camera settings on iPad 
Where available, HDR (High Dynamic Range) takes 3 photos in rapid succession 
and with slightly different settings before merging them together to give you a 
version which is better than its components parts. 
 
The iPad will automatically use HDR when it considers it would be useful but you 
can opt to manually control HDR instead.  

• On some models, you will need to tap on Settings, then Camera, and opt to 
turn OFF Smart HDR. This will then give you the option of tapping HDR ON 
or OFF when on camera screen.  

• On other iPad models, you will be able to tap on HDR on the camera 
screen to turn it on or off.  

By default, the HDR version of the photo is saved in Photos. To keep the non-
HDR version, you will need to opt to Keep Normal Photo within Camera settings.  
 
For other advanced settings not covered here, including advanced Selfie options, 
please see: Take photos with your iPad camera - Apple Support 
 
 

Editing photos and videos 
 
 

The in-built Photos app, reached within Camera, can be used to easily and 
professionally edit photos and videos.  
  
  

Adjust light and colour 
 

• View your photo or video in full screen by tapping on the thumbnail.  

• Tap Edit to reach the edit screen.  
 

There are 3 menus, each represented by icons to the left-hand side of the 
picture. You will go into the first one, Light and Colour menu, automatically. The 
options can be seen down the right-hand side of the picture by flicking up or 
down through the list.  

• Tap on an editing effect such as Brilliance, Highlights or Shadows, and 
drag the slider to adjust the effect. Tap the effect button to see how your 
photo looked before and how it looks after. 

• If you are happy with your changes, tap Done to save and exit. 

• Otherwise tap Cancel and confirm that you want to Discard Changes.  
  
  

https://support.apple.com/en-gb/guide/ipad/ipad99b53a71/ipados
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Apply filter effects 
 

• View your photo or video in full screen by tapping on the thumbnail.  

• Tap Edit to reach the edit screen.  

• Tap on the Filters icon on the left side of the screen to bring up the Filter 
effects menu to the right of the picture. Again, drag the slider to adjust the 
effect. 

• To compare the edited photo to the original, tap the photo. 

• If you are happy with your changes, tap Done to save and exit. 

• Otherwise tap Cancel and confirm that you want to Discard Changes.  
  
  

Crop, rotate, or flip a photo or video 
  

• View your photo or video in full screen by tapping on the thumbnail.  

• Tap Edit to reach the edit screen.  
  
Crop manually: The photo is surrounded by a frame. Drag the corners of the 
frame to enclose the area you want to keep in the photo. Alternatively, you can 
pinch within the photo to make the part you want larger to fit.  
Crop to a preset ratio: Tap the ratio icon at the top of the screen. Options are 
presented along the bottom; tap on your choice.  
Rotate your photo: Tap the rotate photo icon at the top of the screen to rotate 
the photo 90 degrees. You can do this more than once if necessary 
Flip your photo: Tap the flip icon at the top of the screen to flip the image 
horizontally. Tapping this twice will take you back to where you started. 
  
Tap Done to save your edits. Otherwise, tap Cancel and confirm that you wish to 
Discard Changes.  
Straighten and adjust perspective 
 

• Tap a photo or video thumbnail to view it in full screen and then tap Edit at 
the top of the screen to enter the Edit menu. 

• Tap on the Rotation/Crop icon on the left side of the screen, and view the 
Rotation/Crop menu options to the right of the photo. Tap on your selection 
and use the slider to adjust the effect, as previously.  

  
Tap Done to save your edits. Otherwise, tap Cancel and confirm that you wish to 
Discard Changes.  
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Mark up a photo 
 

• Tap a photo or video thumbnail to view it in full screen and then tap Edit at 
the top of the screen to enter the Edit menu. 

• Tap the options icon. 

• Tap Markup. 

• Annotate the photo using the different drawing tools and colours. Tap to 
add shapes, text, or even your signature. 

  
Tape Done to save your edits. Otherwise, tap Cancel and confirm that you wish 
to Discard Changes.  
  

Trim a video 
 

• Open the video, then tap Edit to enter the Edit menu. 

• You will see the video in frame viewer. Drag either end to adjust the length 
of the clip. Tap Done when you are happy.  

• Tap Save Video to save only the trimmed video, or Save Video as New 
Clip to save both versions of the video. 

  
N.B. You can revert to the original image from an edited photo by opening the 
edited image, tapping Edit and then tapping Revert. Choose Revert to Original. 
 

Viewing your photos and videos 
 

• In Camera, tap the thumbnail image below the Shutter button. 

• Swipe right to see the photos you’ve taken recently. 

• Tap the screen to show or hide the controls. 

• Tap All Photos to see all your photos and videos saved in Photos. 
 
 

Sharing or printing your photos 

• While viewing an image, tap the upload icon . 

• Select an option such as Mail, or Messages to share your photo. 

• If your iPad is linked to a printer, you can also swipe up to select Print from 
the list of options. 
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For how to scan a QR code with the iPad camera, see: Scan a QR code with the 
iPad camera - Apple Support 
 
 

Taking photos in Photo Booth 
 
Photo Booth is the ‘fun’ little brother of Camera, and allows you to add funny and 
unusual effects to selfies and photos.  
 

Take a photo 
Aim the iPad at your subject to frame your shot. The screen will show you your 
subject with a different effect in each tile, including Stretch, X-Ray and many, 
many more. The tile in the centre shows you the picture without effects. Simply 
tap the tile to select the effect you like. 
 
Once you have chosen your effect you can switch between rear- and front-facing 
cameras by tapping the reverse camera icon at the bottom right.  
 
To go back and try a different setting, tap on the filters icon on the bottom left of 
the screen.  
  
With some effects e.g. Swirl, you can drag your finger across the screen, or 
pinch, swipe, or rotate the image to alter the appearance. 
Tap the shutter button when you are ready to take the shot. IPad will make a 
shutter sound. To adjust this, use the volume buttons or see Adjust the volume 
on iPad. 
 

Deleting, sharing or copying a photo 
 

Deleting  
Tap the thumbnail of your photo at the bottom of the screen, then tap the Delete 
icon.  
 
Sharing/ copying  
Tap the thumbnail of your photo, tap on the Upload icon (a page with an up-
arrow).  
 
The menu will give you various options for sharing across the top of the menu 
screen: by Airdrop in Message, Mail and others. Tap on your selection and follow 
the instructions.  
 

https://support.apple.com/en-gb/guide/ipad/ipad1be06c51/ipados
https://support.apple.com/en-gb/guide/ipad/ipad1be06c51/ipados
https://support.apple.com/en-gb/guide/ipad/adjust-the-volume-ipad9940e758/14.0/ipados/14.0
https://support.apple.com/en-gb/guide/ipad/adjust-the-volume-ipad9940e758/14.0/ipados/14.0
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You also are given the option to Copy your photo, add it to a shared Album or 
Save to your files. Again, tap on your instructions and indicate where you want 
the photo to be saved or copied to.  
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Lesson 3: Using Dictation 

 

 

Outcome 

Orally record clear sentences in appropriate word-processing apps using 

Dictation. 

 

Preparation 

You will need to ensure a word-processing app or Notes is downloaded onto the 
pupil’s iPad and Dictation is enabled from the Settings menu.  

 

Links to Previous Learning 

Continue to encourage the pupil to develop their ability to think, say and then 
record in order to produce oral sentences which are clear and concise before 
listening to them in order to improve them. 

 

Key vocabulary 

Dictation 

 

Activity 

Introduce the pupil to the Dictation tool, modelling how to use this in order to 

record information within familiar apps. Provide guidance in order to develop the 

pupil’s ability to record information using the Dictation tool. Encourage the 

pupil to plan what they are going to say before recording their ideas and listening 

back to them in order to improve them if appropriate. Encourage the pupil to 

identify when to apply the Dictation tool in order to produce work to alleviate 

visual fatigue.  Then develop the pupil’s ability to use voice commands to initiate 
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dictation functions within enabled word-processing apps, applying formatting and 

punctuation where appropriate. 

Tailor It! 

• Use a word-processing app which will be useful within the classroom 

environment for the pupil. 

• If required, demonstrate how to locate Dictation using the onscreen 

keyboard with VoiceOver (in line with the pupil’s VoiceOver skills).  

• If the pupil uses an external keyboard, demonstrate how to activate and 

deactivate Dictation using this instead. 

• Ensure that dictated words are accessible on the screen for the pupil i.e. 

large enough font, contrast is appropriate etc. 

• Modify the amount of punctuation and/or formatting used when dictating.  

 

Let’s Apply! 

• Look for opportunities for the pupil to dictate their work within the 

classroom and home environment.  

• Practise using the Dictation tool as part of preparation for assessments.   

 

Think SMART! 

S - Which app do you expect the pupil be able to successfully record in? What do 

you expect them to have recorded? 

M - How many sentences will you expect to be clear? How many lessons per 

week would you expect the pupil to utilise Dictation? How many steps do you 

expect the pupil to complete in order to record using Dictation?  

A - How much scaffolding does the pupil need to achieve the outcome? 

R – Is the pupil ready to use the Dictation tool i.e. are their sentences clear and 

they are no longer using filler words such as ‘erm’?  

T – Will the pupil be able to confidently complete all steps to use Dictation 

including all appropriate punctuation and formatting or will the activity need to be 

broken down over more lessons?  
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Instructions for Lesson 3: Using Notes 
 

  

 

The Notes app is used for note-taking, making lists, organising information and 
sketching.  
 

Creating a new note 
 
To create a new note, you can either ask Siri, saying something like “Siri, create 

a new note” or else tap on the Notes icon  
Note that the first line you enter will automatically become the note’s title. To edit 
the title, scroll to the top of the note, then tap Edit. You can also opt for a default 

style for the first line in all new notes, go to Settings > Notes > New Notes Start 
With. 
 

Formatting your note 

• To change the formatting, tap the text icon . 

• You can apply a heading style, bold or italic font, a bulleted or numbered 
list, and more. 

• To save the note, tap Done. 
 

Adding a checklist 

In a note, tap the checklist icon , then do any of the following: 
 
Add items to the list: Enter text, then tap return to enter the next item. 
Increase or decrease the indentation: Swipe right or left on the item. 
Mark an item as complete: Tap the empty circle next to the item to add a 
checkmark. 
Reorder an item: Touch and hold the empty circle or checkmark next to the 
item, then drag the item to a new position in the list. 
 

Manage items in the list:  

• Tap the list to see the menu, tap , then tap Checklist. You have the 
option to check individual items, Check All or Uncheck All, and then either 
Delete Checked or Move Checked to Bottom.  

• To automatically sort checked items to the bottom in all your notes, go to 
Settings  > Notes > Sort Checked Items, then tap Automatically. 
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Add or edit a table 

In a note, tap the table icon , then do any of the following: 
Enter text: Tap a cell, then enter your text. To start another line of text in the 
cell, touch and hold the Shift key and tap next. 
Move to the next cell: Tap next.  
Move to the next row: Tap next at the last cell. 
Format a row or column: Tap a row or column selection handle, then choose a 
style, such as bold, italic, underline, or strikethrough. 
Add or delete a row or column: Tap a row or column selection handle, then 
choose to add or delete. 
Move a row or column: Touch and drag a row or column selection handle to its 
new position.  
See more columns: If the table becomes wider than your screen, swipe right or 
left on the table to see all the columns. 

Convert table to text: tap on a cell in the table and tap . Choose convert to 
Text. 
 

Change how Notes is displayed 
 
Make the note fill the screen:  Turn the iPad to portrait orientation. 

Show lines or grids in notes: tap on the settings icon , tap Lines & Grids, 
then choose a style.  
You can also set a default line/grid by tapping on Settings, tapping on Notes, and 
then tapping on the Lines & Grids menu.  
 

Draw or write using the Apple Pencil or your finger 
 
Use the Notes app to draw a sketch or jot a handwritten note with Apple Pencil or 
your finger. You can draw lines with a ruler, select the colour of the pencil line 
and use a variety of markup tools.  
 

Draw or write in a note 
Start drawing or writing in the note with Apple Pencil. Or to draw or write with 

your finger, tap the pencil icon . 
Do any of the following: 
Change colour or tools: use the markup tools  
Adjust the handwriting area: Drag the resize handle (on the left) up or down. 
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Select and edit drawings and handwriting 
 

With Smart Selection, you can select handwritten text using the same gestures 
you use for typed text. You can move, copy, or delete the selection within the 
note. You can even paste it as typed text in another note or app.  
N.B.  Smart Selection and handwriting transcription require your iPad language 
to be set to English. 

Select drawings or handwriting by tapping the Lasso tool  (between the eraser 
and ruler in the Markup menu) and then using any of the following methods:  
 

• Touch and hold, then drag to expand the selection. Adjust, if necessary by 
dragging the handles.  

• Double-tap to select a word. 

• Triple-tap to select a sentence. 

• Tap the selection, then choose Cut, Copy, Delete, Duplicate, Copy as Text, 
or Insert Space Above. 
 

If you Copy as Text, you can paste the transcribed text in another note or 
another app. 

 

Use handwritten addresses, phone numbers, dates, and more 
A yellow underline appears below handwritten text that’s recognized as a street 
or email address, phone number, date, or other data. Tap the underlined text to 
take action on it. For example, you can see a street address in Maps, compose 
an email, call a phone number, or add a calendar event. 
 

Add attachments to notes on iPad 
In the Notes app, you can attach photos, videos, and scanned documents, or 

information from other apps such as maps and links.  
 
To add a photo or video: tap on the camera icon. Choose a photo or video from 
your photo library, or take a new photo or video. You can change the preview 
size of attachments by touching and holding an attachment, then tapping Small 
Images or Large Images. 
 
To draw on a photo attachment: tap the photo, then tap the pen icon. 
 
To save photos and videos taken in Notes to Photos: tap on Settings, then 
Notes, then turn on Save to Photos. 
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To scan a document into a note using the camera: tap on the camera icon, 
then choose Scan Documents. Position iPad so that the document page appears 
on the screen; iPad automatically captures the page. Otherwise, to manually 
capture the page, tap the shutter button. Alternatively, press a volume button.  
To make changes to the saved document, tap it, then do any of the following: 
 

• Add more pages: tap the ‘add’ icon. 

• Crop the image: Tap the cropping icon . 

• Apply a filter: Tap the colours icon , then choose to scan the page as a 
colour, grayscale, or black-and-white document, or as a photo. 

• Rotate the image: Tap the rotation icon . 

• Mark up the document: Tap , tap the pencil icon, and then use the 
Markup tools.  

• To delete the scan, tap the bin icon.  
 

Add info from another app to a note 
 

• In the other app, open the item you want to share (for example, a map or 
webpage). 

• Tap Share or , then tap Notes. 

• Save the item to a new note or choose an existing note. 
 

Lock your notes on iPad 
 
A single password can be used to password protect any sensitive Notes 
documents on your devices. This could be Face or Touch ID, but you will also 
need a Notes password.  
 

Set up your Notes password 
 

• Tap on Settings 

• Tap on Words and then Password 

• Enter a password and also a hint to help you remember it in case you 
forget because if you reset it, you won’t regain access to your old Notes. 
You can turn on Face- or Touch ID in addition.  

 
If you do need to reset your password, you can do this from Notes > Password > 
Reset Password. 
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How to lock a note 
 

• Open the note, then tap on the Settings icon.  

• Tap Lock. 
You will still be able to see the note’s title in the notes list.  
To remove a lock from a note, tap the Settings icon again and then Remove. 
 

How to open a locked note 
 

• Tap the locked note, then tap View Note. 

• To open the note, use Face ID, Touch ID, or your Notes password. 
N.B. Opening one locked note will temporarily open all your locked notes. 
 
To lock your notes again, either tap the lock icon at the top of the screen, or tap 
lock Now at the bottom of the notes list.  
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Instructions for Lesson 3: Using the Microsoft Word 

App 

 

 

Create a document 

• On the File tab tap on New and then tap on the type of document you want. 

In this example we will select Blank document. 

 

 

 

 

 

 

 

 

 

 

 

• You will be presented with the screen below with the blue toolbar at the 

top.  Tap on the arrow icon which is the first icon on the left on the blue 

toolbar. You will then be given the option to come out of the document and 

either delete the draft or save it. If you choose to save, you will be given 

options of where to save it. Further saving options are explored later.   
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• Once you tap on the screen in order to enter text, you will also see a grey 

shortcut bar in the middle of the screen. The onscreen keyboard will be 

underneath. 

 

 

 

 

 

 

 

 

 

Home tab  

• The home tab on the blue toolbar allows you to choose the text formatting 

options. With a word or paragraph selected you can choose an option. The 

tab below is in Office 365. 

 

 

 

The Home tab may look like the one below depending on what version of 

Office is used. 

 

 
 

 

Saving a document 

• It is a good idea to save a document as soon as you create it. Saving early 

can prevent work from being lost. 
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• In the top right corner on the blue toolbar there is an icon with three dots.  

 

 

Or the icon may be on the left of the toolbar and a picture of a page with 

three dots depending on the version of Office being used. 

 

 

Tap on this and you will see the save button as shown below. 

 

• Tap on Save, give the document a name and save in your chosen location.  

• If you go back into this menu above, you can now choose whether you 

want Autosave turned on or not. It is recommended that this is turned on. 

 

Navigating a document 

• Navigate by swiping the page up or down. 

• To adjust the zoom level just pinch to zoom. 

 

Page Layout 

• In order to set the document up, go to Layout on the blue toolbar. The 

Layout tab is used to make changes to the layout of a page. Within the 

Layout tab choose one of the options e.g., Margins, Orientation, Size, 

Columns or Breaks and then scroll down to choose. 
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• Choose the margins 

 

 

• Choose orientation e.g., portrait or landscape. 

 
 

 

• Choose size e.g. A4, A3 etc 
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• Choose columns e.g., full page width etc. 

 

 

 

• Choose breaks e.g., page break. 

 

 

 

Enter text 

• To enter text just tap on the page and begin typing. 

• If you make a mistake or you want to undo your last action, you can tap the 

Undo button which looks like a curved arrow pointing backwards. It is the 

second icon from the left on the blue toolbar. 

• The Redo button is like a reset button and looks like a curved arrow 

pointing forwards. It is the third icon from the left on the blue toolbar. 

• See diagram below for the Undo and Redo buttons: 
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• There are more options to Undo and Redo actions which are outlined later 

in this instruction guide.  

 

 

Format text 

• You will use the Home tab for all text formatting options. 

 

 

 

• Select a word or paragraph - double tap on a word to select that word. If 

you triple tap it will select the paragraph (to unselect tap once anywhere on 

the screen). Another way to select is double tap on a word and you will see 

a blue circle on the top left and bottom right of that selection. You can tap, 

hold and drag the blue circles to make the exact selection you need.  

 

 

 

 

• Change the font - select some text and tap on font name box. Scroll down 

to choose your font. Office compatible fonts are listed at the top and if you 

scroll down to the bottom you will find iOS fonts as well. 
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• Change the font size - tap on the number and either scroll down for pre-set 

font sizes or use the + and – icons to change. 

 

 

 

• Add bold, underlining or italics - select some text and then tap the 

appropriate icon to apply the formatting. 

 

 

 

• More formatting options - add formatting such as strikethrough, subscript 

etc. 
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Here you can choose a WordArt style for a title or heading. Select the 

word/words and then select a WordArt style. 

      

 

• Highlight text - select some text, tap the highlight icon, and then choose a 

highlight colour. 

 
 

 

• Change the font colour - tap the font colour icon and then choose a colour. 
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• Add bullet or numbered lists – tap the text and then tap the bullet or the 

numbered list icon. 

 
 

 

• Indent a paragraph - tap the text, and then tap the indent icon to move the 

text to the right. Tap the negative indent icon to move the text to the left. 

 

 

• Paragraph formatting – align text, change line spacing etc. 

 

 

• Apply a style - to select a text style, tap the style icon, and then select from 

the list of defined styles. This could be applied to headings. 
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Format text with Shortcut bar 

 

• Shortcut bar – this is the strip above the onscreen keyboard. 

 

 

 

 

Some models may have an indent button which is the first button on the left 
in the diagram below.  

 

 

 

• Undo and Redo buttons – this is another option for carrying out the Undo 

and Redo actions. Tap the Undo button (left button below) to undo typing/ 

action since the last saved. Tap the Redo button (right button below) to 

bring back what you have deleted. 

 

 

 

• Paste button - place the text cursor where you want to paste and tap the 

paste button. 

 

 

• Cut text – select text you want to cut and tap the cut button. This is the 

scissors icon. The Undo button changes to Scissors when you select text. 

 

 

 

 

• Copy text – select text you want to copy and tap the copy icon.  
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• Paste text – place the text cursor where you want to paste (as explained 

above). 

 

• Predictive text and text correction – three words in the middle of the 

shortcut bar which will change based on what you are typing. 

 

• Bold, underline or italicise text – These are found on the right-hand side of 

the strip in the shortcut bar.  

 

 

Alternative editing options 

• You can cut/copy/paste by selecting a word or paragraph to display editing 

options above that word or paragraph (in black and white). Then tap on the 

option required. 
 

 
 

 

• Another way to edit is by using gestures as outlined below: 

 

 Copy, cut and paste  

Make your selection  

Pinch with three fingers to copy it 

Repeat the copy gesture twice to cut it (pinch with three fingers, 

twice) 

Reverse the copy gesture to paste (place three fingers on the screen 

and spread them apart) 
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 Swipe and tap to undo and redo 

Double-tap with three fingers to undo 

Swipe left with three fingers to undo 

Swipe right with three fingers to redo 

 

 Drag to move the cursor  

Moving the cursor works the way it always did. But you can now tap and 

hold the cursor until it gets bigger, and then move it around the screen and 

drop it wherever you like.  

 

Print 

• You can print the document by clicking on the three dots at the end of the 

blue toolbar (on the right) and scrolling down to ‘Print’. 

• From here you can choose whether you are going to use an AirPrint 

compatible printer or print using an app from the app store which allows 

you to print to any wireless printer. 
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Sharing and sending options   

• The ‘Share’ icon is in the top right-hand corner on the blue toolbar, next to 

the three dots (to the left of it). It is an arrow inside a square. This allows 

you to invite people to edit the document once you have saved it. 

• Sharing options can also be found in the icon at the end (three dots), where 

you also choose your saving options. 

• You can send to other people by pressing ‘Send a copy’. You can then 

email with Outlook or send with another app. 

• You can export to ODT format or PDF. 
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Insert 

• The Insert tab on the blue toolbar allows you to insert e.g., pages, tables, 

photos etc. 

 

 

• Page – You can add a page break at any time by tapping the first icon 

‘Page’ on the Insert tab 

 

• Table – add a table by tapping the ‘Table’ icon on the Insert tab. 

A new table will appear as shown below. A new tab has also appeared on 

the blue toolbar which is the ‘Table’ icon. 

 

Now you can edit the table by choosing an option e.g., ‘Delete’ to delete a 

row, column or table, ‘Insert’ to add a row or column, ‘Merge’ to merge or 

split cells, ‘Style Options’, ‘Shading’ etc. 

 

• Photo and Camera – add a photo from your photos or albums. Take a 

photo with the Camera icon and add to your document. You can then edit 

this photo as required. 

 

 

 

• Shapes, Text Box and Icons- add these from the selection given. Scroll 

down to select. 
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• Hyperlinks – You can insert a hyperlink by choosing the hyperlink icon 

which is to the right of ‘Icons’. You can also link a word to a website by 

double tapping the word to select it and choosing the hyperlink icon. You 

can then add the address of the website you want it to link to and click 

Done.  

 

 

 

 

• Comments – choose the ‘Comments’ icon to add a comment. This is next 

to the hyperlinks icon, on the right of When you add a comment, a 

comment icon appears on the right-hand side of the page. This is useful 

when someone else is commenting on your document. You can reply to the 

comments and this allows you to have a discussion. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

212 
 

• Headers, Footers – Choose and edit headers and footers as required. 

 

 

 

 

• Page Numbers – This allows us to insert a page number. This is next to the 

‘Header and Footer’ icon, on the right. You can choose where you want this 

on the screen. The ‘Format page numbers’ allows you to edit the style or 

choose a letter or a roman numeral. You can also include a page count. If 

you want to remove page numbers, then scroll down to ‘Remove Page 

Numbers’ which is underneath ‘Include Page Count’. 

 

 

 

 

• Footnotes and Endnotes – These are next to the ‘Page Numbers’ icon on 

the right. Add footnotes (left icon) and endnotes (right icon) as required. 

 

• Equation – useful for writing scientific or mathematical equations.  
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Draw 

• The Draw tab on the blue toolbar allows you to add notes, create shapes, 

edit text and more. 

 

 

• If you are using an iPad Pro (either a 12.9" or the new 9.7" version) and if 
you have an Office 365 account, you can just start drawing. Start drawing 
on a document using an Apple Pencil and the Word app instantly starts 
applying digital ink to your document and switches to the Draw tab (see 
also, instructions on using an Apple Pencil). Draw shapes, objects and 
annotate documents as required. 

 

• If you want to use your Apple Pencil to select items on the page, you need 
to select the first option ‘Select Objects’. You can then use your Apple 
Pencil to navigate around the document and make selections.   

 

• If you are reading a document and you want to make a note in the margin, 
just make the note with the Pencil.  If you do not have an Apple pencil, you 
can draw using touch. Select ‘Draw with Touch’ as shown above. 

 

• Using the Draw tab, you can switch between an eraser, three pens, a 
pencil and two highlighters. Once a pen/pencil/highlighter has been 
selected, you have a few different formatting options including the size of 
the pen and it’s colour. There are also a few different texture-based options 
to choose from. You can tap the plus or minus sign to make it thicker or 
thinner.  
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• The + icon is at the end of the pens list. If you tap on this, you can add a 
pencil, pen or highlighter. This is useful if you frequently need to use 
different types of pen within one document. Your custom pens icons can be 
re-arranged. Just tap and hold one of your pens/pencils/highlighters from 
your list and drag to the desired position. 

 

Review   

• The Review tab allows you to make general adjustments to the document  

 

 

 

• Proofing tools – this is the first icon which is for spell checking. You can 

choose a proofing language from the first option. You can also turn off the 

spellcheck as required. 
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• Smart Lookup – This is the second icon to the right of ‘Proofing Tools’. 

Select some text and tap on Smart Lookup. This runs a search on 

Wikipedia and other websites for the word selected. 
 

 
 

There are two tabs near the top right corner. These are Explore and 

Define. Define acts as a dictionary. 

 

 

 

 

 

 

 

 

 

 

• Word Count – This is the third icon along. It allows you to view the page 

count and the word count. You can toggle whether you want the word 

count to be shown by default. When you scroll through the document the 

page count and word count will automatically appear at the bottom.  
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• Read Aloud – This is the fourth icon along (shaded below). 

 

 

This is available in Office 2019 and Office 365. Select Read Aloud and go 

to the controls in the bottom right corner. Here you will find Play, Pause 

and Stop which is the cross. You can also move from one paragraph to 

another by selecting Previous and Next. The volume can be controlled in 

the settings icon which has a loudspeaker attached to it.  

 

• Add or remove comments – These are the next few icons after ‘Read 

Aloud’. If you are working collaboratively or editing a document for 

somebody else, you can turn on ‘Track Changes’.  

 

• Display for Review – this allows you to change what you see. So, you can 

see all of the Markup, no Markup or the original. If you select ‘Show 

Markup’ you can change what elements of the Markup you want to see 

e.g., insertions or formatting changes. 



 
 

217 
 

   

 

• Once you have received a document that has had changes made, the last 
few icons after Display Review allow you to approve them or not. 

 

 

 

 

 

 

                                                           

 

 

 

View  

• The View tab allows you to choose how you view the document. 

 
 

 

• Find and Replace – in the top right of the blue toolbar, there is a magnifying 

glass icon. This is the third icon along the bar (in between the ‘lightbulb’ 
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picture and the ‘Share’ icon). If you tap on this, you can search for text 

within the document. 

 

 

The settings icon to the left of this allows you to find and replace. 

 

 

• Print Layout or Mobile View – You can choose between looking at the print 

layout or the mobile view. You can access the mobile view by either 

pressing the ‘Mobile View’ icon underneath the blue toolbar or by tapping 

on the first icon in the top right corner (next to the lightbulb picture) on the 

blue toolbar. 
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• Document Headings – lists document headings once you have applied a 

headings style.  

  

 

• Immersive Reader – turn on Immersive reader and you will be presented 

with the following screen.  

 
 

You can now change the page colour, the text spacing or have the 

document ‘Read Aloud’ to you (see Review section for ‘Read Aloud’ 

instructions). Immersive Reader is also available in Microsoft Lens (see 

Accessing Text – OCR and MS Lens instructions). 

 

 

• Ruler – You can choose whether you want to see the ruler displayed at the 

top. 

 

 



 
 

220 
 

• One Page/Page Width – you can choose whether you want to see an entire 

page on the screen or fit to width.  

Entire page – tap on ‘One Page’. 

 
 

Fit to width – tap on ‘Page Width’. 

 

 

• Zoom in/Zoom Out – zoom in and out on your word document by tapping 

on the ‘Zoom In’ or ‘Zoom Out’ icons. 

 

• In-built help - the fourth icon in, in the top right corner on the blue toolbar, is 

a picture of a lightbulb. If you are unsure where to find a particular function, 

you can type what you want it to do here. 
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• Add-ins - you can install add-ins into Microsoft Word from a limited 

selection. Go to the Insert tab and tap on the last icon. You can see which 

ones you recently installed (My Add-ins) or see all of the available options 

(See all). 
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5b. Inputting Text 

 

Outcome 

The pupil can increase text to their preferred size within appropriate apps before 

producing text in a range of word-processing and PDF writer apps.  

 

Medium-Term Plan  

Lesson Outcome Key Skills Key 

Knowledge 

Links to 

Other Units 

Lesson 4: 

Typing 

The pupil can 

produce mixed 

sentences by 

typing digits, 

letters and 

symbols which 

have been 

increased in size 

(if appropriate) into 

word-processing 

apps.  

•Type using 

digits, letters 

and symbols 

•Use a word-

processing 

app 

•Develop 

speed and 

accuracy in 

typing 

•How to use a 

keyboard to 

record 

•How to 

navigate 

between 

different 

keyboards 

•Which 

computer font 

size suits their 

needs 

 

Lesson 5: 

Completing 

work in a 

PDF 

The pupil can 
complete fields of 
a document in a 
PDF writer app 
which they have 
scanned.  

•Use 

scanning apps 

•Upload 

scanned 

images to a 

PDF writer 

app 

•Use a PDF 

writer app 

•Understand  

 the purpose of 

scanning apps 

•Understand  

 the purpose of 

PDF writer 

apps 

•How to utilise 

PDF and 

scanning 

apps to 

complete 

work more 

quickly and 

easily 

Unit 5a, 

Lesson 2 
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Lesson 4: Typing  

 

Outcome 

The pupil can produce mixed sentences by typing digits, letters and symbols 

which have been increased in size (if appropriate) into word-processing apps.  

 

Preparation 

You will need to ensure a word-processing app is downloaded onto the pupil’s 
iPad. 

 

Key vocabulary 

Type 

 

Activity 

Introduce the Notes app, modelling how to locate the onscreen keyboard. 
Encourage the pupil to type familiar words with increasing confidence and speed. 
Extend this to switching between the QWERKY keyboard to symbols in order 
to record digits and calculations. Discuss when the onscreen keyboard would be 
a useful tool to use to record work in class, role-playing scenarios when the pupil 
could use this as an alternative to recording with a pen and paper. Discuss the 
advantages of using the iPad in landscape (the keyboard is larger). Challenge 
the pupil to produce mixed sentences using symbols, digits and letters. Once the 
pupil is confident in using Notes, introduce using the keyboard in a word-
processing app i.e. Pages, providing guidance in order to locate the size drop-
down menu and increase the font size. Continue to increase confidence and 
speed in typing words, symbols and digits using the built-in keyboard.  

 

Tailor It! 

• Compare recording by typing using the onscreen keyboard with the use of 

a 3rd party online keyboard. 
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• Compare recording by typing using the onscreen keyboard with the use of 

an external keyboard. 

• Ensure the expectations match the pupil’s current literacy and numeracy 

skills i.e. you would not expect them to type a divide sign if they don’t 

recognise it or understand the concept of this yet.  

• Apply VoiceOver using the onscreen keyboard to locate letter keys. 

• Turn VoiceOver on when using an external keyboard so that keys pressed 

are read out. 

• Explore the keyboard options within the Settings menu to tailor the setup 

i.e. removing predictive text or use a split keyboard. 

• Link the pupil’s developing typing skills to typing apps specifically designed 

for pupils with vision impairment i.e. Doorway Online. 

• Apply Follow Focus from the Zoom Accessibility menu. 

• Ensure that text adjustment within a word-processing app is visually 

accessible to the pupil or they can apply accessibility options such as 

Zoom or VoiceOver to adjust these.  

 

Let’s Apply! 

• Apply developing on-screen typing skills to record using word-processing 

apps which reflect in-class practise i.e. Word, ensuring that pupil is 

confident in increasing the font size to meet their individual needs. 

• Extend to a range of other apps i.e. Excel. 

• Encourage application of typing skills within the classroom and home 

environment.  

• Continue to provide opportunities to develop speed and accuracy in typing.  

• In line with Lesson 2, Unit 5, demonstrate how to insert images. 

 

 

Think SMART! 

S - Which app do you expect the pupil be able to successfully type in? What do 

you expect them to have typed? Will they be expected to type letters, words, 

digits and/or symbols? 

M – How accurate do you expect the pupil to be? How fast do you expect them 

to type? 

A - How much scaffolding does the pupil need to achieve the outcome? 
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R – How confident is the pupil with letter recognition and word-building? Do their 

typing skills need to be tied into their phonics? 

T – Will the pupil be confidently able to locate and produce letters, symbols and 

digits before typing and enlarging text in one lesson or will they need to be 

gradually introduced? 
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Instructions for Lesson 4: Inputting Text Using the 

Onscreen Keyboard with VoiceOver 

 

   

   

VoiceOver changes how you use the onscreen keyboard when you activate an 
editable text field. You can enter, select, and delete text; change the keyboard 

language; and more.  
  
Enter text with the onscreen keyboard  
 Select a text field, then double-tap to bring up the insertion point and onscreen 
keyboard.   
  
There are 3 different ways to enter text:   
  
Standard typing (default): Select a key on the keyboard by swiping left or right, 
then double-tap to enter the character. VoiceOver speaks the key when it’s 
selected, and again when the character is entered. Users can also select a 
random letter on the keyboard and swipe right or left until they get the letter they 
are looking for; layout is as the onscreen keyboard e.g. swipe to the right to get 
from E to Y.  
  
Touch-typing: Touch a key on the keyboard to select it, then lift your finger to 
enter the character. If you touch the wrong key, slide your finger to the key you 
want (VoiceOver will speak the character for each key you touch) but don’t take 
your finger off the screen until you have found the one you want.   
  
Direct Touch-typing: VoiceOver is disabled for the keyboard only, so you can 
type just as you do when VoiceOver is off.  
  
A final option is to use the dictation option on the onscreen keyboard, a key 
that is located to the left of the space bar. VoiceOver users have a useful short-
cut to start and stop dictation: a 2-finger double tap on the keyboard. Start 
dictating when you hear the beep.   
  
Change typing mode 
Select the Typing Mode option on the Rotor, flicking up or down with 1 finger to 
move between them.   
 
Alternatively, select Settings, then Accessibility, then VoiceOver, then Typing and 
finally to Typing Style to choose a typing mode.    
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Edit text with the onscreen keyboard  
  
To move the insertion point 
Use the rotor to choose whether to move by character, word or line, and the 
swipe up or down to move forward or backward in the text. VoiceOver makes a 
sound when the insertion point moves, and speaks the character, word, or line 
that the insertion point moves across.   
 
Double-tap the text to move to the beginning or the end.  
  
To delete a character 
Use the backspace key on the onscreen keyboard.   
  
To select text 
With Text Selection enabled within the Rotor menu, set the rotor to Text 
Selection, swipe up or down to choose Character, Word, Line, or Sentence, then 
swipe left or right to move backward or forward.   
  
Alternatively, set the rotor to Edit, swipe up or down to choose Select or Select 
All, then double-tap. If you choose Select, the word closest to the insertion point 
is selected when you double-tap. To increase or decrease the selection, do a 
two-finger scrub (quick move 2 fingers to make a ‘z’ shape) to dismiss the pop-up 
menu, then zoom out or pinch in to make the selection larger or smaller.  
  
Cut, copy, or paste 

Set the rotor to Edit, select the text, swipe up or down to choose Cut, Copy, or 
Paste, then double-tap.  
  
Fix typos 
Set the rotor to Misspelled Words, then swipe up or down to jump to the previous 
or next misspelled word. Swipe left or right to choose a suggested replacement, 
then double-tap to use the replacement.  
  
Undo 
Shake iPad, swipe left or right to choose the action to undo, then double-tap.  
  
Change the keyboard settings  
Keyboard settings can be changed by:  

• select Settings  

• select Accessibility  

• select VoiceOver   

• select Typing  
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Options include:  
Phonetic Feedback: you can choose to have text spoken character by 
character, or even character followed by its phonetic equivalent—for example, B 
and then Bravo.  
Typing Feedback: Choose to speak characters, words, both, or nothing.  
Rotor: Select the settings you want to include in the rotor.  
Verbosity: Tap Deleting Text. To have VoiceOver speak deleted characters in a 
lower pitch, tap Change Pitch.   
 

Inputting text using Braille Screen Input  

   

If you turn on Braille Screen Input, you can use your fingers to enter six-dot 
braille or contracted braille directly on the iPad screen, without a physical braille 

keyboard.  
  
Setting up Braille Screen Input  
 Add Braille Screen Input to the rotor menu by doing the following:  

• Select Settings  

• Select Accessibility  

• Select VoiceOver  

• Select Rotor  

• Select Braille Screen Input to select it from the list.  
 
Turning Braille Screen Input ON and OFF  
Use the Rotor to go to Braille Screen Input  
  
Each time, it will give you two options for holding the iPad when inputting Braille:  
Tabletop mode: in this, the iPad sits flat on the table in front of you, and your 
fingers sit on the screen in the usual 6-key format.  
Screen-away mode: holding the iPad up in front of you, turn it around so that 
the right side is on the left side and the back of the iPad is facing you. Your 
fingers will then sit vertically each side of the iPad with dot 1 at top left and dot 6 
at bottom right.   
  
Enter braille characters by tapping the screen with one or more fingers at the 
same time. As you tap, hold and then release the dots, iPad will read your 
letters.   
Tip: To have iPad read dots aloud, tap and hold the dots, then when you hear the 
timer tones and announcement, release the dots.  
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If the dots are not in your natural finger positions, double-tap each dot in turn to 
‘reset’ their position.   
  
To exit Braille Screen Input, do a two-finger scrub (move two fingers back and 
forth three times quickly, making a “z”), or adjust the rotor to another setting.  
  
Supplementing iPad Keyboard Braille with gestures  
  
Keyboard Braille entry on the iPad does not imitate all aspects of a Braille 
keyboard, and you will need to supplement your Braille with a number of 
gestures which will be spoken by VoiceOver. The most common are here:  
  

Action Gesture 

Enter a space  Swipe right with 1 finger; in 
screen away mode, swipe 
to your right  

Delete the previous character  Swipe left with 1 finger  

Move to a new line  Swipe right with 2 fingers  

Cycle through spelling suggestions  Swipe up or down with 1 finger  

Enter a carriage return, or send a 
message (in Messages)  

Swipe up with 3 fingers  

Switch between six-dot braille and 
contracted braille  

Swipe right with 3 fingers  

Turn braille contractions on or off  Swipe right with 3 fingers  

Translate immediately (when 
contractions are enabled)  

Swipe down with 2 fingers  

Switch to the next keyboard  Swipe up with 2 fingers  

  
Change Braille Screen Input settings  
This can be done at the Braille Screen Input menu.  

• Select on Settings  

• Select Accessibility  

• Select VoiceOver  

• Select Braille  

• Select Braille Screen Input  
  
The following options are available:   

• uncontracted 6-dot Braille  

• uncontracted 8-dot Braille  

• contracted Braille  

• reverse dot positions, which swaps dots 1 and 3 with dots 4 and 6 in both 
6- and 8-dot Braille.  
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Instructions for Lesson 4: Using the Microsoft Excel App 

 

 

App Settings 

1. From home screen menu tap cog icon  (bottom left) 

 

2. Choose a setting to change from the settings pop up menu 
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Open a saved file (workbook) 

 

Opening an existing file from the Excel App Home screen 

1. Option A - Choose Recent 

 

2. Option B - Tap folder icon and navigate through folders to find the existing 

file 

 

 

 

Open a file someone shared with you 

File shares can arrive by email or as pop up notifications on your iPad. When you 

tap on the link in your notification or your email it will open the excel app and the 

shared document.  
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Open a new file from a template 

 

 

1. Tap the + icon (this is a plus sign in a circle) 

2. The screen presents a wide range of templates to choose from 

3. Tap the one you want to use 

 

Open a blank/new workbook 

1. Tap the + icon (this is a plus sign in a circle) 

2. The screen presents a wide range of templates to choose from 

3. Tap the top left thumbnail which should be called Blank workbook 

 

Save a workbook 

 

1. While your document is open, tap the ellipsis icon (three dots) on the top 

right-hand corner of the excel top bar menu   

 

2. Tap the save button 
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3. Name your file e.g. “Myworkbook” 

 

 

4. Close the keyboard by tapping the bottom keyboard icon on the keyboard 

pad 
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5. Select where to save, e.g. My Documents 

 

6. Tap the word ‘save’ top right of the pop up window 

 

 

7.  “auto-save” is now on by default for new documents, repeat the first step 

(tap the ellipsis dots icon to check this) 
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Sharing workbooks 

 

Share while working in the workbook/sheet 

1. From top menu on the right, tap the share icon (box like share with an 

arrow)  

2. You then have the options to “Invite People”, “Copy Link” to paste in 

another message or to “Send a Copy”  

3. You will need the email address of where/who you would like to share with. 

 

 

 

Share a workbook from a folder or list of files 

1. In a folder or list view each file has icons on the right hand side of the list 

2. Tap the share icon (box like share with an arrow)  

3. You then have the options to “Invite People”, “Copy Link” to paste in 

another message or to “Send a Copy” 
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Rename a file 

 

 

1. From a list of files (such as Recent or a folder view) tap the ellipsis (three 

dots icon)  

2. Tap rename 

 

3. Select the name of the file in the pop up screen 

 

4. Rename using the keypad 
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5. Tap the word Rename to finish (top right corner or pop up) 

 

 

6. View renamed file in the original list of files 

 

 

Delete a file 
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1. From a list of files (such as Recent or a folder view) tap the ellipsis (three 

dots icon) on the same row as the file you want to delete  

2. Tap delete 

 

3. From the confirmation pop up tap delete again 

 

4. View the list with the file now gone 

 

 

Interfaces/menus 

 

Main menu and Top Bars 
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View Bar 

 

Review Bar 

 

Data Bar 

 

 

Formulas Bar 

 

 

Draw Bar 

 

 

Insert Bar 

 

Home Bar 

 

 

Sheet Tabs via Bottom Bar  
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Add new sheet 

 

1. From the Sheets Tab Bar (bottom of screen) 

 

2. Tap the + symbol on the rightmost side of the Sheets Tab Bar at the 

bottom of the screen 

 
3. Optionally name your new sheet 

 

 

4. The new sheet is now successfully added to the Sheets Tab Bar 

 

Moving Sheets 

 

 

1. Tap and hold (i.e. long tap) the sheet tab name you wish to move at the 

Sheets Tab Bar at the bottom of the screen. 
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2. Tap Move  from the menu which pops over the Tab Bar 

 

3. From the move menu, tap where you want to move the selected sheet. In 

this example we select to (move to end) . 

 

 

 

 

 

Duplicate Sheets 

 

1. Tap and hold (i.e. long tap) the sheet tab to move at the Sheets Tab Bar at 

the bottom of the screen 

 

2. Select Duplicate  from the menu which pops over the Tab 

Bar 

 

3. Check the duplicate sheet is now successfully added to the Sheets Tab Bar 
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 Excel has called in Sheet1(2).  This 

means the sheet is a second copy. Duplicating a sheet will make a copy of all 

data and formula. 

 

 

Print 

1. From the top bar tap the ellipsis (three dots) on the right side of the screen 

 

 

2. From the drop down menu Select Print 

 

 

 

3. Choose the printer option you recognize.  You can choose whether you are 

going to use an AirPrint compatible printer or print using an app from the 

app store which allows you to print to any wireless printer. 

 

Data Entry 

 

1. Select cells by tapping on the cell you want to use. 

2. Choose edit from the inline menu 

3. Key in data using the keypad 
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Undo/Redo 

 

1. From the KeyPad or 

 

2. From the Top Bar   

 

3. To Undo tap the Back Arrow and  

4. To Redo tap the forward arrow.  

 

 

Resizing Rows and Columns 

 

Resize a column (visually) 

1. Tap on the column letter until a double vertical line icon  appears 

 

 

 

 

 

2. Tap and hold while moving this icon will increase or decrease the column 

width 

 

Resize a row (visually) 

 

 



 
 

244 
 

1. Tap on the row number until a double horizontal line icon appears  

2. Tap and hold the double lines icon while sliding your finger down or up will 

increase or decrease the row height 

 

  Context Menu 

 

Tap and hold a cell to get the context menu 

 

 

 

Cut 

1. Tap and hold a cell to get the context menu 

2. Tap cut.  This removes the contents of the cell and at the same time copies 

the contents to memory (known as the pasteboard).  

 

Copy 

1. Tap and hold a cell (or range of cells) to get the context menu 

2. Tap copy which copies the contents of the cell(s) to memory (known as the 

pasteboard) 
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Paste 

 

1. Tap and hold a cell to get the context menu 

 

 

 

2. Tap paste to insert the copied content from memory (the pasteboard) 

 

 

Pasting a Copy of One or More Cells 

 

Tip: Make sure the worksheet has enough clear space to hold the data you want 

to copy 
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1. Select the range of cells you wish to make a copy of 

 

2. Select a start cell with enough space below and to the right to hold the 

copied data 

3. Hold and tap the cell until the context menu appears 

4. Tap paste 

 

 

5. The result is a copy of your data in another part of your workbook or 

worksheet 

 

6. Excel will copy everything (styles, content and formula) when you simple 

use “Paste” 

7. Use “Paste Special...”  to decide or limit what gets pasted 

 

Edit 

 

1. Tap and hold a cell to get the context menu 
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2. Select Edit, this will highlight and activate the keypad  

 

3. Edit the contents of the cell  

 

4. In the case of editing a cell with a formula, pay attention to the content of 

the formula bar 

 

 

 

Comment 

 

Comments are an opportunity to mark up your work and give more information 

about the content of a cell or range of cells 

 

1. Tap and hold a cell to get the context menu 
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2. Tap Comment 

3. From the comment box enter your text to add a comment which will relate 

to this cell 

 

4. Add your comment (if you shared your worksheet already) -the other 

user(s) may be alerted to your comment  
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5. You can add emoticons (if your organisation or school allows) 

 

 

6. The “thread” (conversation or exchange of comments can optionally be 

“resolved” or “deleted”) to do this tap the ellipsis (three dots icon) on the top 

right-hand corner of the comments panel  
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Speak 

 

1. Tap and hold a cell to get the context menu 

2. The cell must have content  

3. When the cell has content the context menu is extended with a Speak 

option 

4. Tap Speak and if your volume is on, Voice Over will read out the contents 

 

 

Selecting a Range of Cells 

 

1. Select a cell until it is highlighted with a small circle (dot) on the top left 

corner and another on the bottom right corner.  
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2. By holding and dragging either of these dots you can increase the 

highlighted area 

 

3. The highlighted area is a range of cells.  

4. You can now work with this range  

5. Tap hold the area to get the context menu for actions like, copy, cut and 

delete 

 

6. Exercise:  

a. Practice selecting a line of cells, tap hold the dot on the right-hand 

bottom corner and slide your finger across more cells on the same 

row 

b. Practice selecting a vertical group of cells, tap hold the dot on the 

right-hand bottom corner and slide your finger down more cells on 

the column 

c. Practice selecting a range of cells, tap hold the dot on the right-hand 

bottom corner and slide your finger diagonally away towards the 

bottom right of your screen 
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Changing Font Style, Font Size, Bold, Italic, Underline and Font Colour 

 

1. From the Top Menu (Home bar) you can format font options 

 

2. Select the cell or cells  

 

 

 

 

 

 

 

 

3. Choose from a list of fonts with the font drop down menu 
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4. Across the Top Menu (Home Bar) there are different font formatting options 

 

 

a. Size  

 

 

b. Bold  

 

 

c. Italic 

 

 

d. Underline 

 

 

e. Strikethrough 
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f. Font Color 

 

 

 

Formatting Cells and Groups of Cells 

 

1. Select the cells or group of cells  

2. There are a number of formatting options available for the contents of a cell 

(see Changing font...) 

3. Cells or groups of cells can be formatted with different styles and formats 

e.g. tap the Fill icon to change the background colour of a cell 

4. For example, to change borders of a group of cells to outline a range  

5. From the home menu tap the Borders icon  (a small dotted grid) 

6. From the borders drop down  menu tap  the option you would like to use 

 



 
 

255 
 

7. In this example we chose to format first with “All Borders” and to make the 

table stand out “Thick Outside Borders” 

 

 

Merge Cells 

 

1. Tap/select the cells to merge 

2. From the Top Menu, Home Bar tap the alignment icon  (three 

horizontal lines with three dots underneath)  

 

3. From the alignment drop down menu tap “Merge & Centre” 

 

4. Note the warning that only the contents of the leftmost cell will be kept in 

the resulting merged cell. 

 

5. This example shows the result   

 

 



 
 

256 
 

Word Wrapping 

 

The need to wrap text in a cell may occur when the contents of one cell hide the 

contents of another. Instead of stretching the column width you may need or 

prefer to wrap the words.  

 

 

1. Select/tap the cell or cells or the whole column where you wish to apply 

text / word wrapping 

 

2. Tap word Wrap icon which is two lined boxes with an arrow pointing back 

into the box 
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3. The text will then be shown in the box in full 

 

 

Formatting Numbers 

 

Formatting numbers is an important skill for working with spreadsheet data. 

 

1. The Top Menu (Home Bar) has a letters/numbers icon   

2. Tap the letter/numbers icon open up a list of number formatting options 
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3. Scrolling down (swiping up) reveals more options 

 

4. Select a cell with a number in it 

 

5. In this example we have a number with a long decimal to format to a 

currency 

 

 

6. The result is a typical currency formatted number with 2 decimal places 

and the local currency symbol  

 

7. To see the actual number held in the cell tap the cell and note the content 

of the formula bar  
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Inserting and Deleting Rows and Columns 

 

Inserting and deleting rows and columns can be achieved in two ways  

From the context menu 

 

 

1. From the Top Menu, Home Bar tap the Insert & Delete icon  this is a 

small grid with a plus symbol top left and an X symbol bottom right. 

 

Inserting cells rows and columns requires you to select a row or a column or a 

cell first. 

 

2.  Select the row, column or cell adjacent to where you want to insert or 

delete. 

 

 

This results in a row being inserted across the entire worksheet (note how 

the numbers on the right have been separated which might not be 

desirable) 
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3.     Choose the option best suited to your task e.g. 

a. Insert a new table row. (without interrupting other parts of the 

worksheet) 

 

 

b. Delete an excess row and move the cells up 
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Resizing Cells 

 

1. Select/tap the cell  

Resizing a cell will affect other cells in the same row or column 

 

2.  From the Top Menu, Home Bar  

3. Tap the Format Cell Size icon  (a small grid box shape with two 

arrows above)  

The resulting drop down menu allows you to Adjust the row height or the 

column width 

4. In this example tap  “Auto-fit Row Height” 

 

5. The result  
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Clearing Content and Format 

 

1. From the Top Menu, Home Bar  

 

2. Tap the Clear icon  (a diagonal box, possibly meant to look like an 

eraser)  

3. Tap what you would like to achieve from the Clear menu choices  

a. Clear All 

b. Clear Formats 

c. Clear Contents 

 

4. In this example we will Clear Contents 
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Basic Maths Functions Using AutoSum 

1. Either 

a. Select/tap a cell on the right-hand side of row of numbers OR 

 

b. Select a cell below a column of numbers 

 
 

2. Then from the Top Menu, Home Bar  

 

3. Tap the AutoSum icon  (the Greek Sigma icon which indicates sum or 

sum of)  
 

4. Select/tap the type of sum to perform from (Sum, Average, Min or Max) 
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5. Check that the formula includes all the cells  

 

6. Tap the Tick Button to complete the task 

 

7. Here is an example to calculate the SUM of all goals scored by a football 

team for 4 months 

a. Check the Sum 

b. Tap the tick button 
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c. Result 

 

 

8. Here is an example of the AVERAGE goals scored in September 

a. Select the data and then tap Sum icon 

 

b. Choose Average and check the formula includes all numbers needed 

 

c. Tap the tick button  
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d. The result is given - (the average goals for all teams in September == 

10) 

 

 

9. To calculate a total outside of the table 

 

a. Add some text to explain the sum 

 

b. Tap the cell next to our sum text 

 

c. Tap AutoSum → Select Sum  

 

d. Type or edit the formula or adjust the bounding box to cover from the 

top left cell to the bottom right cell - in this instance =SUM(J9:M11) 

 

e. This results as below 
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Maths Functions Using Formula and Standard Spreadsheet 

Functions 

 

There are a wide range of built-in math functions for Excel. 

 

Using the notation =FUNCTION(Values) Spreadsheets are powerful tools for 

calculating and advanced math.  

 

Some important basic functions include (SUM, MIN, MAX and AVERAGE) and 

examples will be covered below 

 

In all these cases we will be using the functions of a range or cells from left to 

right, top to bottom or top left to bottom right 

 

 It is important to understand every cell has a column and then a row reference 

A1 means column A row 1. It is the first cell in a spreadsheet.  

 

Sum/average or count a range of cells 

If we want to add the values of two cells  

=SUM(A1+B1) 

If we want to add all the values in a range of cells with use the : colon character 

between the first and last cell in the row, column or range as follows 

=SUM(A1:A10) is a sum of all the numbers in column A from row 1 to row 10. 

=SUM(A1:J10) is a sum of all the numbers in a row from column A to column J 

 

Suppose you wanted to divide those cells by the number of values in order to 

calculate the average.  

 

Excel allows two ways to do it the simple way is to use the AVERAGE function 

as follows 



 
 

268 
 

=AVERAGE(A1:J10) produces for average number given the count of the 

numbers in a row from column A to column J 

We might also do this using the function COUNT as follows 

=SUM(A1:J10) / COUNT(A1:J10) 

Should we happen to know the count or number of values in advance we could 

“hard code” that value as follows  

=SUM(A1:J10)/10  

 

Here are some helpful screenshots to illustrate how you might use formula within 

your spreadsheet 

 

MAX function example  
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Insert a formula in a cell 

 

In the example, “Avg goals scored per month across the year so far”  

 
 

see the formula  

=SUM(J9:M11)/COUNT(J9:M11)  

the same result could be given from the formula  

=AVERAGE(J9:M11) 

 

Sorting and Filtering (Including Data Menu) 

 

Filter data 

Adding filters to a table of data 

1. Let’s make two identical copies of our football goals table  

2. The first table is hard coded to order teams buy most goals scored and 

then alphabetically 

3. What if we add filters to a table? 
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4.  

 

a. First we must careful select all columns and rows we wish to filter / 

sort and their labels 

 

b. Then from the Top Menu, Home Bar  

 

 

c. Tap the Sort & Filter icon  (a funnel with an A above a Z on the 

left)  

d. Our filters are in place 
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5. Now we can do imaginative things like order the table by who scored the 

most goals in November  

a. Tap the filter “down arrow” icon you wish to use  

b. In this case we chose November  
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Inserting and Editing Tables  

 

Inserting a table into existing data or a copy of existing data will bring powerful 

table features to your skillset. Suggest copying and pasting a range of data from 

another sheet to practise  

1. Let’s copy our football data into a new sheet called Table 

 

2. Make sure our headings have labels as they are hard to edit via the iPad 

app 
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3. With our data selected, from the Top Menu tap Insert  

 

4. From the Top Menu Insert Bar tap the table icon (a plain grid with the word 

table next to it)  

5. Excel should recognise the headings (note the substitution of Column1 for 

the blank label… we will edit that later by tapping on the cell and then 

selecting the edit option) 

 

6. When we select a cell within the resulting Table, the Top Menu reveals a 

new option “Table” and we can select or tap that to reveal the Table Bar 

 

7. From the Table Bar there are a number of quick menu options including 

“Alt Text’ 

8. Let’s add some Alt Text to our table this can be very helpful for screen 

readers and pupils with a severe vision impairment 
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9. Let’s Insert a row for another popular football team  
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10. And paste in the data 

 

11. We can use the filters  

 

12. Finally, although other options are available, let’s format our table to 

look nicer by choosing from a range of quick styles 
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13. (with Column1 edited now to say Totals)  
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Insert and Editing Photos 

 

1. From the Top Menu → Insert Bar 

2. Tap Photos Icon (a landscape with the word Photos next to it)  

 

 

3. From a choice of your device Photos folders tap the image you want to 

insert 

 

4. OR tap Camera to take a photo with your iPad 
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5. Tapping and selecting the image brings up a Picture tab in the Top Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Select the Picture Tab to show the Picture editing menu 

 

7. For example, tap the Crop Icon (two overlapping corners) to trim the sides 

of your picture 

 

8. To resize a picture Tap and hold a corner circle on the outline of your 

selected image  
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9. There are a number of paid and free styling options to frame the picture in 

a circle 

 

 

10. Importantly for screen readers you can add Alt text to describe the 

image for blind users, you may check/uncheck decorative if the image is 

not important to the context of the sheet. 
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Inserting and Editing Shapes 

1. From Top Menu → Insert Tab tap/select the Shapes icon  (a 

circle overlapped by a square with the word Shapes next to it)  

 

2. There are a number of shapes to choose from in the Shapes drop down 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Choose a shape 
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4. Select the shape (e.g. triangle) the “Shape” Tab is revealed in the Top 

Menu 

 

5. In the Shape menu there is an array of styling options; Insert, Shape 

Styles, Fill Colour, Outline Colour… and more  

 

6. Tap the Fill icon (A tipped bucket of pain) and select a colour from the color 

drop down 

 

7. The shape can be resized but not cropped 
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 Inserting and Editing Text Boxes 

 

We can insert a text box which is simple a shape with the text ready to edit  

1. Select a cell near where you wish to place the text box 

 

2. From the Top Menu → Insert Bar → tap the Text Box icon (a box with lines 

and a T in the top left corner)  

 

 

 

3. Instantly we enabled edit mode for our placed text box so we can type in 

the text and close the keypad when we are done. 
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Inserting and Editing Icons 

 

Icons are sharp vector graphics we can insert into a chart to provide context and 

instantly informative labels. 

 

1. From the Top Men → Insert Bar → Select the Icons icon  

 
2. You may need to wait while the icons are generated to populate a menu of 

icons 

3. There are many icons available if you scroll / slide down the icon menu 

4. A selected item e.g.  a Disabled Badge is instantly placed on the sheet 
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5. Note a Graphics Tab appears in the Top Menu 

 

 

6. The Graphic Tabs menu also comes with a variety of options such as Alt 

Text, Crop, Fill, Outline and more.  Note now our screen has a number of 

graphics objects the options Forwards and Backwards have become 

enabled 

7. This allows us to layer shapes, text boxes and photos in front of or behind 

each other (all very fascinating for a spreadsheet) 

8. Here we selected Graphics Fill which reveals a palette of colours to choose 

from 
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Inserting and Editing Charts/Graphs 

 

Select the range of data we wish to generate a chart of table from 

 

1. From The Top Menu → Insert Bar → Select / tap the Chart icon  (a 

series of 3 vertical bars with the word Chart next to it) 

 

2. From the Chart drop down menu there are many options to try out 
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3. E.g.  recommended  

 

4. The chart is placed on your sheet 

 

5. You can tap on it to move it 

6. Tapping on a chart also reveals the Chart Tap in the Top Menu 
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7. From the Chart Menu you can make a number of changes to your chart, 

including colours and changing the chart type 

 

8. To edit the generated Title of the chart long tap the title and the edit keypad 

appears 
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Adding Hyperlinks 

 

Link text to something on the web, this is called a hyperlink. 

1. Select the text to turn into a link 

2. From the Top Menu → Insert Bar → Select the Link icon  (a planet 

with a small chain on it and the word Linke next to it)  
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3. Add the url e.g. http://www.mywebsite.com and tap done 

 

4. The result 

 

 

 

 

 

 

 

 

http://www.mywebsite.com/
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Drawing (Apple Pencil or Finger)  

 

1. From the Top Menu → select the Draw Tab   There is a selection of Draw 

tools 

 

2. For example tap select the marker and change colour to green by holding 

down the marker tab 

 

3. Enable the “Draw with Touch”  setting by tapping or 

sliding bar 

4. Draw by hand on the sheet 
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5. The sheet is still functional so you can continue to type in the cells 

 

 

View Menu: Formula Bar, Gridlines, Headings, Sheet Tabs, Sheet 

Right-to-Left 

 

The View Tab Menu (a tab from the Top Menu) allows us to make changes to 

our sheet which may be useful for presentation 

 

Here various settings have been toggled off to improve the presentation of our 

efforts including; Formula Bar, Gridlines, Headings  
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The magnifying glass + and magnifying glass minus will to zoom in and zoom 

out  

 

Freeze panes  are used to lock a column or row in place. This feature 

is used for sheets with lots of data and it is important to freeze or keep the 

information about the data in particular rows or columns 

 

 

 

Here we see the rows passing under the frozen header (our Top Row from the 

previous step) 

 

 

 

Search 

Search in the current worksheet - default 

 

1. From the Top Menu towards the right-hand side, tap the Magnifying Glass 
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2. Type in the word or number you would like to find 

 

 

3. The information you have searched for is highlighted.  If you hit return, this 

will take you to the next place in your worksheet where you will find the 

information. 

4. You can also use  the left and right hand arrows  at the top right 

hand corner  
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Search in the workbook (all worksheets) 

1. Tap the search settings icon top left  

2. Tap Find and Replace 

 

 

Select Workbook 

 

  

 

Help 

 

The Top Menu does not have a help button or icon 

This is the help icon   

 

The prompt “Tell me what you want to do” will appear 
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Type in what you need e.g. ‘download my sheet’ 

 

 

 

Further information and instructions can be found if you search for help, include 

‘iPad excel app’ in your search.  
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Lesson 5: Completing Work in a PDF 

 

Outcome 

The pupil can complete fields of a document in a PDF writer app which they have 
scanned.  

 

Preparation 

You will need a clear and decluttered worksheet at the pupil’s current academic 
level which is motivating to the pupil and/or linked to a topic. You will also need a 
suitable PDF writer app i.e. Smart Forms and a document scanner app i.e. 
Genius Scan. 

 

Links to Previous Learning 

Continue to provide opportunities to develop speed and accuracy in typing 
letters, digits and symbols.  

Ensure that the pupil is able to take clear photos of the whole of an object before 
completing the entirety of this lesson (See Unit 5a, Lesson 2).  

 

Key vocabulary 

PDF writer app, fields 

 

Activity 

Introduce a PDF writer as an alternative method of completing worksheet-based 
recording. Provide backwards chaining in order to complete fields on the PDF 
using typing tools. Gradually provide work on a PDF writing app in a less 
predictable order. Model and provide guidance in how to increase the text font. 
Once the pupil is confident in typing into the fields, model how to scan 
worksheets using a scanning app and then upload them to the now familiar PDF 
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writing app. Encourage the pupil to complete the steps required in order to scan 
a document, upload it into the PDF writer app before completing their work. 

 

Tailor it! 

• Encourage the pupil to enlarge the text size so that it is comfortable for 

them to read. 

• Apply Zoom including Follow Focus. 

• Tailor the worksheet to match the pupil’s ability to scan and locate 

information i.e. present print and/or images horizontally with adequate 

spacing.  

• Introduce functions within the PDF writing app which will be the most useful 

to the pupil i.e. the pen mode to draw with alongside text or a highlighter to 

highlight key words.  

 

Let’s Apply! 

•  Support the pupil to generalise their typing skills and use of scanning and 

PDF writing apps within the classroom environment as an alternative and 

quicker way of producing their work.  

• Gradually increase the complexity of the worksheet. 

• Encourage the pupil to explore other options in the PDF writer app i.e. pen 

mode and identify how they could use this within their learning 

environment.  

• Explore a range of other apps which can be used to record work, 

identifying key apps that can be used for the pupil to record their own work 

rather than having to rely on others. Demonstrate using the screenshot tool 

as a way of evidencing work if appropriate.  

 

Think SMART! 

S – What kind of document do you expect the pupil to complete? Which apps do 

you expect the pupil to use? 

M – How many steps to scan and type on a document do you expect the pupil to 

complete? How many functions do you expect them to use? 

A - How much scaffolding does the pupil need to achieve the outcome? 
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R – Will you expect the pupil to be able to interact with both the scanner app and 

the PDF writer app or will these need to be taught separately to begin with? Are 

their typing skills at a sufficient level to use the typing tools or will they need to 

use the Dictation tool?  

T – Will the pupil be able to complete all steps in order to scan the document, 

upload to a PDF writing app and engage in this in one lesson or will these steps 

need to be taught and practiced over multiple lessons? 
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What is Siri  
 

• Siri is a built-in, voice-controlled personal assistant available on the 
iPad.  You can ask Siri questions, tell Siri to show you something or 
issue commands.  
 

How to set up Siri  

• Go into Settings   
• Scroll down the left-hand column and tap on Siri & Search   
• To summon Siri with your voice: Turn on Listen for “Hey Siri.”  
• To summon Siri with a button: Turn on Press Home for Siri (on an 
iPad with a Home button) or Press Top Button for Siri (on other iPad 
models).   
 

Summon Siri with your voice  
 

• If you summon Siri with your voice, Siri responds out loud.  
• Say “Hey Siri,” then ask Siri a question or to do a task for you.  
• To ask Siri another question or to do another task, say “Hey 

Siri” again or tap .  
• To prevent iPad from responding to “Hey Siri,” place your iPad face 
down, or:  

Go to Settings     
Tap on Siri & Search   
Turn off Listen for “Hey Siri.”  
 
 
 

 

Appendices B – Siri 
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Summon Siri with a button  
 

• On an iPad with a Home button: Press and hold the button.  
• On other iPad models: Press and hold the top button.  
• When Siri appears, ask Siri a question or to do a task for you.  

• To ask Siri another question or to do another task, tap    
 

 

If Siri does not understand you  

• Rephrase your request: Tap   and ask the question in a 
different way.  

• Spell out part of your request: Tap , then repeat your 
request by spelling out any words that Siri did not understand.  
• Change a message before sending it: Say “Change it”.  
• Edit your request with a text: If you see your request onscreen, you 
can edit it. Tap the request, then use the onscreen keyboard.  

 
 

Type instead of speaking to Siri  
 

• Go to Settings  
• Scroll down the left-hand column and tap on Accessibility   
• Tap on Siri  
• Turn on Type to Siri  
• To make a request, summon Siri, then use the keyboard and text 
field to ask Siri a question or to do a task for you.  

 
 

Find out what Siri can do on an iPad  
 

• You can use Siri to get information and perform tasks.   
• Find answers to questions e.g., “Hey Siri, what is a cat?”  
• Perform tasks with apps e.g., to create an event in your calendar say 
“Hey Siri, meet with my English teacher at 10am”  
• Send and reply to messages e.g., “Hey Siri, send a message to my 
Maths teacher”.  
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Tell Siri about yourself on an iPad  
 

• If you tell Siri about yourself—including things like your home and 
work addresses, and your relationships—you can get a personalised 
service and e.g., say “Send a message to my mum”.  
• Tell Siri who you are.  

o Open the Contacts app  and fill out your 
contact information.   
o Go to Settings – Siri and Search – My information – then tap 
your name.  

• Tell Siri how to say your name e.g., say “Hey Siri, learn to pronounce 
my name”.  

 
 

Add Siri Shortcuts on iPad  
 

• Add a suggested shortcut – tap Add to Siri when you see a 
suggestion for a shortcut, then follow the onscreen 6 to record a phrase 
of your choice that performs the shortcut.  
• Use a shortcut - Summon Siri, then speak your phrase for the 
shortcut.   

 
 

Turn off shortcut suggestions  
 

• Based on your routines, Siri may suggest shortcuts on the Home 
screen, Lock screen and when you start a search  
• To turn off shortcuts: Go to Settings – Siri and Search - tap the app, 
then turn off Suggest Shortcuts for App for the Home Screen, the Lock 
Screen, or both.  

 
 

About Siri suggestions on an iPad  
 

• Siri makes suggestions for what you might want to do next, such as 
confirm an appointment or send an email, based on your routines and 
how you use your apps. For example, Siri might make suggestions 
when you create an email and events, type, search in Safari, confirm an 
appointment etc.   
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Change Siri settings on an iPad  
 

• Change when Siri responds. Go to Settings - Siri & Search, then do 
any of the following:  

o Prevent Siri from responding to the voice command “Hey 
Siri”: Turn off Listen for “Hey Siri.”  
o Prevent Siri from responding to the Home button or the top 
button: Turn off Press Home for Siri (on an iPad with a Home 
button) or Press Top Button for Siri (on other iPad models).  
o Prevent access to Siri when iPad is locked: Turn off Allow Siri 
When Locked.  
o Change the language Siri responds to: Tap Language, then 
select a new language.  
o You can also summon Siri by typing (see Type instead of 
speaking to Siri).  
  

• Change how Siri responds. Go to Settings - Siri & Search, then do 
any of the following:  

o Change the voice for Siri: (not available in all languages) Tap 
Siri Voice, then choose a male or female voice for Siri or change 
the accent.  
o Change when Siri provides voice responses: Tap Siri 
Responses, then choose an option below Spoken Responses.  
o Always see the response from Siri onscreen: Tap Siri 
Responses, then turn on Always Show Siri Captions.  
o See your request onscreen: Tap Siri Responses, then turn on 
Always Show Speech.  

• Hide apps when you summon Siri. If you do not want the active app 
to remain visible behind Siri, go to Settings - Accessibility - Siri, then 
turn off Show Apps Behind Siri.  
  
• Change where Siri Suggestions appear. Go to Settings - Siri & 
Search, then do any of the following:   

o Suggestions while searching  
o Suggestions on Lock Screen  
o Suggestions on Home Screen  
o Suggestions when sharing  
  

• Change Siri settings for a specific app:  
o You can change the Siri Suggestions and Siri 
Shortcuts settings for any app.  
o Go to Settings - Siri & Search, then select an app.  
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• Adjust the Siri voice volume by saying e.g., “Turn up the 
volume” or “Turn down the volume.” Or use the volume buttons.  
  
• Retrain Siri with your voice. Go to Settings - Siri & Search, turn 
off Listen for “Hey Siri,” then turn on Listen for “Hey Siri” again.  
  
• To change Siri accessibility settings, see following 
link https://support.apple.com/en-gb/guide/ipad/ipade5045bb1/ipados   

  
  
  

  
  

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

https://support.apple.com/en-gb/guide/ipad/ipade5045bb1/ipados
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iPad Accessibility Skills  

Siri  Progression 

Basic Skills Introduce Developing Achieved 

Summon Siri with your voice    

Summon Siri with a button    

If Siri does not understand you    

Type instead of speaking to Siri    

    

Intermediate Skills    

Find out what Siri can do on an iPad    

Tell Siri about yourself on an iPad    

Add Siri Shortcuts    

Turn off Shortcut Suggestions    

    

Advanced Skills    

Change Siri settings on an iPad    

Change when Siri responds    

Change how Siri responds    

Hide apps when you summon Siri    

Change where Siri Suggestions appear    

Change Siri settings for a specific app    
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Adjust the Siri voice volume    

Retrain Siri with your voice    

Change Siri accessibility settings    
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Screen-mirroring (or Conference) software enables a pupil to see what is displayed on 
the classroom Interactive Whiteboard (IWB) on their device. They can then, commonly, 
manipulate the image to make it easier to see, changing the colours, zooming in to 
make it bigger, annotating it with an Apple Pencil or saving it to a drive for further 
reference.  
 
There are myriad screen sharing software options, each of which works slightly 
differently. It is common for schools to need to try more than one to find a 
software that fits. Most are free of charge, or relatively cheap.  
 
Common conference software options include (but are not limited to) the 
following:  
 

• join.me 

• VNC 

• Impero 

• Team Viewer 

• Nearpod 

• Splashtop classroom 

• DisplayNote 
 
 
 
 

 

 
 

 

 

 

Appendices C – Instructions on 

Screen-Mirroring Software 
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What is OneDrive  
 

• OneDrive is the cloud storage service developed by Microsoft that 
allows you to store all your files and photos securely in one place, share 
and collaborate with others and then access them from anywhere.  
  

How to set up a OneDrive account  
 

• If you have a Microsoft account, you already have a OneDrive 
account.   
• Download the OneDrive app from the app store. If it is your first time, 
sign into OneDrive with your Microsoft account email address.  
• You can also sign in from a web browser. Go to 
onedrive.live.com. When the sign in window appears, sign in with your 
Microsoft account email address and password.  
  

Home page layout explained  
 

• The Home page should look similar to the diagram below with the 
Home tab highlighted on the toolbar at the bottom of the screen. Your 
list of recent files will appear on the screen.  
 

 
 
 
 
 
 
 
 
 

  
 

Appendices D – Using the 
OneDrive App 
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• The OneDrive features toolbar which is located at the bottom of the 
screen may vary. For example, if you have used Photos, it may appear 
here as well:  
 

  
  

• When you are signed in, a Me icon  will appear in the top left 
corner next to Home. If you tap on this, a sub menu will appear with 
various options.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
 
 
 
 

  
  

• The Add icon (plus sign) in the top right corner displays the menu 
below:  
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Set a passcode  
 

• You can set a four-digit passcode to prevent other users of your iOS 
device from accessing your OneDrive for work or school account. To do 

this, open the app, tap the Me icon, tap Settings , and then tap 
the Passcode toggle to turn it on and to enter your passcode.  

       
  

Add an account  
 

• You can add an account by tapping on the Me icon and then ‘Add 
account’ (grey circle icon with plus sign in the middle)  
 

 

  

Switch between accounts  
 

• If you have more than one OneDrive account e.g., a school and 
personal, you can switch between the two by tapping on either icon. The 
school account is the middle icon below.  
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Sign out of an account  
 

• To sign out of a OneDrive for home account or a OneDrive for work 
or school account, open the app, tap the Me icon, and select the 
account you want to sign out of.   
• Once you have selected the account, tap Settings, go 
to Accounts (near the top), tap the Personal or the OneDrive for 
school/work account name and tap Sign out.  
  

Files tab  
 

• Go to the Files page by tapping on the Files tab at the bottom of the 
screen, located in the features toolbar and your Files list will 
appear. The Files tab will also be highlighted.  
 
 
 
 
 

  
 
 
 

  
 

File/Folder options  
 
 
 
 
 

• Tap on the three dots next to each file or folder on the right-hand side 
of the screen. In the example below the Resources folder has been 
selected and options are chosen as required. If you select a file you will 
be given the option to edit or open in another app as well.  
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Create a folder  
 

• Tap on the Add icon in the top right corner and tap 
on Create a folder.  

  
  
 

• You will now be able to create a folder. Type in the name of your 
folder where it says New folder and then tap on Create a folder.  
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Create a Word document  
 

• If select Word Document, you will be directed to the Word app and a 
new document will open. Once you have finished your document, you 
will be given the option to save to your OneDrive account.  
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Create a PowerPoint or Spreadsheet  
 

• If you select PowerPoint presentation you will be directed to the 
PowerPoint app. You can create a PowerPoint and save it in 
OneDrive. If you have the option to select Excel then follow the same 
steps.  
 

  

  

Access a file or folder   
 

• Tap on the icon/name.   
  

Find a file/folder  
 

• You can find files/folders or search for text within them.   

• At the top of the file view tap Search  in the top bar.  
• Enter the name of the file/folder or text you want to search for.  
  

Change how files are sorted  
 

• Open the folder you want to sort, and then tap the arrow next to the 
current sort order, for example Sort by name (A to Z).  
• Select how you want the files sorted. You can sort by name, date, or 
size.  
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Move files/folders in and out of folders   
 

• You can move folders in and out of another folder, as well as 
individual files. Go to the Files tab to see your list of files and folders.  
  
• Move a file/folder into another folder – select the file/folder you want 
to move elsewhere. Tap on the three dots next to it and select 
Move. Your folders list will appear as a sub menu. Tap on the folder you 
want your file/folder to move into.   

  
• Move a file out of a folder – Tap on the name of the folder that your 
file is in. In the following example we will move the Geography file out 
of the Resources folder. In this example we will tap on Resources (tap 
where circled in red).   
 

  
  

• You will be presented with the list of files and folders in 
Resources. Find the file/folder you want to move and tap on the three 
dots next to it. Sometimes the three dots do not appear straightaway. If 
this happens just come out of the folder and go straight back in. In this 
example we are moving the Geography file. We will tap on the three 
dots next to Geography (circled in red).   
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• You will then be presented with various options including moving the 
file. Tap on Move (circled in red).   
  

  
  

• A sub menu will then appear which contains a list of all available 
folders to move the Geography file into.   

 

  

•  
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• If you just want to move the file out of the folder without transferring 
to another folder then select Move. If you want to transfer to another 
folder then select the folder first before tapping Move.  
  

Upload files and folders  
 

• Tap the Add icon  at the top right of the screen.  
• Tap on ‘Upload’ and the icons below will appear on the screen:  

  
• You can upload any photos or tap on Browse to access files on your 
device (in Files app).   
 

  

Share files/folders  
 

• In the Files page, select the file/folder you want to share. You can do 
this in two ways:  

• Select the file or folder you want to share. You need to press 
and hold to select it. Then tap on the Share icon in the top 
right corner.  

 

  

  
• Once you have selected Share, the ‘Send link’ sub menu will 

appear as shown in the following diagram. Type in the email 
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address of the person/people you want to share the file with. 
Add a message as required and press send.  
 

  
• Another way to share is by tapping on the three dots next to 

your file/folder and choosing Share from the sub menu.  
 

  
 
 
 

Delete a file/folder  
 

• In the Files tab tap on the three dots next to the file/folder  
• Select Delete.  
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Rename a file/folder  
 

• In the Files tab tap on the three dots next to the file/folder  
• Select Rename this folder.  
 

Make available offline  
 

• In the Files tab tap on the three dots next to the file/folder  
• Select Make Available Offline.  

 

View details of file/folder  
 

• In the Files tab tap on the three dots next to the file/folder  
• Select Details.  
 

Open in new window   
 

• In the Files tab tap on the three dots next to the file/folder  
• Select Open in New Window. 
 

Scan a document, whiteboard, business card or photo  
 

• Tap Scan  on the OneDrive features toolbar at the bottom of the 
screen. You can also tap the Add icon at the top of the screen, then tap 
Scan. (To exit out of Scan mode without scanning anything, just tap the 

‘x’ in the upper left corner of your screen.)  
 

 
 
 
 
 
 
 
 
 

      
  
 
 
 
 

• If available, select the appropriate flash setting (on, off, automatic) by 
tapping the Flash icon, just above the white circle icon.   
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• Select either Whiteboard, Document, Business Card, or Photo, then 
tap the white circle icon to scan the item.  
  

  

Edit your scan  
 

• Once you have scanned your item, you can crop it, rotate it, add text, 
or highlight part of it. (If you do not like the image, just press Cancel at 
the bottom left of the screen). If you are happy with the image press 
Confirm at the bottom right of the screen.   
  

• Once confirmed you are presented with. Once scanned you can add 
filters, crop, rotate, delete, highlight or add text. These are all options at 
the bottom left of the screen. You can also add another page by 
pressing the Add icon, which is the first option, bottom left. Once you 
have finished editing your document, tap Done.  
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Save your scan  
 

• You will now have the option to save your document. Click in the box 
circled in red and start typing in order to name your document.   

  
  

• In the example below the file has been named ‘Scan1’. Tap on the 
blue tick in the top right corner to save the document. The file will 
automatically be saved as a PDF.   

  

  
• Once saved, the Files tab is opened and highlighted on 
the features toolbar. The file ‘Scan 1’ is now in the list of folders 
and files, at the bottom.   
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Take a Photo or Video  
 

• Tap on the Plus icon and then tap on Take a Photo or Video.  

  

  
• You have the option to zoom in or out (left hand 
side), select the appropriate flash setting if available, switch between the 
front and rear facing camera and take a photo or video (right hand 
side). Press Cancel if you change your mind or want to retake the 
photo. The options are displayed in the following diagram:  
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Automatically save photos or videos  
 

• Tap on your Me icon    

• Tap Settings  then Camera Upload.  
• Turn on Camera Upload to automatically upload photos and videos to 
OneDrive.  
• To make sure videos automatically upload, turn on Include Videos.  
• You can only upload your camera roll to one account at a time, so 
make sure you are signed in with the account that you want to upload 
photos to. Tap the relevant account icon to switch accounts.  

  

Access photos and videos  
 

• Tap on your Me icon   
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• Tap on Photos  

  

 
• You will then be able to access all your photos and videos.   
• To select a photo/video, tap on it.  

 

  
• You will now be given options on the blue toolbar at the top right-
hand side.  
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• Share the photo  by tapping on the Share icon and sending a link:  
 

  

• Delete the photo by tapping on the delete icon    
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• Make the photo available offline by tapping on the Make Available 

Offline icon    
  

• View details of the photo by tapping on the information or ‘i in a 

circle’ icon   
  

• Download or rename the photo by tapping on the three dots   
  

• You can also access photos by tapping on the Photos tab on the blue 
toolbar at the bottom of the screen, if present.   
  

  

Files and folders shared with you  
 

• When someone shares a OneDrive file or folder with you, you 
typically get an email message or a notification on your iPad. To find the 
files shared with you in the OneDrive app, tap the Shared view 

icon  on the toolbar at the bottom of the screen. You can access 
shared files and folders here if you tap the Shared icon. See diagram 
below (names of persons who have shared the files have been crossed 
out).    
 

   
  

• If you tap on the three dots next to each file you will be given options 
to share/delete/view details/rename/open in another app/edit/open in a 
new window. See diagram below.  
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• The shared view shown in the diagrams is typical for a school/work 
account. The view is different if using a personal OneDrive account.  

  

Shared Libraries  
 

• You can view all your files and folders in your shared libraries here. 

Tap on the Libraries icon  on the Toolbar at the bottom of the 
screen. When you are working as a team — in Microsoft Teams, 
SharePoint, or Outlook—a shared library allows your team to store and 
access files/folders that your team members work on together, and 
OneDrive for work or school connects you to all your shared 
libraries. The diagram below shows an example of all the shared 
libraries for a OneDrive account (names have been crossed out).  
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• If you select a team by tapping on the name/icon you will be able to 
view the files/folders that the team are working on. In the diagram below 
Team ‘T’ has been selected which takes you to the Documents 
page (the name of the team has been crossed out).  
 

  
  

• Tap on Documents to view all the files/folders that Team T are 
working on. The file may be under ‘General’. It depends on where you 
place the file/folder in the site folder structure. (Names of sites/files have 
been crossed out).  
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iPad Accessibility Skills 

Using the Microsoft OneDrive app Progression 

Basic Skills Introduce Developing Achieved 

Set up OneDrive 
 

  

Be familiar with the Home tab    

Set a passcode    

Add an account (optional)    

Switch between accounts (optional)    

Sign out of an account    

    

Files Tab    

Be familiar with the Files tab    

Be familiar with file/folder options    

Create a folder    

Know the instructions involved to be directed to create a word document     

Know the instructions involved to be directed to create a 
PowerPoint/Spreadsheet    

Access a file/folder    

Find a file/folder    

Change how files are sorted    

Move files/folders in and out of folders    

Upload files and folders    
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Share files and folders    

    

Intermediate Skills    

Files/folders 
   

Move files/folders in and out of folders 
 

  

Upload files/folders/photos 
 

  

Share files and folders 
 

  

Delete a file/folder    

Rename a file/folder    

Make a file/folder available offline    

View details of file/folder    

Open in new window    

    

Scans/photos/videos    

Scan a document/whiteboard/business card and photo    

Edit your scan    

Save your scan    

Take a photo or video    

Automatically save your photo or video    

Access photos/videos    

Delete photos/videos    

Make photos available offline    

View details of photo and Download/rename photo    

    

Advanced Skills    

Files/folders shared with you 
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Access files/folders     

Share files/folders     

Delete files/folders     

Rename files/folders    

Open in another app    

Edit files/folders     

Open in new window    

    

Shared Libraries    

View all files/folders    
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Mail is the iPad’s inbuilt email app. Although it is possible to 
download specific apps for, for example, Gmail, Outlook and Hotmail, 
functionality is relatively limited on the iPad compared with Windows computers, 
so we will focus here on Mail which works well with all of these and is very 
comprehensive, allowing you to send and receive emails, photos, drawings.  
  
Setting up Mail  
 

• Tap on Settings  
• Tap on Mail  
• Go to Accounts, then Add Account. Finally tap Other.  
• To add your email account, tap Add Mail Account, and then enter all 
the information requested. This will include your email address and 
password, so make sure you have it handy.   
• You could otherwise choose to set up a new account here.   
• Tap Save when you have finished.   
 

  
Writing an email  

• Within Mail, tap on the new message icon to bring up a new 
email.  
• Tap within the email, and then type your message using the 
onscreen keyboard. You can also choose to dictate the letter by tapping 
the microphone icon to the right of the keyboard, tapping at the bottom 
of the screen when you have finished.   

• Tap the formatting icon  to change how the text in the body 
of your email looks - you can alter font style or size, text colour, add bold 
or italics and many more.   

Appendices E – Using the Mail 
App 
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To add recipients:   

• Tap in the To field, then type the names of recipients. Mail will make 
suggestions from your Contacts as you type. Alternatively, you can tap 
the Plus icon to open Contacts and add recipients directly.  
• To send a copy, tap in the cc/bcc field and enter in the same way. 
The bcc field is for when there are names you don’t want the other 
recipients to see.   

You can also you Siri to combine these 2 steps. By asking her something 
like: “New email to Julia Roberts’, it will open a new email and put Julia’s email 
address in the To field.  
  
Finally, click the blue Send arrow icon at the top right of the screen to send the 
email on its way.  
  
 

Replying to an email  
 

• Tap within the email you want to respond to, tap the 

Respond icon  at the bottom right of the screen and select your 
response (you have the option to Reply, Reply All, Forward and many 
more).  
• Type your response and then tap the Send icon.  
 

  
Adding attachments to an email  
 

In Mail, you can attach many different things to, and within, an email, 
including photos, videos, scanned documents and handwritten notes. 
   

  
Attaching a saved document   
 

• Within the email, tap where you want the document to be inserted.   

• Tap the document icon  above the keyboard.  
• You will be given the option to Add Document or Scan a Document. 
Here, you will be adding a document that is already scanned in and 
saved, so tap Add Document.  
• Locate the document in Files, then tap it to insert it.  
• Alternatively, you can drag a file to your email to attach it.  
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Attaching a saved photo or video  
 

• Within the email, tap where you want the document to be inserted.   

• Tap the camera icon  above the keyboard.  
• You will be given the option of looking for a photo in the Photo 
Library, or else taking a photo. Here, you want to attach a saved photo, 

so tap the Photo Library icon .  
• Locate the photo or video in the photo selector, swiping up to see 
more images. Tap to select the photo or image and insert it in your 
email.   

  
 

Taking a photo or video to put in an email  
 

• Within the email, tap where you want the photo or video to be 
inserted.  
• Tap the camera icon above the keyboard.  
• This time, tap Take Photo to take a new photo or video, then tap Use 
Photo or Use Video to insert it.   
 

If you want to re-take it, tap Retake.   
  
Scan a document into an email  
 

• Within the email, tap where you want the scanned documented to be 

inserted, then tap the Scan Document icon  above the keyboard.  
• Hold the iPad above the document so that it can be seen on the 
screen.   
• The iPad will capture the image automatically, but you can choose to 
capture it manually by pressing the shutter button or a volume button.   
• Scan any additional pages you want.  
• Tap Save (or Keep Scan) when you are finished – select Retake if 
you are not happy with what you have.  
• Scan additional pages, then tap Save when you’re done.  
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To make changes to the saved scan, tap it (it’s a small image at the bottom of 
the screen), then edit it by tapping on any/all of the 3 edit tools at the top of the 
screen. These are:   

Crop the image:  .  

Apply a filter:  .  

Rotate the image:  .  
  
You can also opt to just delete the scan.   
  
Tap Save when done, and the image/s will automatically insert into your email.   
  
 

Viewing emails  
 

  
Preview an email and a list of options  
 

In a mailbox list, touch and hold an email to preview its contents and see a list of 
options for what to do with it now, including replying and filing it.     
By default, Mail will display 2 lines of text, but you can change the default to 
more lines by tapping on Settings > Mail > Preview and stating your preference.   

  
 

Show the whole email  
 

In the list of emails, tap the one you want to read.  

  
Show the whole email conversation (thread)  
 

To see a whole email thread rather than just a single email: 
  

• tap on Settings  
• tap on Mail  
• turn on Organize by Thread  
 

You can further customize how threads are displayed by 
changing others settings in Settings > Mail e.g. Most Recent Message on Top.  
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Saving drafts for later  
 

If you’re writing an email and want to finish it later:  
within the email, tap Cancel, then tap Save Draft.   

To get it back, touch and hold the New Message icon, then tap the draft in the 
list.  
  

Organising emails  

  
Flagging emails  
 

Open the email, tap the Respond icon, then tap Flag.  
• To choose a colour for the flag, tap a coloured dot.  
• To change or remove a flag, open the email, tap Respond, then tap 
another colour, or Unflag.  

  
An email you flag remains in your Inbox, but also appears in the Flagged 
mailbox. To see the Flagged mailbox, tap Mailboxes at the top left, tap Edit, then 
select Flagged.  
  
Getting notified of replies to emails or threads  
You can create mail notifications when reading or writing an email.  

• When reading an email: Tap the Respond icon, then tap Notify Me.  
• When writing an email: Tap the Subject field, tap Notify Me (You 

might also need to tap the Notification icon  then tap Notify Me.) 
 

You can also create mail notifications that let you know when you receive emails 
in favourite mailboxes or from certain people. You might like to use Siri for this. 
Say something like: “Any new mail from Karen today?”  
Muting notifications  
 

• Open an email in the conversation.  
• Tap the Respond icon, and then tap Mute.  

To specify what you want done with emails you muted, go to Settings  > Mail > 
Muted Thread Action, then select an option.  
  
Move email to the junk folder  
 

Open the email, tap the Respond icon, then tap Move to Junk.  
Tip: immediately swipe left with 3 fingers to undo if you have made a mistake.   
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Swiping to organise emails  

 

While viewing an email list, slowly swipe an email to the left until you see the 
menu. Then tap an item. You can use this to Archive or Flag mails, but more 
options are available in More menu, including replying, forwarding, and marking 
as read.    

  
To customise your Swipe options, go to Settings  > Mail > Swipe Options.  
  
Organising emails with mailboxes  
 

Use the Mailboxes list to view your mailboxes, rename or delete them or create 
new mailboxes.   
 

How to view Mailboxes   
 

• When in Mail, tap Mailboxes in the upper-left corner.  
• tap Edit at the top of the list then check the mailbox you want to 
read.   
 

How to add a mailbox  
 

• When in Mail, tap Mailboxes in the upper-left corner.   
• tap Edit, and then select New Mailbox at the bottom of the screen.  
• enter a name and location, then tap Save.  
 

How to reorder your mailboxes  
 

• in Mail, tap Mailboxes in the upper-left corner.  
• tap Edit at the top of the list.  

• touch and hold the order icon  next to a mailbox until 
it lifts up, then drag it to the position you want.  

  
Deleting emails  
  
There are multiple ways to delete emails. Do any of the following:  

• While viewing an email, tap the bin icon   
• While viewing the email list, swipe an email left, then choose 
Trash OR swipe an email all the way to the left to delete it in a single 
gesture.  
• To delete multiple emails at once while viewing a list of emails, tap 
Edit, select the emails you want to delete, then tap Trash.  
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• To select multiple emails quickly, swipe down through the 
checkboxes.  

To turn the confirmation of deletion on or off, go to Settings  > Mail, then turn on 
or off Ask Before Deleting.  
If you change your mind, immediately swipe left with three fingers to undo.  
  
Recovering deleted emails  
 

• Go to the account’s Trash mailbox, then open the email.  

• Tap the folders icon , then select a mailbox.  
• If you change your mind, immediately swipe left with three fingers to 
undo.  

Tip: To see deleted emails across all your accounts, tap Mailboxes at the top left, 
tap Edit at the top of the list, then select the All Trash mailbox.  
  

  
Using Mail with VoiceOver   
   

• Open the Mail app.   
• After you hear the sound that alerts you that new mail has been 
downloaded, begin swiping right. This will read your e-mail subject lines, 
one per swipe.   
• When you reach an e-mail you wish to read, double tap to open it.   
• At this point you can either perform a two-finger swipe down to read 
the e-mail from the beginning or a two-finger swipe up to read the entire 
e-mail.   
• If it's a long e-mail, a three-finger swipe up will advance you one 
screen at a time through the e-mail, a two-finger swipe down will move 
you back toward the beginning.   
• Lightly touch two fingers to the screen at any time to stop speech.   
• Close your e-mail by performing a two-finger scrub (place two fingers 
on the screen and quickly move them an inch or so from side to side, as 
though you were scrubbing the glass), which will go back one screen, 
closing the e-mail you were reading.   
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iPad Accessibility Skills 

Using Mail Progression 

Basic Skills Introduce Developing Achieved 

Set up a Mail account 
 

  

Write and send an email    

Reply to an email    

    

Intermediate Skills    

Add attachments to an email    

Attach a saved document    

Attach a saved photo or video    

Take a photo or video to attach to an email    

Scan a document to attach to an email    

    

Viewing emails     

Preview an email and a list of options    

Show the whole email    

Show the whole email thread    
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Save drafts for later    

    

Advanced Skills    

Organising emails    

Flagging emails    

Mail notifications 
 

  

Mute notifications    

Move email to the junk folder    

Swiping to organise emails    

Organise emails with mailboxes    

Delete emails    

Recover deleted emails    

Using Mail with VoiceOver    
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Introduction 

VoiceOver on iPad can be controlled from an external keyboard. Most VoiceOver 

gestures have equivalent keyboard commands. This reference lists the most 

common keyboard commands for controlling VoiceOver, navigating the web, and 

editing text. 

 

VoiceOver Modifier Keys 

The VoiceOver Modifier Keys refer to one or two keyboard keys which combine 

with alphanumeric keys to form commands to control VoiceOver. The VoiceOver 

modifier can be configured to be one of the following: 

• Control + Option 
• Caps Lock 

To customise the VoiceOver Modifier Keys: 

• Go to Settings 
• Tap Accessibility > VoiceOver > Typing > Modifier Keys 
• Tap your choice of Control + Option or Caps Lock. 

 

General Commands 

In the following tables, "VO" refers to the VoiceOver Modifier Key. 

Action Keystroke 

Turn on VoiceOver Help VO–K 

Turn off VoiceOver Help Escape 

Select the next or previous 

item 

VO–Right Arrow or VO–Left Arrow 

Appendices F – Using the 
VoiceOver Keyboard Command 
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Double-tap to activate the 

selected item 

VO–Space bar 

Press the Home button VO–H 

Touch and hold the selected 

item 

VO–Shift–M 

Move to the status bar VO–M 

Read from the current 

position 

VO–A 

Read from the top VO–B 

Pause or resume reading Control 

Copy the last spoken text to 

the clipboard 

VO–Shift–C 

Search for text VO–F 

Mute or unmute VoiceOver 

speech 

VO–S 

Open Notification Centre Fn–VO–Up Arrow 

Open Control Centre Fn–VO–Down Arrow 

Open the Item Chooser VO–I 

Change the label of the 

selected item 

VO–/ 

Double-tap with two fingers VO–”-” 

Swipe up or down VO–Up Arrow or VO–Down Arrow 

Adjust the rotor VO–Command–Left Arrow or VO–

Command–Right Arrow 

Adjust the setting specified 

by the rotor 

VO–Command–Up Arrow or VO–

Command–Down Arrow 
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Turn the screen curtain on or 

off 

VO–Shift–S 

Return to the previous 

screen 

Escape 

Switch apps Command–Tab or Command–Shift–

Tab 

 

Quick Nav 

Quick Nav allows VoiceOver to be controlled with the arrow keys. 

Action Keystroke 

Turn Quick Nav on or off Left Arrow–Right Arrow 

Select the next or previous 

item 

Right Arrow or Left Arrow 

Select the next or previous 

item specified by the rotor 

Down Arrow or Up Arrow 

Select the first or last item Control–Up Arrow or Control–Down 

Arrow 

Tap an item Up Arrow–Down Arrow 

Scroll up, down, left, or right Option–Up Arrow, Option–Down Arrow, 

Option–Left Arrow, or Option–Right 

Arrow 

Adjust the rotor Up Arrow–Left Arrow or Up Arrow–Right 

Arrow 
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Single-key Quick Nav on the Web 

Action Keystroke 

Turn Single-key Quick Nav on or 

off 

VO-Q 

 

Element Next Previous 

Link L Shift–L 

Text field R Shift–R 

Button B Shift–B 

Form control C Shift–C 

Image I Shift–I 

Table T Shift–T 

Static text S Shift–S 

ARIA landmark W Shift–W 

List X Shift–X 

Item of the same 

type 

M Shift–M 

Heading H Shift–H 

Level 1 heading 1 Shift–1 

Level 2 heading 2 Shift–2 

Level 3 heading 3 Shift–3 

Level 4 heading 4 Shift–4 

Level 5 heading 5 Shift–5 

Level 6 heading 6 Shift–6 
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Navigating text 

Tip: ensure that both “Quick Nav” and “Single-key Quick Nav” are turned off 

when navigating text. 

Navigate by Next Previous 

Character Right Arrow Left Arrow 

Word Option–Right 

Arrow 

Option–Left Arrow 

Line Down Arrow Up Arrow 

Paragraph Option–Down 

Arrow 

Option–Up Arrow 

 

Move to Beginning of End of 

Line Command–Left 

Arrow 

Command–Right Arrow 

Paragrap

h 

Option–Up Arrow Option–Down Arrow 

Text area Command–Up Arrow Command–Down 

Arrow 

 

Editing text 

Tip: ensure that both “Quick Nav” and “Single-key Quick Nav” are turned off 

when editing text. 

Action Keystroke 

Select text as you 

move 

Shift + any of the navigation commands 

above 

Select all text Command–A 
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Copy selected text Command–C 

Cut selected text Command–X 

Paste selected text Command–V 

Undo last change Command–Z 

Redo last change Shift–Command–Z 
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Introduction 

VoiceOver on iPad can be controlled from an external keyboard. Most VoiceOver 

gestures have equivalent keyboard commands. This reference lists the most 

common keyboard commands for controlling VoiceOver, navigating the web, and 

editing text. 

 

VoiceOver Modifier Keys 

The VoiceOver Modifier Keys refer to one or two keyboard keys which combine 

with alphanumeric keys to form commands to control VoiceOver. The VoiceOver 

modifier can be configured to be one of the following: 

• Control + Option 
• Caps Lock 

To customise the VoiceOver Modifier Keys: 

• Go to Settings 
• Tap Accessibility > VoiceOver > Typing > Modifier Keys 
• Tap your choice of Control + Option or Caps Lock. 

General Commands 

In the following tables, "VO" refers to the VoiceOver Modifier Key. 

Action Keystroke 

Turn on VoiceOver Help VO–K 

Turn off VoiceOver Help Escape 

Appendices G – Instructions 
on Using VoiceOver Keyboard 

Commands 
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Select the next or previous 

item 

VO–Right Arrow or VO–Left Arrow 

Double-tap to activate the 

selected item 

VO–Space bar 

Press the Home button VO–H 

Touch and hold the selected 

item 

VO–Shift–M 

Move to the status bar VO–M 

Read from the current 

position 

VO–A 

Read from the top VO–B 

Pause or resume reading Control 

Copy the last spoken text to 

the clipboard 

VO–Shift–C 

Search for text VO–F 

Mute or unmute VoiceOver 

speech 

VO–S 

Open Notification Centre Fn–VO–Up Arrow 

Open Control Centre Fn–VO–Down Arrow 

Open the Item Chooser VO–I 

Change the label of the 

selected item 

VO–/ 

Double-tap with two fingers VO–”-” 

Swipe up or down VO–Up Arrow or VO–Down Arrow 

Adjust the rotor VO–Command–Left Arrow or VO–

Command–Right Arrow 
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Adjust the setting specified 

by the rotor 

VO–Command–Up Arrow or VO–

Command–Down Arrow 

Turn the screen curtain on or 

off 

VO–Shift–S 

Return to the previous 

screen 

Escape 

Switch apps Command–Tab or Command–Shift–

Tab 

 

Quick Nav 

Quick Nav allows VoiceOver to be controlled with the arrow keys. 

Action Keystroke 

Turn Quick Nav on or off Left Arrow–Right Arrow 

Select the next or previous 

item 

Right Arrow or Left Arrow 

Select the next or previous 

item specified by the rotor 

Down Arrow or Up Arrow 

Select the first or last item Control–Up Arrow or Control–Down 

Arrow 

Tap an item Up Arrow–Down Arrow 

Scroll up, down, left, or right Option–Up Arrow, Option–Down Arrow, 

Option–Left Arrow, or Option–Right 

Arrow 

Adjust the rotor Up Arrow–Left Arrow or Up Arrow–Right 

Arrow 
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Single-key Quick Nav on the Web 

 

Action Keystroke 

Turn Single-key Quick Nav on or 

off 

VO-Q 

 

Element Next Previous 

Link L Shift–L 

Text field R Shift–R 

Button B Shift–B 

Form control C Shift–C 

Image I Shift–I 

Table T Shift–T 

Static text S Shift–S 

ARIA landmark W Shift–W 

List X Shift–X 

Item of the same 

type 

M Shift–M 

Heading H Shift–H 

Level 1 heading 1 Shift–1 

Level 2 heading 2 Shift–2 

Level 3 heading 3 Shift–3 

Level 4 heading 4 Shift–4 

Level 5 heading 5 Shift–5 

Level 6 heading 6 Shift–6 
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Navigating text 

Tip: ensure that both “Quick Nav” and “Single-key Quick Nav” are turned off 

when navigating text. 

 

Navigate by Next Previous 

Character Right Arrow Left Arrow 

Word Option–Right 

Arrow 

Option–Left Arrow 

Line Down Arrow Up Arrow 

Paragraph Option–Down 

Arrow 

Option–Up Arrow 

 

Move to Beginning of End of 

Line Command–Left 

Arrow 

Command–Right Arrow 

Paragraph Option–Up Arrow Option–Down Arrow 

Text area Command–Up 

Arrow 

Command–Down 

Arrow 

 

Editing text 

Tip: ensure that both “Quick Nav” and “Single-key Quick Nav” are turned off 

when editing text. 

Action Keystroke 

Select text as you 

move 

Shift + any of the navigation commands 

above 

Select all text Command–A 
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Copy selected text Command–C 

Cut selected text Command–X 

Paste selected text Command–V 

Undo last change Command–Z 

Redo last change Shift–Command–Z 
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iPad supports many international braille tables and refreshable braille displays. 
You can connect a Bluetooth wireless braille display to read VoiceOver output, 
including contracted and uncontracted braille and equations using Nemeth Code. 
When you edit text, the braille display shows the text in context, and your edits 
are automatically converted between braille and printed text. You can also use a 
braille display with input keys to control your iPad when VoiceOver is turned on. 
For a list of supported braille displays, see the Apple Support article Braille 
displays supported by iPhone, iPad, and iPod touch. 
Connect a braille display and learn commands to control iPad 
Turn on the braille display. 
 

On iPad, go to Settings  > Bluetooth, turn on Bluetooth, then choose the 
display. 
 

Setting Description 

Output Choose uncontracted six-dot, uncontracted eight-
dot, or contracted braille. 

Input Choose uncontracted six-dot, uncontracted eight-
dot, or contracted braille; you can also turn on 
Automatic Translation. 

Braille Screen 
Input 

Choose the input method for entering braille using 
the screen. See Type braille directly on iPad using 
VoiceOver. 

Braille Tables Add tables that appear in the Braille Table rotor. 

Status Cells Turn on the general and text status cells and 
choose their location. 

Equations use 
Nemeth Code 

Turn on Nemeth Code for mathematical 
equations. 

Appendices H – Instructions on 
Using a Braille Display with 

VoiceOver on iPad 

 
 

https://support.apple.com/HT202514
https://support.apple.com/HT202514
https://support.apple.com/en-gb/guide/ipad/type-onscreen-braille-ipad6936b430/14.0/ipados/14.0
https://support.apple.com/en-gb/guide/ipad/type-onscreen-braille-ipad6936b430/14.0/ipados/14.0
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On iPad, go to Settings > Accessibility > VoiceOver > Braille, then choose the 

display. 
 
To see the braille commands for controlling iPad, tap More Info, then tap Braille 
Commands. 
 
See the Apple Support article Common braille commands for VoiceOver on your 
iPhone, iPad, and iPod touch. 
 
Change the braille display settings 

On iPad, go to Settings  > Accessibility > VoiceOver > Braille. 
Set any of the following: 
 
Output closed captions in braille during media playback 

On iPad, go to Settings  > Accessibility > VoiceOver > Verbosity. 
Choose Braille or Speech and Braille. 
 
 

 
 
 
 
 

Show On-screen 
Keyboard 

Display the keyboard on the screen. 

Turn Pages when 
Panning 

Automatically turn pages when panning. 

Word Wrap Wrap words to the next line. 

Alert Display 
Duration 

Adjust the duration that an alert is visible on your 
braille display. 

Ignore Chord 
Duration 

Adjust the amount of time required before 
subsequent key presses are recognized as braille 
chords. 

Auto Advance 
Duration 

Adjust this setting to your preferred reading 
speed. 

https://support.apple.com/HT202132
https://support.apple.com/HT202132
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Talking 
scientific 
calculator 

 

Calculator Large colourful buttons, 

optional high contrast, full 

voice over support and option 

to use speech for answers, 

buttons names and formulas 

£4.99 

Talking 

statistics 

calculator 

Calculator As above £3.99 

Brighter and 

bigger 

Reading A reading glasses tool for 

people who have difficulty 

reading fine print and focusing 

on nearby objects due to 

presbyopia, eye illness etc 

Free 

Magnifying 

Glass with Light 

 

Reading This app enables the user to 

very simply magnify text or 

objects up to 10x. You can 

have the light on or off and 

simply tap to focus. The 

simple features all work well  

Free 

Dolphin Easy 
Reader 

Reading  Use with DAISY, Epub or text 

books (links with RNIB 

Bookshare). Works with 

VoiceOver and iOS supported 

braille displays. Zooms in, 

choose colurs, text size and 

highlights to suit visual needs. 

Free 

BigMagnify Reading Magnifying glass and 

flashlight. 

Turn your iphone/ipad into a 

state of the art magnifying 

glass! 

Free 

Appendices I – Useful Apps 
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DAISY Talk 

 

Reading DAISY (Digital Accessible 

Information System) is an 

international standard for 

digital books designed for 

people with print disabilities. 

DAISY Talk is an app that 

reads out text of a DAISY 

book using a synthesized 

voice incorporated into an iOS 

device. 

 

£25.99 

KNFB reader  

 

 

Reading Reader takes a photo of text 

and then reads it aloud in clear 

synthetic speech. It is fully 

accessible using VoiceOver. It 

has text detection so you know 

you have the printed side of 

the page. It also has tilt assist 

and viewfinder assist, helping 

you to get the whole page 

photographed. 

£99.99 

Kindle 

 

Reading This fully accessible app 

enables you to turn your 

iPhone or iPad into a Kindle. 

You’re able to turn any eBook 

in to large print and all the 

eBooks (including those with 

narration) that you have 

purchased on Amazon will 

automatically appear in your 

app. Kindle Unlimited and 

Amazon Prime members can 

select and download eBooks 

directly in the app. 

  

Free 

The 

MD_evReader 

App  

 

Reading This has been developed to 

help people with a central 

vision loss read. It presents 

text from eBooks in a scrolling 

stream across the screen. The 

Free 
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app is designed for those 

people who use Eccentric 

Viewing (EV) and/or steady 

eye strategies for reading. 

Some people with macular 

degeneration may find it useful 

as a reading aid, or as a way 

of practising the Eccentric 

Viewing and steady eye 

techniques. The line of text 

scrolls horizontally from left to 

right and the reader aims to 

hold their gaze away from the 

line to view it with their best 

region of vision. The trackpad 

is used to control the speed of 

the text. 

Audible 

 

Audio book 

service 

 Audible is an audio book 

service brought to you by 

Amazon. 

It has all the best sellers as 

well as classics, non-fiction 

and much more, professionally 

narrated by actors.  

One 

month 

Free trial 

then 

£7.99 a 

month 

 

Prizmo 

 

Text to 

Speech 

Prizmo is a photo-based 

scanner app that lets you scan 

and recognize text documents, 

business cards, and images, 

and then export them as 

PDF/Text, vCard, or 

JPEG/PNG with VoiceOver. 

£9.99  

Dragon 

Anywhere: 

Dictate 

Speech to 

Text 

Professional grade dictation 

app. 

1 week's 

trial then 

£109.99 

annually 

Voice Dream 

Scanner 

 

Scanning Voice Dream Scanner is the 

ultimate app for scanning, 

recognising and reading 

printed documents.  

£5.99 
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Voice Dream Scanner has 

additional options for saving 

documents as PDFs or plain 

text and you can save 

those documents to locations 

including Dropbox and Google 

Drive to view on other devices. 

You can also use Voice 

Dream Scanner 

in conjunction with Voice 

Dream Reader.  

Voice Dream 

Reader 

Text to 

speech 

This is an advanced text-to-

speech app with 

a highly configurable screen 

layout so that it 

can be tailored to suit every 

reading style from 

completely auditory to 

completely visual, plus 

synchronized combination of 

both. It supports reading, PDF 

and Word documents, eBooks, 

Web pages and more. It also 

has a range of languages. 

£19.99 

Speechify- 

Audio Text 

Reader 

Text to 

speech 

This turns reading material 

into interactive audiobooks. It 

can read books, documents 

and articles.  

Free and 

upgrades 

available 

Access Note 

 

Note taker AccessNote is a note taker 

used and developed by the 

American Foundation for the 

Blind.  

Free 

Aipoly Vision 

 

ILS Users point the app at an 
object and simply press a 
recognition button. 

 

Free and 

upgrades 

available 

at a cost 

iDentifi 

 

ILS iDentifi is an app that uses 

artificial intelligence to enable 

users with a vision impairment 

Free 
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to click a photo and get an 

instant description. It’s able to 

recognise objects, brands, 

colours, facial expressions, 

handwriting and text, and 

delivers an audible description 

of the image’s contents to the 

user. The interface is very 

accessible and gives the 

option to choose from three 

different modes of object and 

text recognition, as well as 

how fast you want the app to 

speak. 

SeeingAl Many uses Describes the people, text and 

objects around you 

Free 

TapTapSee 

 

Many uses TapTapSee uses a phone’s 

camera and VoiceOver 

functions to photograph 

objects and identify them for 

the user. You double-tap the 

device’s screen to photograph 

any two or three dimensional 

object at any angle, and the 

app analyses the image and 

gives you a description, out 

loud, within seconds. 

Free 

CamFind 

 

Many uses CamFind allows you to do an 

online search by simply taking 

a photo of an object – the app 

then uses mobile visual search 

technology to tell you what it 

is.  

Free 
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Ariadne GPS 

 

ILS Allows users with a vision 
impairment to navigate 
directions using talking maps 
and an innovative interface. 
Ariadne works anywhere 
accessible by Google Maps. 

£4.99 

Be My Eyes 

 

ILS An app that connects people 
with a vision impairment with 
fully-sighted volunteers who 
provide virtual assistance 
through a live video call. Be 
My Eyes is available in 180 
languages.  

Free 

Bespecular ILS This app links up fully-sighted 

volunteers with users with a 

vision impairment. The person 

with a vision impairment takes 

a photo of what he or she 

needs help with and attaches 

a voice message, which is 

sent to a community of 

volunteers. Within minutes, the 

user receives a reply and then 

rates out of five stars the 

helpfulness of the volunteer. 

Free 

Color ID 

 

ILS Colour Identifier uses the 

camera on your phone or 

tablet to identify and speak the 

names of colours in real-time. 

It’s an augmented reality app 

that helps you discover the 

colours around you. 

Free 

Light Detector 

 

ILS Light Detector transforms any 

natural or artificial light source 

it encounters into sound. Just 

run the application and point 

your phone’s camera in any 

direction. You will hear a 

higher or lower sound 

depending on the intensity of 

the light, enabling you to 

£1.99 
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understand where light fixtures 

and windows are in a room. 

Clew ILS Helps people with a vision 

impairment navigate indoor 

environments independently. 

iOS 11 or later. Works best in 

well-lit environments with 

distinct visual features and few 

moving objects 

Free 

BlindSquare 

 

ILS An accessible GPS app, which 

describes the environment, 

announces points of interest, 

streets and user specified 

points as you travel. Once 

BlindSquare has determined 

your location using your 

phone’s GPS, it will look up 

information about your 

surroundings. 

£38.99 

Microsoft 
Soundscape 

ILS The app uses 3D audio 

technology to enable you to 

build up a mental map of your 

location as you travel. 

Free 

ATM Finder 

 

ILS Users can filter search to find 

ATMs that have audio 

assistance, are Free to use, 

belong to a specific 

organisation, such as your 

bank, and are wheelchair 

accessible. The app is GPS-

enabled and shows you the 

ATMs that are closest to you 

on a map and also allows you 

to search for ATMs in other 

locations to help you plan 

ahead. 

Free 

Digit – Eyes 

 

ILS This app reads manufacturer’s 

barcodes and tells you the 

product name. In some cases 

it will give you a full 

Free 

version 

available 

with 
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description, usage instructions 

and ingredients. You can also 

record your own audio labels 

or make text labels that are 

read aloud by your phone.  

upgrade 

for £9.99 

 

acceltype Touch-typing  Helps people of all ages learn 

to type with speed and 

accuracy. Can use an external 

keyboard and adjust font size. 

£4.99 

Visual Braille 

Lite 

Braille You can type in standard text 

and visual braille converts it 

(Grade 1/uncontracted). 

Free 

Visual Brailler Braille A simple braille editor. 6 dot 

braille on screen keyboard, 

indefinite number of 40 cell 

braille lines, cut copy and 

paste braille, refreshable 

braille display input and 

output, BRL (unformatted) and 

BFR (formatted) braille file 

export. 

Free 

Pocket braille 

Lite 

Braille Learn the alphabet and 

punctuation symbols of the 

Braille code as an entry point 

to the language. 

Free 

BrailleNow Braille Designed to teach fully-sighted 

persons how to recognize the 

Braille letters a-z. 

Free 

These apps 

have been 

specially 

developed for 

children with 

CVI  

Visual 

stimulation 

wonderbaby.org/articles/cvi-

apps 

e.g. Fluidity HD: 

Very responsive screen 

encourages simple motor 

movements with bold visual 

displays. Great for teaching 

cause and effect and 

increasing visual attention (no 

audio). 

Free and 

apps to 

purchase 

Infant visual 
stimulation 

Visual 

stimulation 

This app contains high 

contrast pictures in flashcard 

£4.99 

https://geo.itunes.apple.com/us/app/fluidity-hd/id399403909?mt=8&at=11l8DE
https://geo.itunes.apple.com/us/app/fluidity-hd/id399403909?mt=8&at=11l8DE
https://geo.itunes.apple.com/us/app/fluidity-hd/id399403909?mt=8&at=11l8DE
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format, designed for new-

borns and babies. 

Baby Screen Visual 

stimulation 

This app displays simple 

animated patterns designed to 

appeal to babies' developing 

visual systems. 

Free 

Atlas of 

Ophthalmology 

QTVI 

resource 

Clinical images of virtually all 

eye diseases. 

Free 

Vision Sim QTVI 

resource 

This app was developed to 

allow people with healthy 

vision to see the world through 

the eyes of a person 

experiencing one of nine 

degenerative eye diseases. 

Free 

EYEWARE QTVI 

resource 

Eyeware lets you view your 

surroundings with a range of 

the most common eye 

conditions. 

Free 

Thru my eyes QTVI 

resource 

Vision simulation app for 

Leber's and RP 

Free 

Chromatic 
vision simulator 

QTVI 

resource 

Colour vision simulation tool 

which simulates the colour 

vision of colour vision 

deficiencies. 

Free 

Vision test Vision 

assessment 

Search for Vision test and a 

range of apps are available for 

colour vision and Snellen 

charts. 

Free 

Kayisight Test 
professional 

Vision 

assessment 

You can measure and record 

near and distant visual acuity 

in children from 18 months of 

age. 

There is a 

cost after 

a Free 

trial 

 
 

https://itunes.apple.com/us/app/baby-screen/id384999458?mt=8
https://itunes.apple.com/us/app/atlas-ophthalmology-by-onjoph/id448650383?mt=8
https://itunes.apple.com/us/app/atlas-ophthalmology-by-onjoph/id448650383?mt=8

